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strucciones de Seguridad

(Normas Oficiales Mexicanas Electrical Safety Statement)
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. Todas las instrucciones de seguridad y operacion deberan ser leidas antes de que el aparato eléctrico sea operado.
. Las instrucciones de seguridad y operacion deberan ser guardadas para referencia futura.

. Todas las advertencias en el aparato eléctrico y en sus instrucciones de operacién deben ser respetadas.

. Todas las instrucciones de operacion y uso deben ser seguidas.

. El aparato eléctrico no debera ser usado cerca del agua—por ejemplo, cerca de la tina de bafo, lavabo, sétano mojado o cerca

de una alberca, etc.

. El aparato eléctrico debe ser usado Unicamente con carritos o pedestales que sean recomendados por el fabricante.
. El aparato eléctrico debe ser montado a la pared o al techo sélo como sea recomendado por el fabricante.

. Servicio—E| usuario no debe intentar dar servicio al equipo eléctrico mas alla a lo descrito en las instrucciones de operacion.

Todo otro servicio deberd ser referido a personal de servicio calificado.

. El aparato eléctrico debe ser situado de tal manera que su posicién no interfiera su uso. La colocaciéon del aparato eléctrico

sobre una cama, sofd, alfombra o superficie similar puede bloguea la ventilacién, no se debe colocar en libreros o gabinetes
que impidan el flujo de aire por los orificios de ventilacion.

El equipo eléctrico deber ser situado fuera del alcance de fuentes de calor como radiadores, registros de calor, estufas u otros
aparatos (incluyendo amplificadores) que producen calor.

. El aparato eléctrico debera ser connectado a una fuente de poder sélo del tipo descrito en el instructivo de operacion, o como

se indique en el aparato.
Precaucion debe ser tomada de tal manera que la tierra fisica y la polarizacién del equipo no sea eliminada.

Los cables de la fuente de poder deben ser guiados de tal manera que no sean pisados ni pellizcados por objetos colocados
sobre o contra ellos, poniendo particular atenciéon a los contactos y receptaculos donde salen del aparato.

El equipo eléctrico debe ser limpiado Unicamente de acuerdo a las recomendaciones del fabricante.

En caso de existir, una antena externa deberd ser localizada lejos de las lineas de energia.

El cable de corriente debera ser desconectado del cuando el equipo no sea usado por un largo periodo de tiempo.

Cuidado debe ser tomado de tal manera que objectos liquidos no sean derramados sobre la cubierta u orificios de ventilacion.

Servicio por personal calificado debera ser provisto cuando:

El cable de poder o el contacto ha sido dafado; u

Objectos han caido o liquido ha sido derramado dentro del aparato; o

El aparato ha sido expuesto a la lluvia; o

El aparato parece no operar normalmente o muestra un cambio en su desempefio; o
El aparato ha sido tirado o su cubierta ha sido dafada.

-”-"QO.U.UP
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Content Commander User Guide

Part1: Welcome to iCOMPEL Digital Signage

Welcome to the iCOMPEL Content Commander (iCC) user guide. Here you will find comprehensive
information about how to create digital signage with the iCC and how to manage the iCC unit.

Find the subject you are looking for in the table of contents or in the PDF bookmarks. Track down the location of
specific topics with the index at the end of the guide or by using the Adobe® Reader® search facility.

If you are new to iCOMPEL digital signage, you will find it helpful to read the Overview for an introduction to the
fundamental concepts and components involved. Also familiarise yourself with the Terms You Need to Know
before beginning to create digital signage content with the iCC.

Following that, you will be ready to check through the steps for Logging On to the iCC and Using the Web Interface.

However, the more experienced may wish to go straight to the information about creating and controlling digital
displays:
. Creating a Schedule — Getting started with designing and implementing your display.

. Understanding Media Types — Understanding the different types of content you can display and how the iCC
manages them.

You can also find background Information on setting up and managing the iCC:
. System Status — Keeping your iCC running smoothly.

Setup — Performing configuration and maintenance tasks.

Important: This user guide provides comprehensive information about all the features the iCC offers. However,
some features are only enabled if you purchase the appropriate license. Please contact your reseller or supplier
for more information.

1.1 Overview

To understand the fundamental concepts and components of a digital signage configuration, it is useful to start by
describing a very simple arrangement with a standalone display. Building on that, further illustrations will add
the extra features, including the iCC, that become increasingly relevant as your network grows more distributed
and more sophisticated.

Work through the description of these examples in turn:

« Standalone Display

« Multiple Displays

« Multiple Channels

11
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1.1.1  Standalone Display

The following diagram illustrates the simplest situation with a single display controlled by an individual. You might
conceive of this as a screen displaying information in the foyer of a school:

Browser Display Screen
G Local Area Network, <):> ﬁ @
Intranet,
or Internet Player

User

Note the significance of the highlighted features in that scenario:
« User—The person controlling the screen content and its operation (that is, you).

« Browser— You exercise control through a web browser (such as Mozilla® Firefox® or Microsoft® Internet
Explorer®). This remains the case for even the largest digital signage network.

« Local area network, Intranet, or Internet — In principle, you do not need to be physically close to the screen's
location. This becomes more significant as the size of the network increases.

« Player—Player is the generic term for the appliance that runs the screen. Specifically, the player is the Black
Box Net-Top-Box. The player has to be physically attached to the screen.

« Display Screen — The equipment that displays the content you have defined. You configure the player to display
various media on selected areas of the screen at chosen times.

As you might expect, additional features are needed to support a network that includes Multiple Displays.

12
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1.1.2 Multiple Displays

The following diagram illustrates a more fully-featured situation where a user controls several players and their
screens. You might conceive of this as a set of screens displaying sales information on the floors of a shop. In
practice, the number of players would be much higher, which is why it is desirable —and soon necessary —to add
further components to the network:

Publisher @
ﬁ Channel 1 @

Local Area Network, Channel 1 Subscriber
Intranet, =
or Internet @
Browser

all o

Subscriber
User

You can see that certain features are the same: the user, the browser, and the network. Note now the significance of
the additional features, discussed clockwise as they appear:

. Publisher— A Publisher is a system you configure to provide content to multiple players. This enables you to
display consistent content on several screens and means you only need update it in one place. Although some
player models can perform this role, in our context the publisher is specifically the Black Box Content
Commander.

« Channel — A Channel refers to both the content it contains and its originating publisher. The Channel Name (in
this case 'Channel 1') identifies the channel and is often just the name of the publisher.

« Subscriber — A Subscriber is a player that you configure to accept content from a publisher. In the diagram,
Channel 1 provides the content for all the subscriber players and their screens. Subscriber and Publisher are
referred to as Roles (the only other role is Standalone, which is the role of the player in the first diagram).

You can build on the parts already described to create a network not only of multiple displays but also of Multiple
Channels.

1.1.3 Multiple Channels

When your signage network grows to a large number of players and their screens, the quantity and variety of content
you need to manage and distribute grows accordingly.

Once again, it is useful to envision the key components in a condensed and summarised form.

13



Part 1: Welcome to Black Box Digital Signage

The following diagram shows how the individual network features we have discussed so far combine to provide a
network infrastructure of multiple displays and multiple channels. You might conceive of this as a multisite business
with sites in different cities, maintaining a resilient network of players displaying various streams of content, and
all under centralized control:

Channel 1
Subscribers

Channel 1 Channel 1 0@

Publisher

Channel 2
Local Area Network, U@
Intranet,
or Internet Channel 2
Subscribers

Channel 2

= N

Browser w 0@
o

User

Notice how the by-now familiar components operate in combination:

« At the center, you create and manage the flow of content for the network through your web browser.

« TheiCC publishes content over multiple channels. You configure as many as you need to serve the needs
of the business, up to a maximum of 50.

« Multiple subscriber players display content from whichever channel you designate appropriate to their
function. For example, the content could be subject-based if the display is for a particular department or could
be locale-based if the display is for a particular city.

« How you group the subscriber players is up to you: you can have numerous players displaying common
content.

That picture is deliberately simplified to illustrate the essential components of a large network. Therefore, it is
worth emphasizing that the iCC can readily scale up to manage the content for even complex digital signage
networks. For example, the iCC allows you to set a bandwidth limit on a per-port basis, thereby prioritising quality
of service for different purposes (see the HTTP service settings description in Firewall for more details).

This is not to say the iCC alone can provide everything required for more specialist configurations. You may need
to add a Channel Content Server (CCS) to assist content processing if you have specific network topology
requirements (see Channel Content Servers for more details).
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Having now considered the background terms and concepts of the digital signage network, the next step is
to understand how to compose the content that you will publish through the iCC. Begin by reading the Terms
You Need o Know.,

1.2 Terms You Need to Know

The iCC provides powerful facilities to help you to design, structure, and control sophisticated and effective content
display.

To understand how you use the iCC to manage display of content, it is important to understand how certain
key features relate to each other.

The following diagram illustrates the critical relationships between Schedules, Layouts, Zones, and Playlists:

A Schedule:

...shows a Layout: - Dﬁ
1
...made of Zones: -

Text

..each running a Playlist: . cree

=] Text

To flesh out how those relationships work, consider each of those key features in tum.

Schedule

The player is designed to run continuously. You control which Layouts are displayed on what days and at which
times by creating a Schedule. The schedule may be something like this:

« Layout A runs from 4.00 pm to 6.00 pm, Mondays to Fridays.
« Layout B runs from 2.00 pm to 8.00 pm, Saturdays and Sundays.

« Layout C runs at all other times, throughout the week.

Layout

A Layout is the arrangement of individual display areas, known as Zones, that you use to compose your on-screen
display. Your layout might display video in one zone, scrolling text in another, a sequence of still images in a third
zone, with a full-screen zone behind the others showing a background color orimage.
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Zones

Zones are rectangular areas, each of which can display various forms of content (known as media items). You can
design layouts with any number of zones, of any size, in any location, either separate or overlapping. You specify
which zones display which media types (for example, one for a promotional video, one for scrolling text, another for
your organisation's name or logo, and so on). You can also have zones display a mix of media types. You arrange the
media items for each zone in a Playlist.

Playlist

A Playlist contains one or several media items that you choose to display in a zone. Media items include fixed and
scrolling text, movies, images, Adobe® Flash® animations, web pages, and newsfeeds. To display a media item,
you add it to the playlist. Each zone has its own favorite playlist, which runs continuously. You can also synchronise
the display between two playlists (for example, to run a scrolling text message at the same time as a related
promotional video orimage.

That examination of the key features gives a flavour of how you put together your signage display content fora
single player. However, as we have seen, using the iCC you can also easily provide the same content for groups of
players by publishing through one or more channels.

You can also allow people local to the subscriber players to have a degree of control over the content the player
displays. The material and features that you allow local users to modify is called Ad Hoc content and they are called
Ad Hoc Users.

That brief survey of the key terms provides the foundation to start using the iCC. Other sections introduce and
describe additional terms and concepts as needed. An extensive Glossary provides definitions of the core iCC
terminology.

But now, to consider further how to use schedules, layouts, zones, and playlists to create your digital signage, refer
to Creating Digital Signage.

1.3 Logging On

During the log on process, you will need to provide the IP address of your iCC. Make a note of this before you
begin. If you do not know the IP address, restart the iCC: it displays its IP address above the progress bar
towards the end of the boot sequence.

Follow these steps to login to youriCC:
1. Ensure that the iCC is connected to the network.

2. Open aweb browser (such as Mozilla® Firefox® or Microsoft® Internet Explorer®) on a computer on the same
network as the iCC.

3. Inyourbrowser's address bar, type in the IP address of your iCC and click the 'go to' arrow or press the Enter
key.

4. When prompted, enter the username and password. The factory-set defaults for these are remote and 9999
respectively. YouriCC displays its Home page.
Security: It is strongly recommended that you change the remote account password from the factory default
as soon as possible. Also change the iCC master password and check that the security services configuration
matches your requirements (see Security — General Settings for details).
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That connection is secured by HTTP digest authentication, which encrypts the password. However, you should
consider adopting form-based authentication as it can be configured to give stronger security. Form-based
authentication also provides an explicit sign out when you want to end your session on the iCC.

Important. If you use form-based authentication, you will need to provide a valid SSL certificate
(as described below). It is possible to access the iCC without a valid certificate, but your browser will at
first block you and warn that the connection is untrustworthy or that there is a problem with security.

To configure form-based authentication, follow these steps:

1. Onthe menu bar, click Setup and select System and Security.

2. Click the Firewall tab.

Inthe HTTP Service Settings panel, from the Authentication drop-down menu, select Form-based
Authentication.

w

From the Supported Protocols drop-down menu, select HTTPS.

Click the | Save Securily Seflings | tton (ignore the prompt to reboot the ICC).

Click the SSL Certificates tab.
Select Use Custom SSL Certificates for Web Server.

No o &

8. Complete the certificate details and click the| Save Changes | p +1on.
9. Click the prompt to reboot the iCC.

When you next access the iCC, you will need to do so using the HTTPS protocol. Your username and password will
be as before. To sign out of your session, click the prompt at the top right of the iCC display.

For the future, you might want to bookmark the Home page or add it to your favorites for easier access. If your
network is set up to provide DHCP and DNS support, you can also access the iCC using its name rather than its
IP address: the name is automatically generated in the format iCCserial, where serial is the serial number of your
iCC (for example, iCC123456).

The iCC comes ready-installed with a number of sample displays and you might find those useful to illustrate the
kinds of features you can implement.

If you need assistance at any time, click Help on the menu bar to access page-specific help or to navigate to any
other help page.

You can now begin to become familiar with the iCC user interface.

1.4 Using the Web Interface

You control and manage the iCC through your browser using the web-style pages of the iCC user interface.

You should become familiar with the essential features of the user interface before beginning to use the iCC.
Most important is the main Home page but you should also be aware of the generic navigation and command
features employed on other pages. What follows is a tour of the Home page followed by descriptions of those
generic features.
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The Home Page
This is the first page you see after logging onto the iCC. At its heart is this view of the current state of the iCC,
showing a summary of its operational status:

» LI Channels 7 P & Media
» & Network

» [] System

QAOC

» &h Reporting

That summary is made up of Status Bars.
Status Bars

These indicate the status of key iCC operational components. Each status bar has this general

» £ Network (V)

The features to note are:

« Open/close arrow — Click the® arrow to reveal more details. Click the™ arrow to reduce the detail.
« Name — The subject of the status report (in the above case the subject is the Network).

« Status summary — The color of the status bar icon indicates the current status (in the above case, the network
status is good).

Here are status bars that respectively indicate attention needed and problem detected:

» &h Reporting

» A Media 0

If you click the open arrow on an attention or problem status bar, the iCC provides a description of the problem in
the information revealed. To take corrective action, click on the appropriate button to open the relevant page in the
interface.
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In general, opening a status bar provides you with additional information about the subject area, with a selection of
buttons to take you to the relevant pages in the user interface. For example, opening the System status bar
reveals details about the iCC system state:

v [:] System K'J

Hardware Maodel: - Serial Number: 31421
Software Vo_2.3 (34255)
Sofware Update Automatic updates are turned off. No pending manual updates.
Time: MNTP - EuropefLondon
Audia: Master Volume is 100%. Using input source line with level 75%.
Temperature: CPU temperature is 33°C. Disc temperature is 32°C.

Most pertinently for your use of the iCC, opening the Channels status bar reveals a summary of the channels
you have published:

¥ | Channels W

Status: Name Status Version
Default Channel Published - Channel published to /channel/1 w93.0.(
mig jtvchannel Published - Channel published to

mgji ublished - Channel published to /channel/3 W7.4.0

As you can see, because of its importance, the iCC allocates half of the Home page display to the Channels
status summary. The iCC displays this information:

. Name —The name of the channel.

. Status — The latest publication status of the channel. When a channel starts publishing, the iCC highlights this

with m and then with m as the process progresses.

« Version - Indicates the minimum software version the player needs to display the channel's content.

Status:

To access detailed information on the channels, click the| | button to open the Manage

Channels page.

Generic Features: The Menu Bar

The menu bar appears on every page of the user interface. It allows you to navigate to the page you need to perform
detailed actions. Broadly speaking, each page corresponds to a particular feature such as:

« Layout design
« Playlist creation
« Channel publishing

« Managing user accounts
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The menu bar offers these top-level options (you may see fewer options depending on your configuration):

Home Media | Playlists | Layouts | Schedules | Channels | Ad hoc Entry | Status Setup | Help

The relevant explanatory sections describe those options in detail. You can also change how you interact with the
menu bar on the Help > Ul Options page. Some iCC features are only available if you enable the Detailed or
Expert option on the Ul Options page. Restrictions may also apply if youriCC hardware components and
capabilities do not support certain functions or if you do not have the requisite software licenses.

To speed your access to important pages and information, the right-hand side of the menu bar includes a selection
of icons. Click the icon to access the following:

! —The Home page.

E —The Manage Channels page.

- The Manage Layouts page.

— The Setup icons page.

An additional icon indicates the system status and can be one of:
— Confirms there are no known issues.

D — Brief description of an attention item (only shown if one is active).

ﬂ — Brief description of a problem item (only shown if one is active).

Note: The iCC does not display the quick access icons if your computer screen is too small or you have
restricted the size of the browser window.

Generic Features: Tabbed Pages

Many options in the iCC user interface are split across tabbed pages:

ﬁ Schedule @ Add Schedule Entry ﬁ Properties

To access the options on the tabbed page, click the tab label (for example, Add Schedule Entry).

Generic Features: Action Buttons
Numerous actions are common across different iCC pages. The user interface indicates these with icon action
buttons. Click the button to perform the indicated action:

@ —Delete
% |- Rename

—Copy
L2 | _Edit

N_ Drag to reorder
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Generic Features: Command Buttons

Some commands are common across different iCC pages. The user interface provides command buttons for

these. To execute the command, click the button. The label on the button describes the command,

or| Add |

Save Changes
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Part2: Creating Digital Signage

This section describes how to create your digital signs. If you are new to the iCC, see Terms You Need to
Know before you begin.

Click on the links below for more information on:

Using Schedules — Controlling what is displayed and when.

Using Layouts — Organizing the screen into different display areas.
Using Zones — Configuring the type of content displayed in each layout.
Using Playlists — Specifying the media items that play in each zone.

Understanding Media Types — Setting up and managing the different types of media.

Enhancing Your Displays — Using synchronisation, interactivity, and the RS-232 interface.

2.1 Using Schedules

The player units are designed to run continuously. You control which layouts are displayed on what days and at what
times by creating a Schedule for each channel. A schedule always contains at least one Schedule Entry, which
defines at least one player action (often, which layout to display). A schedule entry does not necessarily specify a
layout change, it could specify some other action (for example, switching the audio to mute).

The schedule entries define periods of time during which actions occur. The programme of schedule entries is based
on a one-week cycle. The Default Schedule Entry defines the layout that appears, or the actions that occur, when
no other schedule entry is active.

The player always displays the schedule with the most recent start time. Once a schedule starts running it continues
until another schedule is set to begin. If there is only one schedule it runs indefinitely.

An example schedule might contain schedule entries taking these actions:
« Playing layout X from 4:00 pm to 6:00 pm, Mondays to Fridays.
« Playing layout Y from 2:00 pm to 8:00 pm on Saturdays and Sundays.

« The default schedule entry, playing layout Z at all other times.
You can temporarily interrupt a schedule by using a Schedule Override.
To access the schedules configured for a channel on the iCC:

1. Onthe menu bar, click Schedules.
2. Select the relevant channel from the drop-down list.

3. Click Manage Schedules.

The iCC provides these action buttons:
@ — Delete the schedule.
— Copy the schedule.

# | _ Edit the schedule.
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Note: Deleting a schedule does not delete its associated layouts. If only one schedule remains, you cannot
delete it.

To create a new schedule, click the Add Schedule tab.

2.1.1 Creating a Schedule

To display content on your player units, you need to create at least one channel with its associated schedule.
You add schedule entries to a schedule to fine-tune how the player runs it.

To create a new schedule:

1. Onthe menu bar, click Schedules.

2. Select the channel from the drop-down list.
3. Click Manage Schedules.

4. Click the Add Schedule tab.

To create the new schedule, complete the following details and click the |_Add Schedule | b 4.

Schedule Name Enter a unique name for the schedule.
Valid From Select the date and time when the player starts running the schedule (the defaultis in 24 hours time).

Valid Until Select the option that matches your requirement:

« Superseded — The player keeps playing this schedule until a more eligible schedule becomes
available.

« Date — The player keeps playing this schedule until the date and time you choose. It then plays
the next eligible schedule. If the player cannot find an eligible schedule, it continues to play this
one.

Show Layout Select the layout to display.

Conditional Play | This is only enabled when you have added Player Local Information (PLI) to the player (see Player
Local Information for details).
Ifitis enabled, you have two options:
« Play Always — Default. The player always plays the schedule.

« Play if Player Local Information ltem — The player only plays the schedule if certain conditions
are met.

If you select Play if Player Local Information Item, complete these steps:
1. Select the name of the relevant player local information from the first drop-down list.

2. Selectthe test to apply from the second drop-down list.

3. Enter the value to test for in the final field (add further values by clicking the * |button or delete
values by clicking the @ button).

2.1.2 Schedule Entries

A schedule entry is a set of one or more actions for the player to perform at specified times. Schedule entries repeat
over a weekly cycle and a programme of schedule entries make up a schedule.
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Use schedule entries to specify these actions:
« Displaying a layout.

« Switching a screen on or off.

« Switching audio on or off.

« Performing Advance To commands.

Whenever you create a new schedule, the iCC automatically includes a Default Schedule Entry. The
default schedule entry has no start and end time and defines the default states when no other entry is active.

Schedule entries allow you to direct your player to perform simple or highly sophisticated sequences of actions. You
can have the player display different layouts at different times of the day and different days of the week, switch the
display on and off, or repeat actions at specified intervals.

Toillustrate the use of schedule entries in more detail, here is a worked example.

With the following schedule, made up of three schedule entries, the player will:

« Turn the screen on to show the Car Showroom layout from 08:45 until 18:00 on Mondays to Fridays.
« Display the Retail layout (showing other sales offerings) for 10 minutes every hour.

« Turn the screen off at all other times.

® schedule =0 Add Schedule Entry < Properties

Actions Schedule Entry

8 Dafaults usad when no Schadule Entry 15 active
' Audio 15 Muted Screen is Off Layout Car Showroom
u # From 08:45 until 18:00 Mon-Fri
Audio B Unmuted Soreen & On ayout Car Ehgwrggm
o g Rapeat every hour for 10 minutes From 09:00 unbil 18:00 Mon-Fr
Audio s Unmuted Screen is On  Layout Retail

Looking at the respective settings on the Add Schedule Entry tab reveals how you would go about specifying each
of those schedule entries.
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The first schedule entry causes the player to turn the screen off and mute the audio soundtrack (note that the Car
Showroom layout plays even though the screen is off):

Default Actions:  Audio: Mule -
Screan: OF -

|I| Show Layout: Car Showroom -

B advance To |hide -

| Cancel | SaveChanges |

The second schedule entry causes the player to turn the screen on and play the Car Showroom layout:

From: 08 = : 45 » : 00 ~ Untl: 18 » : 00 = : 00 -

On: @ mon @ Tue # wed B Thu @ Fri Bl sat Bl sun

Repeat: @ Perform Actions for the entire penod
% During the Period, only perform Actions:
Every 01 =|: |00 -|: |00 ~|for |00 - : 10 ~|:(00 -

Ad hoc: Ad hoc Schadule is not currently available as no Ad hoc Schaduls Iteme have bean created

Actiens: ¥ audio: Unmute

(o] (2]

¥ Screen: On =

=l

Layout: CarShowroom -

[ advance To: |hide

Cancel || Save Changes |

The third schedule entry causes the player to change to the Retail layout for 10 minutes every hour:

From: 09 = : 00 = : 00 ~ Until: 18 ~ : 00 = : 00 -~

On: | @ mon @ Tue B wed @ Thu @ Fri [ sat F sun

Repeat: @ Parform Actions for the entire period
@ Dunng the Penod, only perform Actions:

Every 01 = : 00 = : 00 = for 00 ~ : 10 » : 00 =

ad hoc: Ad hoc Schedule = not currently available as no Ad hoc Schedule Items have been created

Actions: [ audio: Unmute -

(o] (2]

® Screen: On -
¥ Layout: Retail -

[ Advance To: | hide

[ Cancel ] | Save Changes
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To create a new schedule entry, click the Add Schedule Entry tab, complete the following details, and click the
| Add Schedule Entry | by tton:

From

On

Repeat

Ad hoc

Actions

Select the time range during which you want the player to apply the schedule entry.

00:00:00 means midnight. Set both From and Until to midnight for the player to run the schedule entry all
day. For a period that runs through midnight, add separate schedule entries: one ending at midnight, one
commencing from midnight.

Check the boxes for the days you want the player to play the schedule entry.

Choose the option that matches your requirement:
« Perform actions for the entire period — The player performs the actions all of the time.

« During the period, only perform actions — The player performs the actions only when and for as long
as you specify. Specify the regularity with the Every options and the duration with the for options. The
Every setting must be at least 30 seconds longer than the for setting. The minimum for setting is 30
seconds.

This is only enabled when you have added ad hoc schedule items to the iCC (see Managing Ad Hoc
Pages for details).

Check the User can override From, On and Repeat settings using Ad hoc Schedule Item box to allow
ad hoc users to alter those time settings.

Check the boxes and select the required action you want the player to perform:

« Audio — Unmute or mute the display's sound.

« Screen - Turn the screen on or off.

« Layout — Display the selected layout.

« Advance To — Play the nextitem in the zones containing the selected rendezvous point.

Modify a schedule entry by clicking the | # | button next to it on the Schedule tab.

213

Overriding the Schedule

You may need to override the current schedule at certain times (for example, to show a special event froma TV
broadcast feed). You can create a Schedule Override which temporarily replaces the current schedule. The player
stops playing the current schedule and displays a different layout.

To create a schedule override, follow these steps.

N o o b~ w0 D=

On the menu bar, click Schedules.

Select the channel from the drop-down list.

Click Manage Overrides.

Click the Add Override tab.

Enter a name for the override. Use a descriptive name (for example, 'Emergency Instructions').
Select what you want the player to do with audio and the screen.

Choose a layout for the player to display.

8. Click the | AddOvemde |, ton,
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2.2 Using Layouts

A layout is an arrangement of various display areas, called zones. Your layout may include video in one zone,
scrolling text in another zone, and a sequence of stillimages in a third zone. You may also have a zone that is the
same size as the layout and contains a background image on which all the other zones are superimposed. Your
audience sees everything in your layout, so you need to take care to design layouts that are appealing and effective.

By default, the iCC names the zones for each layout on the screen in the order in which they were created — zone A,
B, C and so on. To help manage the zones, you can change the names to make them more descriptive (for
example, 'Background' or 'Main Video'). You can change the relative display positions of the zones in a layout.

Each zone can display media items of different types, according to the media player or players you enable for the
zone.

The iCC screen background is visible in any part of the layout that is not covered by a zone. You can define
the color orimage for the screen background independently of any layout.

2.21 Manage Layout Page

The Layouts > Manage Layouts page shows all the layouts available on this iCC. A number of layouts are

provided by default and you can create new ones by clicking the Add Layout tab and following the steps in Adding
a New Layout.

For each layout, the iCC displays:

« Adiagram of the layout's zones.

« The name and description of the layout.

« If applicable, the names of the schedules and channels that use the layout.
« The canvas size required for the layout.

« The names of any rendezvous points or Change Layout commands.

« Alink tothe layout's Ad hoc Page.

Additionally, the iCC displays an audio icon i you enable a soundtrack and a touch-screen iconli_ * if you
enable interactivity. Click on the icon to edit those properties.

Click the layout name (or the thumbnail) to open the graphical layout editor or to access the layout's properties. Click
a zone in the layout diagram to open the zone's playlist.

The iCC provides the following action buttons for each layout:

[(@]_ Delete the layout (you cannot delete a layout referenced by a schedule, even if inactive).

% | — Rename the layout.

— Copy the layout.

? |—Editthe playlists for the layout's zones or edit the layout itself.

To reduce the number of layouts displayed, follow these steps:

1. Click the T8 | pytton.

2. Enterall or part of the layout's name.
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Click the L AeBlY | putton.

To clear afilter, click the M button.

2.2.2 Adding a New Layout

To add a new layout, follow these steps:

1

2
3
4.
5
6

7.

On the menu bar, select Layouts then Manage Layouts.
Click the Add Layout tab.

Enter a name for the new layout and its overall width and height.
Click the 249 | pytton

Click the | | button next to your new layout in the layouts list to open the graphical layout editor.

. Add and set the properties for the zones you require.

When done, cIickH Savew and H Save all changes

You can return to and edit your layout whenever you wish.

2.2.3 Editing a Layout

To edit a layout, click its name on the Layouts menu or on the Layouts > Manage Layouts page.

The edit layout page has these tabs:

Zones — Displays the graphical layout editor for you to add or modify zones and their properties.
Layout Properties — Displays options for you to set up the layout's canvas size, ad hoc page, and soundtrack.
Interaction — Displays the interactivity options for you to configure.

Permissions — Displays the roles that can access the layout and the users allocated with those roles. If a role
has only asset-based permissions, you can enable or disable the role's access here. See Asset-Specific
Permissions for more information.

2.2.4 Layout Properties

The Layout Properties tab allows you to configure the following details (when complete, click the | Save all changes
button):

Description Optional. Enter a description of the layout. The iCC displays this on the Layout pages

underneath the layout's name.

Layout Ad hoc Page | Check this box and the iCC will automatically create an ad hoc page if you add ad hoc items to

this layout.

If you add or remove ad hoc items, the iCC will add or remove them from that ad hoc page. If you
delete all ad hoc items, the iCC deletes the ad hoc page.
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Soundtrack Check the Include Soundtrack box to enable a soundtrack for this layout.

By default, the iCC checks the Add default media to Soundtrack's Playlist box. This means that
the iCC will play the default soundtrack media. If you uncheck that box, you will need to add a media
file by opening the Soundtrack item in the layout's Playlist menu.

Check the Enable media auditing by default for all items in the soundtrack box to include data
on the soundtrack items in the media audit reports.

2.2.5 Interaction Properties

The Interaction tab allows you to define how the layout responds to touch screen, remote control, and RS-232 input
events.

Note: The player may require a license to use these options.

For each type of interaction, the iCC offers three basic actions in response:
« No default action — The layout does not respond to the interaction.

« Advance to a rendezvous point — Specify the rendezvous point and the zone from the drop-down menus. For a
touch screen event, you can also choose whether this is on press or release and can configure an on-click sound.

« Change to layout — Specify the layout to change to from the drop-down menu.

In each case, the iCC also offers timeout options for you to further refine the response. You can specify the number
of seconds that the player waits:

« After the last event — Delays the response to an interaction.

« For the first event — Provides a response if there is no interaction during the timeout period.

See Using Interactivity for details on designing and implementing interactive responses.

2.3 Using Zones

You compose layouts from defined rectangular areas called zones. Each zone can display various types of media
content. The number of zones in your layout, their size, and location is up to you.

It is common to use different zones to display different types of content (for example, one for scrolling text, one for a
promotional video, and so on). However, any zone can display any media type: you just have to enable the zone with
the appropriate media player. You can have a zone display a single item or a sequence of items. You define the items
that a zone displays in a playlist.

2.3.1 The Layout Editor

To create and manage the zones in a layout, you use the graphical layout editor. To edit a layout, click its name on
the Layouts menu or on the Layouts > Manage Layouts page.
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The Zones tab provides the graphical editor that you use to adjust the position and size of each zone in your layout:

[(® Zones [i=] Layout Properties & Interaction F_,é"' Permissions

Designing for layout canvas size: 3840x2160 -
The Zone Properties window can be moved using drag-and-drop if it obscures the Layout design.
25%
& Add Zone | o1 SelectZone~ |  Zone Properties | ] Save~ | - :| + | Fit to view

By default, the editor displays the layout to best fit the current space on your screen. You can modify how the editor
scales and displays the layout by adjusting two options at the top of the screen:

Designing for layout canvas size — Select a canvas size from that drop-down list that matches the size and
orientation of your output screen. Besides the standard sizes listed, you can specify a custom size. When you
save the layout, the player uses that setting to size the display it creates. In the illustration, the canvas size
selected is 3840x2160.

— Click for the editor to display the layout to best fit the current space on your screen. Alter the

amount displayed by clickingthe * orthe = button: each click changes what is shown by 5%. Altematively,
click and move the slider. At 100% the display shows the layout at life size, but therefore not all of it may be
visible on your screen. In the illustration, the percentage is set to 25% so that all of a large layout can be seenin
the editor.

The editor displays each zone in a color indicating the media player enabled for the zone:

Red — Movie player (zone B)
Light green — HTML player (zone E).
Light blue — Image player (zone D).

Yellow — Text player (zone C).
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Note: The display shows the zones with a slight transparency (for example, to aid in aligning with background
images). This does not indicate how the zone appears when displayed on screen.

To select a zone, click it. The editor shows the selected zone with handles (as seen for zone E). To move the zone,
drag-and-drop it. To resize the zone, drag one of the handles.

You can also right-click a zone to open a context menu containing common functions:

Move to Front
Move to Back
Make Full Screen
Delete

Save all changes
Edit overlapping A

When you have finished making changes to your zones, click the ml button. This offers these options:

[ Savaalichanges | Simply saves your layout changes.

o Save alichanges and editPlaylist | _ 54,5 your layout changes and opens the playlist for you to edit it.

2.3.2 Editing a Zone

The graphical layout editor provides the following buttons to support your work on the layout:
. M — Click to add a zone to the layout. The iCC adds the zone for you to start sizing and positioning it.

. Ml — Click to display a list of all zones in the current layout.

,_Zone Properties |— Click to toggle the Zone Properties dialog off and on. The iCC displays the toolbar for the
currently selected zone.

. M — Click to select the Save options.

The - Salaclznnavland " Zone Properies

buttons provide the detailed editing features.

Click the Ml button to open alist like this:

o Select Zone » |

View All Zongs |

. # % EFront

Q
[ ] i % Background Back

The list highlights the currently selected zone (in this case, zone B).
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Perform the following actions with the Select Zone features:
e Click the (0] button to delete a zone.
« Click the | | button to select the zone you want to size and position. This includes zones hidden by other zones.

« Change the zone order by dragging-and-dropping the *8 icon. This is the zone order in layers (for example, moving
the 'Background' image to the back of the layout).

Close the Select Zone list by clicking its button again or clicking elsewhere on the page.

2.3.3 Editing a Zone's Properties

Click the el e button to open its dialog:

Zone Properties: AGENDA )

j e A Radia Properties

Zone Name: AGENDA
Media: [T TR (V] HTML Image Text

You can move the dialog around the screen by dragging it by its title bar. Close the dialog by clicking its ' * ' button or

by clicking the T

I button again.

You can access and configure the properties by selecting the appropriate tab and entering the values required:

Zone Choose from the following options:

« Zone Name — Optional. Enter a descriptive name for the zone. The ICC shows this name when
you are on a zone-specific page (such as in its playlist).

« Media — Check the relevant box or boxes to enable the zone to play that media type.

Size & Position | Size and position the zone by entering specific values.

Note: If you use pixel values, the result may vary according to the resolution of the screen.

« Top, Bottom, Left, and Right Edge Offsets — The iCC offsets the position of the zone relative to
the edge of the screen.

« Width — Exact width for the zone.
« Height — Exact height for the zone.

« Aspect Ratio — Use to automatically size the zone depending on the aspect ratio of its content.
Only available if you use pixels for Width and Height and do not select the Specify custom width
and height option. First, select the type of aspect ratio needed from the drop-down list. Second,
select whether the iCC calculates the required zone size keyed to the height or to the width.
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Properties Check the box or boxes to enable the options required:

« Image - If you have enabled the zone to show images, check this box to see the firstitem in the
playlistin the layout editor (instead of the standard colored area). This helps preview the image and
align other zones to it.

« Design Visibility — Uncheck this box so that the zone is not shown in thumbnail views. This helps to
edit other zones that are overlapped by this zone.

« Media Audit — Check this box to enable media audit reporting for the zone. You can override this on
an item-by-item basis in the playlist. See Reporting for more details on reporting.

2.4 Using Playlists

A playlist is a sequence of media items that you choose for display in a zone. Each zone has its own playlist and runs
independently of other playlists. A soundtrack also has its own playlist.

Playlists play their content in a continuous loop. After the player plays the last item, it starts again with the first.

You can include the following in a playlist:

« Individual content files (such as images, movies, or text).

« Special items (such as newsfeeds, TV stations, and tables).
« Folders containing multiple items.

« Ad hoc Items (controlled by your local users).

To add or modify items in a playlist, you need to access its specific page. Use one of these methods to access a
playlist's page:

« Onthe menu bar, click Playlists and select the zone from the relevant layout.

« Onthe menu bar, click Layouts > Manage Layouts and click on the zone in the relevant layout diagram.
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The playlist page has these tabs:

Playlist Lists the items in the playlist (displays their type, media details, play duration, and any time validity or
conditional play settings you have configured). To see how to add, copy, or change a file-based media
item, see Adding Media ltem Files to a Playlist.

The ICC may display icons to indicate the status of those items (as described in the Key panel at the
bottom of the playlist)

That default view of the playlistis called the Manage View. To open one of the additional play criteria

views, click the relevant button at the top right of the list:

. — Conditional Play View. Use this to view and edit the conditional play configuration of playlist
items. See Viewing and Editing Conditional Play for more information.

. — Time Validity View. Use this to view and edit the time validity configuration of playlist items.
See Viewing and Editing Time Validity for more information.

To return to the Manage View, click the - button.

Files & Folders | Lists the folders containing media items you can add to the playlist (also use to navigate between
folders and move files between folders). You can also add a whole folder to a playlist. See Media Run
from the iCC Disk for more information.

Upload Files Use to copy files onto the iCC and to create new folders. See Uploading Content Files for more
information.
Specials Use to add special items to the playlist (items other than files and folders). See Adding Special ltems to

a Playlist for more information.

Defaults Use to set the default properties for media items when you first add them to the playlist. Changing a
default value does not affect items already in the playlist.

Permissions Use to see the roles that can access the playlist and the users allocated with those roles. If a role has

only asset-based permissions, you can enable or disable the role's access here. See Asset-Specific
Permissions for more information.

The iCC provides the following action buttons for each item in a playlist:
* _Move theitem (by drag-and-drop).

@ — Delete the item.

— Add a copy of the item to the playlist.

# |~ Edit the item's properties.

2.41 Viewing and Editing Conditional Play

On the playlist page, click the & button to open the Conditional Play View. You control whether a playlist runs
conditionally by creating and applying player local information (see Player Local Information for more information).

Use the Conditional Play View to examine and edit the conditional play properties for all the items in the playlist. If

you make changes, click the | S2¥& | button. You can also access the conditional play for an individual item by editing
it and opening its Play Criteria tab.
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To understand the information displayed and the tasks you can perform, this illustration shows the essential features
of the view, which are described below:

PLI Name: Location -

&=/ Fo der: fila:/media/Haotal/Slidas == Falder: fila:/madia/Intarmational/Slidas
. [== Maediz: Image. Text — Mediz: HTML, Image. Text
PLI Value Filter:
Show 10 ~ PLI values Always Play A Location contains ALL of -

Previous Mext b
Main Hall

Meeting Room 1

Meeting Room 2 F

Reception
The left-hand column details the player local information:

PLIName Select the name of the PLI you want to use from the drop-down list (in this case, 'Location’).

PLI Value Filter | If you want to limit the number of PLI values displayed, enter a filtering string here. The filter is case
insensitive and you can use accented characters. The iCC starts filtering the PLIs as soon as you start

typing.

Show Select how many PLI values you want displayed at a time from the drop-down list. If there are more PLI
values than that, navigate through them by clicking the Previous and Next arrows.

The illustration shows how the iCC displays each PLI value on a row. The rows span all of the playlist item columns. Use the
check boxes in the columns to select the PLI values needed to create your conditional play.

The right-hand columns detail the playlist items and the conditional play applied to them:

Item type The item type is illustrated with a thumbnail (if available) and a description. In the case of a folder, a
Media line shows the zone type needed to display its content.

In the illustration, the playlistitem is a folder and the description is of its location.

If you hover your cursor over that header, the # | button appears: click it to edit the item's properties.

Conditional Choose the conditional operator from the drop-down list.

operator In the illustration, the first playlist item is set to the default, which is Always Play. That s, the item plays

regardless of any conditions you might set for other items in the playlist. In other words, this item is not
subject to conditional play.

The conditional play operators in the remainder of the drop-down list are (with reference to the
example 'Location’ PLI):

« Location contains ALL of — Item plays if all of the checked values are in the PLI.
« Location contains ANY of — Iltem plays if any of the checked values are in the PLI.
« Location contains NONE of — Item plays if none of the checked values are in the PLI.

The illustration shows that the player would only play the second playlist item if 'Location’ contains both
'Meeting Room 1'and 'Meeting Room 2".
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Check the boxes associated with the PLI values you want to apply. To apply all of the PLI values, check
the box below the conditional operator drop-down list.

The illustration shows that the PLI values 'Meeting Room 1' and 'Meeting Room 2' will be applied to the
second playlistitem.

2.4.2 Viewing and Editing Time Validity

On the playlist page, click the button to open the Time Validity View. You control the dates, days, and times
when a playlist item runs by modifying its time validity settings (see Play Criteria Properties for more information).

Use the Time Validity View to examine and edit the time validity settings for all the items in the playlist.
You can also access the time validity settings for an individual item by editing it and opening its Play Criteria tab.

To understand the information displayed and the tasks you can perform, this illustration shows the essential features
of the view, which are described below:

Filter Flaylist Ite Start Date 2015-03-02 Today Previous 7 Days Hext 7 Days

Monday Tuesday Weadnasday Thursday Friday Saturday Swunday

SIS 2015-03-02 2015-03-03 2015-03-04 2015-03-05 2015-03-D6 2015-03-07 2015-03-08

Faolder: file:/media/Hokal
[Shides

Media: Image, Text

[

Folder: file:/media
== /lokemational/slides
B Media; HTML, Image.,

Text

That view shows two playlist items, both of which are folders containing a mix of media:
« Thefirstitem plays during Monday, Tuesday, and Wednesday but not on Thursday or Friday.
« The second item does not play on Monday, Tuesday, or Wednesday but does play on Thursday and Friday.

« Both items play on Saturday and Sunday.

In more detail, the header options are:

Filter If you want to limit the number of playlist items displayed, enter a filtering string here. You can filter
on any string displayed in the Playlist Item column, including on folder path components. The filter
is case insensitive and you can use accented characters. The iCC starts filtering the playlist items
as soon as you start typing.

Start Date Click here for the iCC to open a calendar for you to select the view's start date. The view displays
the seven days starting with that date.

Today Click to set the view's start date to today.
Previous 7 Days | Click to view the previous seven days.

Next 7 Days Click to view the next seven days.
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The view displays each item on a row containing:

« Athumbnail of the item (if available) and a description. In the case of a folder, the description shows the zone
type needed to display its content. If you hover your cursor over the thumbnail, the| # | button appears: click it
to edit the item's properties.

« A calendar with blocks showing when the player will display the item. If you hover your cursor over any of the
blocks, the iCC displays a popup containing a summary of the item's time validity.

That time validity summary popup looks like this:

Folder: file: f media/Hotel / Slides
Media: Image, Text

Date Range

2015-04-02 - 2015-04-09
valid Days
Mon, Tue, Wed, Sat, Sun,

Edit Time Validity

As you see, the popup contains a summary of the item's description and time validity. To change the time validity

Edil Tirmme Valiglily

setting, click the button.

2.4.3 Adding Media Item Files to a Playlist

Before you can add a media item file to a playlist, you need to upload it to the ICC. You must have enabled the zone
to play the type of media you want to add to the playlist.

To add a file to a playlist, open the playlist page and follow these steps:
Click the Files & Folders tab.

1
2. If required, navigate to the location containing the file.

3. Click the | 494 | putton alongside the file you want to add.
4. Click the Playlist tab to view the updated playlist.

Perform any other required actions (for example, adjusting the play order or modifying the item properties).

After adding an item, you can include a copy of it in the same playlist by clicking its button.

For file-based or folder play items, you can change the item that the player uses by following these steps:
1. Open the playlist page.
2. Click theitem's | # | button.

3. Onthe Media tab, click the button to the right of the media location description. The wording on the button varies

according to the media type (for example, for an image file it is the |_Pick Image Media File | button).

4. Navigate to and click on the new file or folder.
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Click the | ® Pk fle | op | 8 Pick Felder [y itton,

Click the | SaveChanges |p, ton The player displays the updated playlist.

2.4.4 Adding Special Items to a Playlist

You can add special items to a playlist if supported by your ICC and the media you have enabled the zone to play.

There are two groups of special items:

Those you need to set up in advance.

Those you do not need to set up in advance.

The special items you need to set up in advance are:

Video (including TV stations).
Newsfeeds.
Tables.

The special items you do not need to set up in advance are:

Clocks.

Direct text.

External web pages.
QR Codes.
Interactivity actions.

The Wait, Rendezvous Point, Advance To, and Change Layout commands.

To add a special item to a playlist, open the playlist page and follow these steps:

1.

2.

4.

Click the Specials tab.

Click the |ﬂ| button alongside the item you want to add. (Depending on the item, you may need to enter text or
select properties first.)
Click the Playlist tab to view the updated playlist.

Perform any other required actions (for example, adjusting the play order or modifying the item properties).

2.4.5 Adding Folders to a Playlist

You can add a whole folder to a playlist. The player treats the folder as a single playlist item but plays the files within
it individually.

Before you add it, ensure that the folder contains the media items you want to use.

To add a folder to a playlist, open the playlist page and follow these steps:

1.

0N

Click the Files & Folders tab.

Click the |ﬂ| button alongside the folder you want to add.
Click the Playlist tab to view the updated playlist.

Perform any other required actions (see Folder Play Properties for information on how the player plays the
folder items).
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Part 3: Understanding Media Types

Your player units can display a great many types of digital content (also referred to as media).

When creating a layout, you must specify the type of media each zone will display. This enables the zone to 'play' the
media concerned. You can configure zones to support one or more of these players:

« Movie player — For media such as videoand TV.

« HTML player— For media such as web pages and tables.

« Image player — For media such as graphics and photographs.
« Text player — For media such as text and newsfeeds.

In addition to those media types, you can add audio to a layout using the Soundtrack feature (see Audio and Radio
for more details).

The iCC provides many features for setting up and managing the media items you want to use. It is important
to understand how the iCC handles groups of media differently depending on their types and characteristics:

. Media Directly Managed by the iCC (includes text, newsfeeds, clocks, tables, RS-232 outputs, and QR Codes).

. Media Run from the iCC Disk (includes video, text files, images and photos, audio, presentations, HTML web

pages, Adobe Flash files, PDF files, and folder play).
. Media from External Sources (includes TV, radio, live video, multicast video, and external web pages).

3.1 Media Directly Managed by the iCC

Some types of media are managed directly by the iCC. These include:
Text

Newsfeeds

Clocks

Tables

RS-232 ltems

QR Codes

You caninclude a wide variety of media items as ad hoc content and they are also directly managed by
the iCC. Using ad hoc content is described separately (see Ad Hoc Content for details).

3.1.1 Text

You can display text you directly enter on the iCC. (You can also display text files: see Text Files for more details.)

Zone player type to enable: Text.

Playlist tab containing the item: Special.
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Additional notes:

Supported Format iCC Notes

text editorial formats The text editor offers formatting features (for example, use of bold,
italic, font size, and color).

3.1.2 Newsfeeds

You can display newsfeeds from external sources on the player.

Broadcasters or news agencies (for example, the BBC or Reuters) provide newsfeeds containing headline news or
sports reports. Providers often do not charge and usually do not require usernames or passwords. However, some

providers do define terms restricting display of their newsfeeds in digital signage networks and you must check on

this before using newsfeed content.

Zone player type to enable: Text.
Playlist tab containing the item: Special.

Additional notes:

Supported Format Notes

RSS 0.91 and 2.0 (must say

'RSS' or XML ). Compatible newsfeeds are normally indicated by the L.u.J symbol.

To subscribe to a newsfeed, follow these steps:

1. Find the newsfeed using your browser.

2. Click the link to the newsfeed or click the RSS button k.
Copy the newsfeed's web address from the browser's address bar.

4. OntheiCC's menu bar, click Media and Newsfeeds.

5. Click the Add Newsfeed tab, complete the newsfeed properties, and click the| Add | button.

The newsfeed properties are:

Name Enter a unique name for the newsfeed.

RSS Newsfeed URL | Enter or paste in the newsfeed web address. You mustinclude the protocol (for example,
http://www.bbc.co.uk/travelnews/tpeg/en/pti/pti_rss.xml).

Refresh Interval Specify how often the iCC checks for updates.

Maximum Age Specify how long the iCC will continue to display existing items if there is no connection to the
newsfeed to obtain new ones.
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Authentication Select the required authentication style:
« No authentication required — The newsfeed does not require a username and password.
« Login with — The newsfeed requires a username and password. Enter them in the fields
provided.

Proxy Select the required proxy configuration:
. No proxy required — The iCC connects directly to the internet.
., Use proxy if configured — The iCC accesses the internet through the configured proxy. You
must first configure the proxy (on the Setup > System > HTTP Proxy page).

3.1.3 Clocks

You can display a digital clock on the player showing the date and time in any one of a variety of formats.
Zone player type to enable: Text.

Playlist tab containing the item: Special.

3.1.4 Tables
You can create and format tables for display on the player. Before you can add a table to a playlist, you have to create
it.

Tables are a convenient way of displaying static data. You can also use tables to hold ad hoc entries that local users
control (for example, a table showing conference center room allocations). The iCC creates tables using HTML.

Zone player type to enable: HTML.

Playlist tab containing the item: Special.

Adding and Editing an Ordinary Table:

To add a table, follow these steps:

1. Onthe menu bar, click Media and Tables.
2. Click the Add Table tab.

3. Enter a descriptive name for the table.

4

Enter the number of rows and columns. The maximum size is 19 rows by 39 columns. You cannot change the
size of a table after you create it.

5. Click the| Add | button.
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The iCC displays the Tables tab with your table added to the list. Click the button next to a table to take these
actions:

(0] Delete the table. You cannot delete a table that is in use. Check
the right-hand column to see the items using the table.

% Rename the table. Enter the new name in the field and click the
Rename Table |00, Ifyou decide not to rename the table,

click the |_GancelRename |y, o

Copy the table. Enter the name for the copy in the field and click
the M button. If you decide not to copy the table, click
the |_CancelCopy | ton.

& | Edit the table. To edit a table after creating it, follow the same

steps as described next for setting up a new table.

You need to set up your new table by following these steps:

1. Click the table's |_# | button.
2. Click the Style tab.

3. Take whichever of these formatting steps are needed to get the effect you want:
o Click the | EditBorder | putton to change the width and color of the border.
o Click the | Edit€elumn | pytton for each column you want to size manually.

o Click the | | button for each cell whose text font and size you want to adjust. Text Properties describes the
formatting options. You can edit one cell and specify that the iCC also applies those changes to other cells.

Click the Values tab.

5. Edit the default text in each cell as required.

6. Click the | Savealichanges | tion.

Adding and Editing Ad Hoc Tables:
To create an ad hoc table, follow these steps:
1. Create a table as described above.
2. Onthe menu bar, click Media and Manage Ad hoc Items.
3. Click the Add Item tab.
4. Addanew Ad hoc Table Item that references the table.
Note: If you copy an ad hoc table, the copied table is not an ad hoc table.
To edit an ad hoc table, open the Tables page and click the table's | # | Make changes on the Style and Default
Values tabs as described for the Style and Values tabs above. Click the Ad Hoc tab to specify the ad hoc features.
Click the| EditCell | button for the cell you want to change and select the option required:
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« Default Value — The ad hoc user cannot change the cell value.

« Override with any value — The ad hoc user can enter any value in the cell.

If you set the User Interface Policy to Detailed, the iCC also offers these options:

« Override with Integer between — The ad hoc user can only enter values between the lower limit and upper limit
you specify (both inclusive).

« Override with text of maximum length — The ad hoc user can only enter text up to the number of characters you
specify.

« Override value with text matching — The ad hoc user can only enter text that matches the regular expression
you specify. In the Feedback Message field, enter the message you want the player to display to the ad hoc user
if what they enter does not match the regular expression. Information about using regular expressions is readily
available (for example, at http://www.regular-expressions.info/).

3.1.5 RS-232 Items

You can add an RS-232 output item to a playlist. When the item is reached in a playlist, the player sends a character
string to an external device through its RS-232 port (for example, to switch on a light at the start of the day). See
RS-232 Qutputs for how to set up RS-232 items.

Zone player type to enable: any player type.
Playlist tab containing the item: Special.

To add an RS-232 output item to a playlist, follow these steps:
On the menu bar, click Playlists and select the layout and zone where you want to add the RS-232 item.
Click the Specials tab.
Check the Send RS-232 Item.

1

2

3

4. Click the| 489 |putton.
5. Inthe playlist, drag the % iconto adjust the position of the RS-232 item in the playlist, as necessary.
6

If required, click the # | putton to change the RS-232 item on the Media tab or to set conditional play on the
Play Criteria tab.

3.1.6 QR Codes

You can create and display QR Codes using the iCC.

QR Codes (Quick Response Codes) are two-dimensional barcodes carrying content that can be read by a suitable
device. For example, a QR Code can contain a web site URL or an email address: a user scans the QR Code with a
smartphone to open that web site or to compose an email to that address.

Zone player type to enable: Image.

Playlist tab containing the item: Special.
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Additional notes:

Supported Format Notes

QR Code The iCC creates QR Codes with Level H error correction (30%)
and uses byte encoding.

3.2 Media Run from the iCC Disk
Use the Media > Files & Folders option to manage media content files on the iCC disk.

Note: You cannot create or edit files on the iCC. Create or edit files elsewhere and upload the result to the iCC.
Click the tab for the options you require:

« Files & Folders —Manage the files and folders on the iCC disk (see below for details).

« Upload Files — Copy files from your computer onto the iCC (as described in Uploading Content Files).

« Permissions — Manage the roles that can access a folder and the users allocated with those roles. If arole has
only asset-based permissions, you can enable or disable the role's access here. See Asset-Specific
Permissions for more information.

The File & Folders tab provides these file management features:
« List—Displays all the files and folders in the current location.
« Navigate — Move between folders (click on a folder name or on a link in the Folder field to open it).

« Act—Delete, move, and rename files and folders and also copy files.

Click the button next to a folder to take these actions:
[(@]_ Delete the folder

% | —Move or rename the folder.
Click the button next to a file to take these actions:

[ ® |_Delete the file.

* | — Move or rename the file.

(9 ]_Copy thefile.

Note: You cannot take any folder or file actions in the iCC system folders.
Refer to the media-specific information to see which zone player type to enable and for additional notes
on the formats supported by the iCC:
Video
Text Files
Images and Photos

Audio

Presentations

HTML Web Pages
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Adobe Flash
PDF Files

Folder Play

3.21 Uploading Content Files

You can upload content files to the iCC in several ways:

« Using the Upload Files Tab — The iCC offers an Upload Files tab on the Media > Files & Folders page or when

you open a specific playlist.
o Using ETP
« Using Drag and Drap — If supported by your browser.

Note: Always add your content files to the Media folder or to sub-folders of the Media folder.

Using the Upload Files Tab:
You use both the Files & Folders and playlist Upload Files tabs in the same way:
1. Navigate to the folder where you want to add the file.
2. Click the Upload Files tab.
If required, create a subfolder:

a. Type aname for the subfolder in the Folder name field.

b. Click the | Create Falder | tton,
c. Click the subfolder name to enter it.
d. Click the Upload Files tab.

4. Click the| B/®se- | hutton and navigate to the file you want to upload.

5. Click the | UpleadFile |1 tton.

6. Repeat those steps for each file.

Using FTP:
Before using FTP, make a note of the IP address of your iCC. If you do not know the IP address, consult the person
who administers your network or reboot the iCC: it displays its IP address during the process.

Note: You need to have the FTP Read/Write permission on the iCC to upload using FTP. FTP may also be
disabled on your network for security reasons. If you have difficulty using FTP, check with the person who
administers your iCC or network.

You can upload using a dedicated FTP program. A quick alternative is to use Windows Explorer (or similar
file-management program):

1. Open two copies of Windows Explorer.

In the first copy, navigate to the folder with the content you want to upload.

. Inthe second copy, type ftp:// and the IP address of youriCC in the address bar (for example,
ftp://192.168.0.254) and press the Enter key.

4. When prompted, enter your iCC username and password. Windows Explorer now displays your default iCC
folder location.
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Navigate to the Media folder. Do not add or modify files in any other folder as this may render the iCC unusable.

6. As required, create further folders under the Media folder. It is good practice to create separate folders for each
layout and sub-folders for each zone (for example, media/Layout_reception/Zone_A).

7. Toupload content to the iCC, drag-and-drop or copy-and-paste folders and files from the first copy of Windows
Explorer to the second copy of Windows Explorer.
Note: If the FTP page does not refresh, press the F5 key or click Refresh to update it.

When you have connected Windows Explorer to your iCC with FTP, you can also:
« Rename and delete files on the iCC.

« Download files from the iCC to your computer using drag-and-drop or copy-and-paste.

You cannot move files from one folder to another using FTP. Instead, download the file to your computer and then
upload it to the other iCC folder. Alternatively, move files using the Media > Files & Folders page.

Using Drag and Drop:
Some browsers allow you to drag files off of your computer desktop and drop them directly into a playlist or a folder
on the iCC. The following browsers support drag and drop:

Operating System  Browser and Minimum Version

Windows. Microsoft Internet Explorer 9, Mozilla Firefox 6.0.2, Google Chrome 14
Mac OS X Mozilla Firefox 3.6.19, Google Chrome 14, Apple® Safari® 5.0.6
Linux Mozilla Firefox 6.0.2

Note these limitations of drag and drop:

« You cannot upload folders, only individual or groups of files.

. Ifyou upload afile to a place containing a file with the same name, the iCC overwrites the existing file.

. If the file is for a media type not enabled for the zone, you can upload the file but it will not appear in the playlist
until you enable its media type.

You can drag and drop a file into these locations using the method indicated:

« Playlist —Hover your cursor over the preferred position on the Playlist tab.

« Folder within a playlist — Hover your cursor over the folder on the Playlist tab.

« Folder—Hover your cursor over the preferred location on the Files & Folders tab.

« Folder within a folder — Hover your cursor over the folder on the Files & Folders tab.

To perform an upload using drag and drop, follow these steps:

1. Openthe page on the iCC that is the location for the upload (either a playlist or a folder).
2. Onyour computer desktop, select the file or files you want to upload.

3. Hold down the left mouse button.
4

Move your mouse until the cursor is over the upload location.
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5. Release the mouse button. The iCC displays a green progress bar as the upload proceeds (you might not see
this for small files). When the upload completes, the iCC confirms the file's name and location in that progress

bar.

3.2.2 Video

You can play various video formats with the player.

Zone player type to enable: Movie.

Note: By default, you can enable up to two movie zones. To enable more requires an additional license and the
maximum number is dependent on the player model. For best performance, only enable one movie zone per
layout on less powerful player models.

Playlist tab containing the item: Files & Folders.

To help you identify a particular video, the iCC displays a thumbnail image from it. That appears in the

Filename column of the Files & Folders display (and in the Media column when you add the video to the

playlist). TheiCC
displays the

Additional notes:

Supported Codecs

H.264

MPEG-1
MPEG-2

MPEG-4 (ASP and AVC)

VOB

WMV 9

Supported Containers

AVI

MOV

MPG

MP4

icon if it cannot render a thumbnail.

Notes

Recommended. Small file size but higher CPU load. However,
supports high definition.

Poor resolution.
Good combination of CPU load and resolution but large file size.

Small file size but higher CPU load. However, supports high
definition.

Same as MPEG-2.

Windows Media Video.

Notes

Microsoft® format. Can contain a wide-range of codecs. CPU load
and resolution depends on the codecs within (see table above for
guidance).

Apple® QuickTime® format. Can contain a wide-range of codecs.
CPU load and resolution depends on the codecs within (see table
above for guidance).

MPEG transport stream.

ISO MPEG-4 container (subset of MOV).
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3.2.3 Text Files

You can display text files on the player. (You can also display text you enter directly: see Text for more details.)
Zone player type to enable: Text.
Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes
TXT Plain text only. The player does not support the display of files

formatted by word-processor (for example, DOC or DOCX files
from Microsoft® Word or PDF files from Adobe® Acrobat®).

3.24 Images and Photos

You can display several image formats with the player.

Zone player type to enable: Image.

Note: Large images may take several seconds to appear and may slow down the performance of the player.
Always resize an image to match the size of the zone before uploading it.

Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes
PNG Recommended. Good quality and supports transparency.
JPG Recommended. Edges can blur and does not look good when

shown on a large screen.

GIF Can look very grainy. Only supports 256 colors but does support
transparency.

The player does not support animated GIFs. To use an animated
GIF, firstembed itinto an HTML page.

BMP Large file size but no loss of quality.

3.2.5 Audio

You can play various audio formats with the player.
You add audio files to a whole layout and not to an individual zone. Layout property to enable: Soundtrack.
Playlist tab containing the item: Files & Folders.

Additional notes:



Content Commander User Guide

Supported Format Notes

MPEG-1 (layers 1,2, and 3) | Performs acceptably on all player models.

MPEG-2 (AAC) Performs acceptably on all player models.
MPEG-4 (AAC) Recommended. Good performance.
MP3 Recommended. Good performance.

Uncompressed PCM (WAV) Container. High quality but much larger file size than MP3.
WMA V1-3 Performs acceptably on all player models.

AC3 Performs acceptably on all player models.

3.2.6 Presentations

Presentations often have complex animations, timings, and graphics. To ensure the player displays a presentation
correctly, save it in the best format to ensure faithful reproduction.

Zone player type to enable:
« If saved as video — Movie.
o If saved as Adobe Flash—HTML.

« If saved as image slide show —Image.
Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes
Microsoft® PowerPoint® Save as WMV video — Best option for high quality and complex
2010 (PPT, PPTX) animations and transitions but files can be large.

Save as Adobe Flash — Supports animations and transitions but
complex and fast animation may appear choppy. Creates small
files.

Save as image slide show — Use if animations and transitions are
not important.

Apple® Keynote® Save as MOV video — Best option for high quality and complex
animations and transitions but files can be large.

Save as a Video:

To save a PowerPoint 2010 presentation as a video:

1. Select File > Save & Send > Create a Video.

2. Select the Computer & HD displays profile as this is likely to be the best for the player.

3. When prompted, choose where to save the video.
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There are also third-party products specifically for converting PowerPoint 2010 presentations to video. Other
products are more general screen capture applications, which can be useful if you want to include mouse movement
or provide a voice-over.

Save as Adobe Flash:

There are third-party products for converting PowerPoint 2010 presentations to an Adobe Flash animation with
varying degrees of complexity. For example, you can use the free OpenOffice suite to open a PowerPoint 2010
presentation and export it to an Adobe Flash file but without slide transitions or animations.

Save as Image Slide Show:

To save a PowerPoint 2010 presentation as an image slide show:

1. Select File > Save & Send > Change file type.

2. Choose a supported image file type (PNG is recommended, but the player also supports JPG, TIF, and BMP).

3. When prompted, choose where to save the files and select Every Slide.

3.27 HTML Web Pages

You can display local HTML files on the player. (You can also display whole or part pages from a remote web site:
see External Web Pages for details.)

Zone player type to enable: HTML.
Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes

HTML The player displays HTML using the WebKit browser engine for
Linux. (The Apple Safari and Google Chrome browsers also use
the WebKit engine.)

WebKit supports web pages including JavaScript® and Adobe
Flash but not ActiveX®.

3.2.8 Adobe Flash

You can display Adobe Flash files with the player.

Note: Complex Adobe Flash files may not run smoothly on less powerful player models.
Zone player type to enable: HTML.
Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes

SWF The player supports Adobe Flash Player version 11.

Flash files give no indication to the player that they are finished.
You need to set a maximum duration when you add the file to a
playlist to force the player to move on to the nextitem.
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3.2.9 PDF Files

You can display pages from PDF files with the player.
Zone player type to enable: Image.
Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes

PDF Supported version: ISO 32000-1:2008 (also known as PDF 1.7).
Earlier versions may display correctly but are not supported.
The player cannot display:
« Dynamic PDF content (such as forms).

« PDF files secured by password.

3.2.10 Folder Play

Rather than adding a number of files individually to a playlist, you can add and play an entire folder from
the iCC disk. This is known as Folder Play.

Zone player type to enable: as required by the media types in the files.
Playlist tab containing the item: Files & Folders.

You can configure folder play properties to control how the player plays the files:

« Insequence —Files play in file name order. Numbers come before letters and uppercase characters before
lowercase (for example, '1' comes before 'A" which comes before 'a').

« Inrandom order - Files play in a random order (shuffle play).
Coupled with the order of play, you can also configure these properties:
« How many of the files to play.

« The number of files to jump before playing the next file.

See Folder Play Properties for more details about how to configure folder play.

3.3 Media from External Sources

You can display media running directly from external sources with the player.

Refer to the media-specific Information to see which zone player type to enable and for additional notes on the
formats supported:

v

Radio

Live Video

Multicast Video
External Web Pages
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3.31 TV

You can play output from external digital TV stations with the player.
Zone player type to enable: Movie.
Playlist tab containing the item: Specials.

Additional notes:

Supported Format Notes

Digital TV Broadcast DVB-T digital TV, where available.

The player must be set up with:
« TV antenna connected toits TV socket.

« TV tuner card tuned to the digital transmitter.

See TV & Radio for more details of tuning and setting up digital TV.

3.3.2 Radio

You can play output from external digital radio stations with the player.
You add audio to a whole layout and not to an individual zone. Layout property to enable: Soundtrack.
Playlist tab containing the item: Specials.

Additional notes:

Supported Format Notes

Digital radio Digital radio stations, where available.

The player must be set up with:
« ATV antenna connected to its TV socket.

« Atuner card for tuning in to the stations (see TV & Radio for more details).

See TV & Radio for more details of tuning and setting up digital radio.

3.3.3 Live Video

You can output live video from various devices with the player.
Zone player type to enable: Movie.

Playlist tab containing the item: Specials.

58



Content Commander User Guide

Additional notes:

Supported Formats Notes

HDMI capture Includes output from video cameras, DVD players, set-top

HDMI capture (analogue audio) boxes, and so on.

Component video Your player must be set up with:

S-Video « The correctlicense.

Composite video o ATV tunerorvideo capture card.

« The appropriate video cable connecting the video device to
the TV tuner card.

Before the player can display the video, configure it to recognise the video source as a TV input (as described in the
TV & Radio section of the Net-Top-Box User Guide).

3.3.4 Multicast Video

As an alternative to receiving TV broadcasts directly, the player can receive multicast video (also known as Internet
Protocol Television (IPTV)) over the local network.

Note: Using multicast video requires an additional license.
Zone player type to enable: Movie.
Playlist tab containing the item: Specials.

Additional notes:

Supported Format Notes

MPEG-2 Transport Stream in | Your player setup needs to include:

ubP « An Internet Group Management Protocol (IGMP) network
infrastructure to support multicast streaming.

« A device to stream video onto the network.

Before the player can display the video, configure it to recognise the video source as a TV input (as described in the
TV & Radio section of the Net-Top-Box User Guide).

3.3.5 External Web Pages

You can display whole or parts of pages from an external web site with the player. See Displaying Part of a Movie or

Web Page for details of how to display only a part of a web page. See HTML Web Pages for how to display HTML
files held locally on the player.

Zone player type to enable: HTML.

Playlist tab containing the item: Specials.
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Additional notes:

Supported Format Notes

HTML The player displays HTML using the WebKit browser engine for
Linux. (The Apple Safari and Google Chrome browsers also use
the WebKit engine.) WebKit supports web pages including
JavaScript and Adobe Flash but not ActiveX.

To display a web page, the player must have live access to it at the
time. If the web page requires a username and password to log in,
include those in the URL in the format:
protocol:/lusername.password@site.

Adding External Web Pages to a Playlist:
To add an external web page to a playlist, follow these steps:

1. Openthe web page you want to link to and copy its whole URL address. (You can also sometimes use the
URL to link to a specific frame or image to display.)

On the iCC menu bar, click Playlists and select the zone in the layout you want to add the page to.
Select the Specials tab.
Paste the web site URL into the External Web Page field.

Click the | #dd | putton.

o o kw0 D

In the playlist, you can drag the % iconto adjust the item's position or click its # | button to modify its
properties.

Notes:
o HTML pages always have a white, non-transparent background.

o Auto-refresh web pages direct the player browser to reload the page at regular intervals. Add auto-refresh
pages to a playlist with an indefinite duration to be sure that they always show the latest information.
Determine whether a page auto-refreshes by searching forthe <meta http-equiv=refresh>taginits
HTML code:

o To keep non-auto-refresh pages current, you need to reload them periodically. To do so, add the pages to a
playlist with a fixed duration, as this forces the player to reload the page.

Saving Web Pages to Disk and Adding to a Playlist:
As an alternative to displaying a web page directly from an external source, you can save it on the iCC.
This removes the connection to the source and your files will not be updated if the source changes.

To save the HTML files, use your browser's Save function. For example, with Internet Explorer, follow these steps:

1. From the File menu select Save as.
2. Navigate to the location where you want to save the files.

3. From the Save as type drop-down list, select Web page, complete. This saves the page as well as all its
associated files (such as images). Internet Explorer saves the associated files in a folder called pagename
files, where pagename is the name of the HTML page.
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When you have saved the HTML page and its files, add to a playlist by following these steps:

1.

Upload the HTML page file and the filesfolder with all its files onto the iCC. If you need to include other files
(for example, a JavaScript file implementing additional features) add them tothe filesfolder. See Uploading
Content Files for how to upload files.

Note: Drag-and-drop will not upload folders so you cannot use it to upload the files folderin one action.

Add to a playlist as described in Adding Media Item Files to a Playlist.

3.4 Media ltem Properties

There are different playlist properties for each type of media item. To edit the properties for a playlist item, click the

# | putton alongside the item.

The iCC displays the properties on these tabs:

Media — Location and name of the media. Can also contain ad hoc, touch screen, and item-specific properties (for
example, for clocks, newsfeeds, and folder play).

Style — Properties specific to the media type (this tab is not shown for folder play items).

Play Criteria — Properties controlling when the item plays (time validity and conditional play). (See Play Criteria
Properties for details.)

Advanced — Advanced properties that apply to all media items (position and size and media audit). (See
Advanced Properties for details.)

The following table lists the generic properties you will find on the Media and Style tabs for each of the zone media

players:
Movie HTML Image Text Soundtrack
Duration o 0] o 0]
Deinterlace O
Mode O o
Letterbox Color O o
Subtitles O
Volume O 0] 0]
Opacity (0] @) (0] (0]
Movie Size (0]
Web Page Size 0]
Zoom 0]
Page Background 0]
Fade In o
Fade Out o
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Movie HTML Image Text Soundtrack
Text Style (0]
Font
Text Color
Background Color
Horizontal Alignment
Vertical Alignment
Margins

White Space

0O O o o o o o o

Character Set

For details of those generic properties, see the information specific to each type of media player:
Movie Properties

HTML Properties

Image Properties

Text Properties
Soundtrack Properties

Some playlist items have properties additional to the generic properties. For details of those item-specific properties,
see the information for each item:

Newsfeed Properties

Clock Properties
PDF File Properties

Folder Play Properties

Ad Hoc Properties

3.4.1 Movie Properties

The following properties apply to a zone enabled as a Movie player:

Subtitles Check the Display subtitles box to enable subtitles for the video (if available).

Duration Select the duration you require:
« Play all of the movie — The movie plays continuously.

« Play the movie for — The movie plays for the period you specify.

Volume Enter the volume as a percentage of the maximum volume.
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Deinterlace The player automatically performs deinterlacing if required. To explicitly enable or disable
deinterlacing, select Yes or No from the drop-down list.
Hardware Decode Select whether to use hardware or software decode:

« Use hardware-assisted decoding if possible — Default. If your player has graphics processing
hardware, the player uses it to decode and display the movie. This usually provides higher
performance.

« Always use software-only decoding — The player decodes and displays the movie using
software running on its CPU. For example, you might select this option if you have movies
showing in multiple zones and another movie needs the higher performance of hardware-decode.

Depending on the configuration and content of your layout, choosing one or other option for an
individual movie can require a trade-off between performance and processing resources.
Mode You can set the display mode to one of these options:

« Fitto Zone — Stretches the movie to fill the zone. This will distort the movie if the zone does not
have the same aspect ratio as the movie.

« Letterbox — Shows the entire movie and preserves its aspect ratio. The player displays the
letterbox color in any space in the zone not covered by the movie.

« Crop — Preserves the movie aspect ratio but cuts off its edges if it is larger than the zone.

Letterbox Color If you select Letterbox as the display mode, some space may be left in the zone outside of the
movie. Use this option to select the color the player displays in that space.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is
completely opaque and 1% is almost completely transparent.
Movie Size Choose the option you require:
« Use Zone Size — Display whole movie in the zone.
« Show Part of Movie — Display only a 'window' view of the movie in the zone:
o Left edge offset — Amount to indent the window relative to the movie's left edge.
o Top edge offset — Amount to indent the window relative to the movie's top edge.
o Movie width — Full width of movie.
o Movie height — Full height of movie.

Note: This is only available if you set the User Interface Policy to Detailed or Expert on the Ul
Options page.

3.4.2 HTML Properties

The following properties apply to a zone enabled as an HTML player:

Duration Select the duration you require:
« Play the HTML file indefinitely — The player shows the web page always.
« Play HTML file for — The player shows the web page for the period you specify.

Volume Enter the volume as a percentage of the maximum volume.
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Web Page Size Choose the option you require:

« Use Zone Size — Display whole movie in the zone.

« Show Part of Web Page — Display only a 'window' view of the movie in the zone:
o Left edge offset — Amount to indent the window relative to the page's left edge.
o Top edge offset — Amount to indent the window relative to the page's top edge.
o Web Page width — Full width of page.
o Web Page height — Full height of page.

Note: This is only available if you set the User Interface Policy to Detailed or Expert on the Ul

Options page.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is
completely opaque and 1% is almost completely transparent.

Zoom Enables the Zone to zoom in on the HTML content. Smaller than 100% zooms out (to get the whole
web page in a small zone for example) or larger than 100% zoom in, to fill the zone with partofa
web page.

Page Check the HTML Page allows transparent backgrounds box to enable a transparent background

Background (for example, to allow view of a background zone).

Note: Enabling this prevents Adobe Flash playing correctly in the HTML zone.

Automatic Sign In | Check the Customise page box to enable the player to perform an automatic sign in to the web
page. The player detects if the page requires sign in. Enter the username and password of the
credentials required.

This is an example web-page customisation achieved by applying external code to the HTML page.
Contact Black Box for more information on customisation.

Page Services Check the Allow HTML media... box to enable access to the player page-support services for the
Black Box web APIs.

3.4.3 Image Properties

The following properties apply to zones enabled as an Image player:

Fade In You can set the image to fade in with one of these options:
» No Fade in — Image appears immediately without fading in.

« Fade In n.n seconds — Image fades in from the background. Specify the number of seconds for the
fade-in to last (defaultis 1.5 seconds).

« Cross fade from previous image — Image fades in as the previous image fades out. You must also
set the previous image's Fade Out option to Cross fade to next image. If no previous image is set
to cross fade, this image fades in from the background in the number of seconds you specify
(defaultis 1.5 seconds).

Duration Select the duration you require:
« Show image indefinitely — The player shows the image always.

« Show the image for — The player shows the image for the period you specify.
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You can set the image to fade out with one of these options:
« No Fade out — Image disappears immediately without fading out.

« Fade out in n.n seconds — Image fades out to the background. Specify the number of seconds for
the fade-out to last (defaultis 1.5 seconds).

« Cross fade to next image in n.n seconds — Image fades out as the nextimage fades in. You must

also set the nextimage's Fade In option to Cross fade from previous image. If no nextimage is
set to cross fade, this image fades out to the background in the number of seconds you specify
(defaultis 1.5 seconds).

You can set the display mode to one of these options:

« Fit to Zone — Stretches the image to fill the zone. This will distort the image if the zone does not
have the same aspect ratio as the image.

« Letterbox — Shows the entire image and preserves its aspect ratio. The player displays the
letterbox color in any space in the zone not covered by the image.

« Crop — Preserves the image aspect ratio but cuts off its edges if it is larger than the zone.

If you select Letterbox as the display mode, some space may be left in the zone outside of the image.
Use this option to select the color the player displays in that space.

To allow background items to be visible, enter a percentage to match the opacity required. 100% is
completely opaque and 1% is almost completely transparent.

3.4.4 Text Properties

The following properties apply to a zone enabled as a Text player:

Text Style Choose the option for how you want the text displayed:
« Show text indefinitely — Displays always.
« Show text for — Displays for the period you specify.
« Text moving from right to left at speed — Scrolls right-to-left at the speed you specify.
« Text moving from left to right at speed — Scrolls left-to-right at the speed you specify.
« Text moving from bottom to top at speed — Scrolls bottom-to-top at the speed you specify.
« Text moving from top to bottom at speed — Scrolls top-to-bottom at the speed you specify.
For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).

Font Select the font family you want and the size and style to apply.

Text Color If you want text in a different color than the default, click the | PekEalewr | hytton to select an
alternative.

Background Color If you want the background in a different color than the default, click the Pk Colowr | hytton to

select an alternative.

Horizontal Alignment Select the text horizontal position (only enabled for stationary and vertically-scrolling text).

Vertical Alignment Select the text vertical position (only enabled for stationary and horizontally-scrolling text).

Margins

Set values to add blank space at each margin (in pixels).
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White Space Choose the option for how you want extra spaces, tabs, and new lines handled (collectively
termed 'whitespace'):

. Display spaces and new lines as entered — Display all whitespace as entered (default).

- Display multiple spaces as single space and multiple new lines as a single new line —
Ignore extra whitespace.

Note: This property is for text files only.

Character Set If necessary, select an alternative text-encoding standard.

Note: This property is for text files only.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100%
is completely opaque and 1% is almost completely transparent..

3.4.5 Soundtrack Properties

The following properties apply to the audio playlist for layouts enabled with the Soundtrack option:

Duration Select the duration you require:
« Play all of the audio file — The soundtrack plays continuously.

- Play audio file for — The soundtrack plays for the period you specify.

Volume Enter the volume as a percentage of the maximum volume.

3.4.6 Newsfeed Properties

The iCC holds a newsfeed's properties in a number of locations. Access each group of properties by:

« Clicking the # | button for the newsfeed on the Media > Newsfeeds page (see Newsfeeds for a description of
those properties).

o Clicking the # | button for the newsfeed in the playlist. The iCC displays some properties on the Media tab and
some on the Style tab.

The newsfeed properties on the playlist Media tab are:

Item Type Indicates who can make changes to the setup on this page (click the Save Changes and
change Item Type button to alter this).

Ad Hoc Entry Label Enter a reference label for the iCC to use in the playlist Media column.

Allowed Choices Select which newsfeeds the ad hoc user can choose:
« All Available Newsfeeds — User can choose from any of the newsfeeds you have added.

o Only Selected Newsfeeds — User can choose only from the newsfeeds you check.
Default Newsfeed Select the default newsfeed from the drop-down list.

Fields Select whether to display components of the newsfeed other than the content:
« Title — Newsfeed title.

« Description — Newsfeed summary description.

Customization Status  Indicates the newsfeed selection status.
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The newsfeed properties on the playlist Style tab are:

Item Selection

Item
Synchronization

Text Style

Font

Text Color

Background Color

Horizontal Alignment
Vertical Alignment
Margins

Opacity

Choose the properties that specify how you want the iCC to choose from and sequence the
newsfeed articles:

« Play all ltems — Play all of the articles.
« Play only the first n items — Play just this number of articles.

« Play all ltems in groups of nitems — Jump this number of articles before playing the next
article.

« Select items sequentially — Play articles in title order. Numbers come before letters and
uppercase characters before lowercase (for example, '1' comes before 'A’ which comes
before 'a’).

« Select items at random — Play articles at random (shuffle play).
If you need to synchronise between zones, select the appropriate option for your
synchronisation strategy:

« Slave - track changes to Master — The media shown in this zone is controlled from a
master zone.

« Master — This zone controls the media shown in a slave zone.

You may want to show the headline in one zone and the details in another zone: see
Playlist Displays Between Zones for how to keep the displays aligned.

Choose the option for how you want the text displayed:

« Show first Newsfeed item indefinitely — Displays always.

« Show each Newsfeed Item for — Displays for the period you specify.

« Text moving from right to left at speed — Scrolls right-to-left at the speed you specify.

« Text moving from left to right at speed — Scrolls left-to-right at the speed you specify.

« Text moving from bottom to top at speed — Scrolls bottom-to-top at the speed you specify.
« Text moving from top to bottom at speed — Scrolls top-to-bottom at the speed you specify.

For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).
Select the font family you want and the size and style to apply.

If you want text in a different color than the default, click the Fick Calawr | button to selectan
alternative.

If you want the background in a different color than the default, click the Pk Calawr | hytton to
select an alternative.

Select the text horizontal position (only enabled for stationary and vertically-scrolling text).
Select the text vertical position (only enabled for stationary and horizontally-scrolling text).
Set values to add blank space at each margin (in pixels).

To allow background items to be visible, enter a percentage to match the opacity required.
100% is completely opaque and 1% is almost completely transparent..
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3.4.7 Clock Properties

The iCC holds a clock's properties in the playlist's Media and Style tabs.

The clock properties on the Media tab are:

Display Content
Day of Week Format
Date Format

Year Format

Month Format

Time Format

Hour Format

Time Zone

Select the overall date and time format.
Select the positioning and format of the day.
Select the sequence of date components.
Selecta 2 or 4 digit year display.

Select a month name or number display.

Select whether to use the time format for the locale (defined on the player Setup > Player >
International page) or the one you specify here.

Select whether to use 12 hour or 24 hour clock.

Select the required time zone from the drop-down list.

The clock properties on the Style tab are:

Duration

Font

Text Color

Background Color

Horizontal Alignment
Vertical Alignment
Margins

Opacity

Select the duration you require:
« Show Clock indefinitely — The player displays the clock all the time.
« Show Clock for — The player displays the clock for the period you specify

Select the font family you want and the size and style to apply.

If you want text in a different color than the default, click the | Pk Calowr | pytton to select an
alternative.

If you want the background in a different color than the default, click the | FekCaleur | pytton to
select an alternative.

Select the clock's horizontal position.
Select the clock's vertical position.
Set values to add blank space at each margin (in pixels).

To allow background items to be visible, enter a percentage to match the opacity required.
100% is completely opaque and 1% is almost completely transparent.

3.4.8 PDF File Properties

With one addition, PDF files have the same properties as images (see Image Properties for details).
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The addition is an option to select the pages you want the player to display. To select the pages you want displayed,
take these steps:

1. Add the PDF file to the playlist.

2. Click the PDF file's | # | button.
3. Open the Media tab.
4. Enterthe required setting in the PDF Pages to be shown field.

Depending on the setting, the player will display pages in sequence, repeatedly, in groups, and in a different order
than they appear in the file. If you have more than one PDF file in a folder play, the settings apply to all those PDF
files. This table contains example settings to illustrate the flexibility available to you (note the use of commas and
hyphens to delineate page selections):

Example Setting Pages Displayed

1- All pages from page 1 to the end. This is the default setting.
10- All pages from page 10 to the end.

15 Page 15.

15,7 Pages 1,5,and 7.

1-3,6-9 Pages 1,2,3and6,7,8,9.

3-5,3-5 Pages 3,4,5and 3,4, 5.

1-5,7-3 Pages 1,2,3,4,5and 7,6,5,4, 3.

7-2 Pages 7,6,5,4, 3, 2.

-1 All pages in reverse order (page 1 last).

3.49 Folder Play Properties

The iCC displays folder play properties on the Media tab. Besides the folder play properties, this contains
properties for all of the player types enabled for the zone.

You can customie how long the player plays movie, HTML, and SWF (Adobe Flash) files. Specify the length of play
by adding the string -duration-x just before the file extension (where x is the duration in seconds). For example,
the player would play the file logo-intro-duration-17.swf for 17 seconds. This customisation has no effect
if you add the file into a playlist individually.

The following specific properties apply to folders in a playlist:

Media Check the box to enable the relevant media player for the zone.

Management Check the Management box to enable ad hoc management of this folder.

If the ad hoc user places files in the indicated ad hoc media folder, the player plays them instead
of those in the current folder. If there are no suitable files in the ad hoc media folder, the player
plays the files in the current folder.
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Item Selection

Item Synchronisation

Choose the properties that specify how you want the player to choose from and sequence the
files:

« Play all tems — Play all of the files.
« Play only the first nitems — Play just this number of files.
« Play all Items in groups of nitems — Jump this number of files before playing the next file.

« Select items sequentially — Play files in file name order. Numbers come before letters and
uppercase characters before lowercase (for example, '1' comes before 'A’ which comes
before 'a').

« Select items at random — Play files at random (shuffle play).

If you choose a property other than Play all items, the player plays files in the sequence you
have chosen. To do that, it records which files it played and when (in other words, retains the
current state of play). Folders in different playlists run through their sequence independently.

However, you may went to ensure that the player synchronises the order of folder play between
different playlists. That is, have the player restart each folder play sequence from the beginning.
To do so, add a Folder Play Reset item to the playlist at the point where you want that to
happen. Select Folder Play Reset from the options on the Specials tab. Combine folder play
reset with the rendezvous point and advance to features to create the synchronised play you
require.

If you need to synchronise between zones, select the appropriate option for your
synchronisation strategy:

« Slave - track changes to Master — The media shown in this zone is controlled from a master
zone.

« Master — This zone controls the media shown in a slave zone.

See Playlist Displays Between Zones for more details.

You can combine folder play properties to create complex sequences to meet specific requirements. For example,
you may wish to set up a playlist that showed a sequence of music videos in a fixed order, and between each video
show two randomly selected advertisements followed by a corporate logo for a fixed time.

To create this sequence of folders, follow these steps:

1. Create three folders on the iCC as follows:

o Music

o Advertisements

o Logo

2. Upload videos into the Music folder. Rename the video files as necessary to create the play order you want
(for example, 'A Summer in the city.mpg, B Be my girl.mpg', and so on).

Upload the advertisements into the Advertisements folder.

4. Upload the logointo the Logo folder.

Create a playlist as follows:

o Add the Music folder to the playlist (set to play all items sequentially).

o Add the Advertisements folder to the playlist (set to play only the first two items randomly).

o Addthe logo image as an individual file (set duration 10 seconds).
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3.4.10 Play Criteria Properties

All media items have the properties present on the Play Criteria tab.

The following properties apply to any zone:

Time Validity

Conditional Play

To control when the player shows an item in a playlist, check the relevant boxes and set the times
you require:

. Date Range — Select the dates during which you want these settings to apply (for a single day,
set both dates the same).

« Days — Select the days you want the item to appear.

« Time Period — Select the period during which you want the item to appear.

Examples when you might choose to use this property:

. To play adverts only on certain days of the week.

« To show a traffic report only after 5.00 pm.

Points to note:

« Outside the times you specify, the player skips the item when its turn comes in the playlist.
« The player continues to play the item even if the valid time expires before the item ends.
This is only enabled when you have added player local information to the player (see Player Local
Information for details).

Ifitis enabled, you have two options:

« Play Always — Default. The player always plays the item.

« Play if Player Local Information Item — The player only plays the item if certain conditions are
met.

If you select Play if Player Local Information Item, complete these steps:
1. Selectthe name of the relevant player local information from the first drop-down list.

2. Selectthe test to apply from the second drop-down list.

3. Enter the value to test for in the final field (add further values by clicking the * | putton or
delete values by clicking the @ button).

4. Click the | SaveChanges |, o

3.4.11 Advanced Properties

All media items have the properties present on the Advanced tab.

Other than the Media Audit property, the iCC only displays the Advanced properties if:

« You have set the User Interface Policy to Detailed or Expert on the Ul Options page.

« You have previously enabled the property.
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The following properties apply to any zone:

Position and Size | To override the position and size of a zone, select the Use custom position and size radio button
and set the values you require:

« Top edge offset — Amount to move the zone relative to the screen's top edge.
- Left edge offset — Amount to move the zone relative to the screen's left edge
« Width — Width for the zone.
« Height — Height for the zone.
This property is not applicable to soundtrack items.
Media Audit To change whether the player collects media audit data to send in its reports, check the relevant
radio button:

« Inherit the zone's media audit setting — The player collects or does not collect the data
depending on the setting in the zone's properties.

. Disable media auditing — Disables data collection even ifitis enabled in the zone's properties.

- Enable media auditing — Enables data collection even ifitis not enabled in the zone's properties.

3.4.12 Ad Hoc Properties

The iCC displays ad hoc properties on the Media tab.

You can apply the following properties to directly entered text, newsfeeds, radio, TV, and tables that you have set
to be customizable or ad hoc:

Item Type Click the |_S2ve Changes and change llem Type |}, 1101 to save any existing changes to the item

and to open the page to select the item's type:

« Content of this item is controlled by the Layout Designer
« Content of this item can be customised using this Layout's Ad hoc Entry Page
« Use an existing Ad hoc Item

« Create and use a new Ad hoc Item

Ad Hoc Entry Label The label used to refer to this item on the layout's Ad hoc Page.

Ad Hoc Iltem Name Unique identifier for the ad hoc Item on the iCC. (Only for ad hoc items that you cannot
customize.)
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Properties dependent  The iCC displays some properties that are dependent on the type of ad hoc item: «
on media type Directly entered text:
o Ad Hoc Input — Options to format the text and specify allowable ad hoc user input.

o Default Text — Enter default text to display.

o Customisation Scope — Either Local (customised text displays only on the ad hoc user's
local iCC) or Remote (customised text displays on players that are subscribers to the ad
hoc user's iCC).

« Newsfeed:

o Allowed Choices — Whether you allow the ad hoc user to select all or a subset of the
available newsfeeds on the player.

o Default Newsfeed — Select the default newsfeed to display.
o Fields — Whether to display newsfeed with or without title or description.
« TV and radio:

o Allowed Choices — Whether you allow the ad hoc user to select all or a subset of the
available stations on the player.

o Default Station — Select the default station to play.
o Subtitles — Whether or not to display subtitles (if available).
« Tables:

o Table — Name link to the Ad Hoc tab of the Media > Tables page for configuring the
table.

Customisation Status | Indicates if this item is currently displaying its default value or if it has been overridden by an ad
hoc user.

Used By Layouts Lists the layouts that use this ad hoc ltem. (Only for ad hoc items that you cannot customise.)

3.5 Playlist Commands
You can use the following playlist features to alter the display sequence and appearance:

« Rendezvous Points and the Advance To Command

« Change Layout Command

3.5.1 Rendezvous Points and the Advance To Command

Each playlist displays a sequence of items that operate independently. Even if two playlists contain items of exactly
equal lengths, you cannot rely on their display being completely synchronized. Instead, if you want to achieve
synchronization between playlists, you need to use a combination of Advance To commands and Rendezvous
Points.

An Advance To command in a playlist causes the player to start displaying an item in another playlist. You specify
the item to display by placing a matching rendezvous point at an appropriate place in the other playlist. If the receiving
zone's playlist contains the rendezvous point, the player immediately starts playing the playlist item after the
rendezvous point.

To link the two together, the Advance To command refers to the rendezvous point by name. You can select whether
the player passes the Advance To command to a single zone or to all zones in the current layout. Therefore, by
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placing the same rendezvous point in several zones, you can trigger actions in all of them with a single Advance To
command.

You can also use the Advance To mechanism to initiate player actions as a result of user interactions, such as
motion sensor, pressure mat, or touch screen events (see Using Interactivity for more details).

To add a rendezvous point to a playlist, follow these steps:

Click the Specials tab.

N O~

In the Rendezvous Point field, enter a name. You can enter any text for the name (but not starting with the string
auto_)and names are not case-sensitive.

w

Click the |94 | pytton.

>

Make sure the rendezvous point appears immediately before the item you want the player to synchronize with the
other playlist.

5. If required, repeat to create additional rendezvous points in other playlists.

6. Addthe Advance To command.

To add an Advance To command to a playlist, follow these steps:
Click the Specials tab.

1
2. From the Advance To Rendezvous Point drop-down list, select the relevant rendezvous point name.

Click the | #A94 | pytton.

w

>

Make sure the Advance To command appears immediately before the item you want the player to synchronize
with the other playlist.

o

If you want the Advance To command to target only a specific zone:
a. Click thel # |button.

b. Select the zone from the drop-down list.

c. Click the| Save Changes |y, tton

Note: If you want to change the Advance To command to point to a different rendezvous point or to different
zones, click the # |putton and alter your selection.

3.5.2 Change Layout Command

Unlike the Advance To command, the Change Layout command launches a different screen layout with its own
arrangement of zones.

If you want to implement a simple change of the layout, then the Advance To command brings a quick result.
However, it is difficult to implement a complex change using the Advance To command. The Change Layout
command displays a different layout entirely, but it does take longer to refresh the screen.

To add a Change Layout command to a playlist, follow these steps:
Click the Specials tab.

1
2. From the Change Layout drop-down list, select the new layout you want to use.

3. Click the | A9d | pytton.

4. Make sure the Change Layout command appears in the right place in the playlist.
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Note: If you want to change the Change Layout command to point to a different layout, click the # | button and
alter your selection.

3.6 Colors

Use the Media > Colors page to set the colors the iCC applies to fonts, backgrounds, and other items.

When you create a new layout or a new table, the iCC automatically creates new color items:
« Forlayouts, the coloritems are for the text foreground, the text background, and the letterbox background.
« Fortables, the coloritems are for the text foreground and text background.

The iCC names color items in the format Layout name: Color item. For example, if you create a new
layout named 'Holidays', the iCC creates the following color items for it:

« Text foreground — Holidays: Text

« Text background — Holidays: Background

« Letterbox —Holidays: Letterbox

You can modify the properties for these color items as needed.

You define a Color Item by a unique name, a colour value, and an opacity setting. If you change the colour value
or opacity setting, the iCC updates all the items that use the color. Click the button to apply your changes. You
can define more than one color item with the same color values.

Click the tab for the option you require:

« Colors —Listing the color items and their characteristics. Click the @ button to delete a color (you cannot
deleteitif it is in use). Click the # | putton to:

o Modify a color — The settings are as described for the Add Color tab. Click the | SaveChanges |, tton to
enable your modifications.

o Access the Used By tab — Lists which layouts are using the color.

« Add Color — Adding a new color manually.
To add a new color, complete the following details and click the | Add Calourliem | p jttop:

Name Enter a unique and meaningful name for the color. This does not have to be in Layout name: Color item
format followed by the iCC.

Color Value Specify the color using either separate RGB values or a single hexadecimal value. On a Windows PC,
you can find the RGB values for a color you want to use by following these steps:

1. Click Start and select All Programs > Accessories > Paint.

2. Open a file containing an image that uses the target color.
. 4
3. Use the Color Picker tool to select a pixel of the target color.

4. Click the Edit Colors tool 'l-..

o

Read off the RGB values at the bottom right of the Edit Colors display.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is
completely opaque and 1% is almost completely transparent..
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3.7 Fonts
The iCC offers a collection of standard fonts that are suitable for most purposes.

To view the installed fonts:

1. Onthe menu bar, click Media and Fonts.
2. Click the Font Families tab.

The Font Families tab shows details of all the fonts available on the iCC (including those you install). The Font
Files tab lists the files for any fonts you install.

If you want to use a font that is not available on the iCC, you must add your own font files. The iCC supports

TrueType® (TTF or TTCZ'and OpenType® (OTF) format font files. The new font is published in a channel and picked
up by every subscriber. However, a subscriber has to reboot before being able to display the font.

To add a font file, follow these steps:

1. Onthe menu bar, select Media and Fonts.
2. Click the Add Font File tab.

3. Click the | B™®Wse- | hytton and navigate to the font file you wish to add.

4. Click the 2= |putton.

5. Click the | UpleadFent |p o
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Part4: Enhancing Your Displays

You can enhance your digital sign display in various ways:

Playlist Displays Between Zones

Using Interactivity

Using the RS-232 Interface Port

Displaying Part of a Movie or Web Page

Changing the Screen Background

4.1 Playlist Displays Between Zones

You can synchronize the display between playlists in useful and sophisticated ways using rendezvous points
and Advance To commands.

Examples include:

« Displaying video orimages in one zone and related text captions in another zone (for a method to achieve this, see
Automatic Captioning).

« Displaying a selection of videos or images in response to ad hoc user input (for a method to achieve this, see
Displaying Video-On-Demand Using a Sub-Playlist).

You can achieve further complex and powerful results with other of the rendezvous point and Advance To command
mechanisms:

« An Advance To command executed in any currently playing playlist (including in the same playlist).

« An Advance To command delivered over the player's Ethernet port in the form of an XML message posted to the
HTML TCP port.

« AnAdvance To command in a schedule entry orin an ad hoc page.
« A change in binary input lines on the RS-232 port initiating an Advance To command.

« Anevent on an attached touch-sensitive screen initiating an Advance To command.

411 Automatic Captioning

To implement synchronisation between zones, you need to designate one playlist as the Master Playlist and one or
more other playlists as Slave Playlists. You add rendezvous points to each slave playlist and the identically named
Advance To command in the master playlist. When the master playlist reaches the Advance To command, the
player forces the slave playlists to start playing the first item after the rendezvous point.

To have the player perform automatic captioning, you have to use files with corresponding file names. For example,
to display captioning for a video file called Marketing Highlights 01.mpg, you would need to create afile
calledMarketing Highlights 01.txt containing the text captions.

To set up automatic captioning between the zone playing the video and the zone playing the captions, first set up the
video zone:

1. Upload all the videos into one folder on the iCC.
2. Open the video zone's playlist page.

3. Click the Files & Folders tab and navigate to the video folder
location.
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©® N o o &

Click the folder's @ button.

Click the Playlist tab.

Click the folder's £ | button.

From the Item Synchronisation drop-down list, select Master.

In Movie properties, select the Duration option Play the Movie File Indefinitely.

Click the | SaveChanges | tton,

Second, set up the captioning zone:

© ® N o o O D -~

Upload all of the text files into one folder on the iCC. (This can be the same folder that contains the videos.)
Open the captioning zone's playlist page.

Click the Files & Folders tab and navigate to the text folder location.

Click the folder's |42 | pytton.

Click the Playlist tab.

Click the folder's | # | button.
From the Item Synchronisation drop-down list, select Slave - Track Changes to Master.

In Text properties, select the Text Style option to Show Text File Indefinitely.
Click the | Save Changes | ptton,

4.1.2 Displaying Video-On-Demand Using a Sub-Playlist

You can use the Ad hoc mechanism to configure the player to show videos on-demand (in response to a button-click)
by using a series of Advance To commands. The same mechanism can also be used to set up images or any other
media type to be displayed on-demand. You do this using sub-playlists.

You can create aloop, or sub-playlist, by inserting both a rendezvous point at the beginning of a sequence of items
and an Advance To command at the end of the sequence in the same playlist. This means that the player displays
the items in the sequence in a continuous loop until another Advance To command breaks out of the loop.

Toillustrate that mechanism, here is a sequence of items in a playlist:

Rendezvous Point: Start

o Default Movie item

o Advance To: Start

Rendezvous Point: Option1

o Option1 Movie Item
o Advance To: Start

Rendezvous Point: Option2
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That playlist sequence might run like this:

1. The player plays Default Movie item in a continuous loop created by the Advance To command and rendezvous
point Start.

An Advance To command Option1 arrives from an ad hoc page.
The player starts playing the item after rendezvous point Option1 and this is Option1 Movie Item.

At the end of Option1 Movie item, the player processes the Advance To command Start.

o & 0D

The player therefore retumns to rendezvous point Start and plays the Default Movie Item again in a continuous
loop.

To create a sub-playlist loop, follow these steps:
Click on a zone to edit its playlist.

Click on the Specials tab.

Click the |- 484 | hytton to add the rendezvous point to the playlist.

1
2
3. Type the name of the loop into the Rendezvous Point text box (use as descriptive a name as possible).
4
5

. Add the items that must appear in the sub-playlist in the usual manner. If you want a sub-playlist to play just once,
insert an image at the end with an indefinite duration.

6. Inthe Specials tab, select the rendezvous point by name from the Advance To Rendezvous Point list and
click the | 494 | putton.

7. Make the layout live by adding to a schedule and clicking the button.

You are now able to switch between playlists by adding Advance To commands to an ad hoc page:

1. Select Media > Manage Ad hoc items, and click the Add Item tab.

Add

2. Select the Advance To type, enter a name, and click the |
for each rendezvous point.

I button. Repeat to add an Advance To command

Select Media > Design Pages > Manage Ad hoc pages, and click the Add Pages tab.

Create a new page with a name such as 'Movie control'.

Click the| # | button and add the ad hoc items for each rendezvous point to the ad hoc page.

o o k~ w

In the Properties tab, select the users who are allowed to call the commands.

7. Click the | SaveChanges |p tton

4.2 Using Interactivity

You can configure the player to respond to inputs from an external source. External inputs are known as Events and
they may be caused by:

« Someone pressing or releasing a defined area on a USB touch screen.

« Someone passing a detector or stepping on a pressure mat that generates a general purpose input/output (GP10)
signal (received through the player unit's RS-232 port or adapter).

« Someone pressing a button on a remote keypad (infrared controller).
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The way you configure the player to respond may include:
« Executing a Change Layout command.

« Executing an Advance To command.

Those responses are known as Actions and you can configure the player to take them immediately or after a
timeout. Together, the combination of an event and an action is known as an Interaction.

For all events (or timeouts), you can have the player take one of these actions:
« Change to a specified layout.

« Advance to a rendezvous point.

« Ignore the event for this zone or layout and pass it to another zone or layout.

Additionally, for touch and GPIO events, you can have the player take one of these actions:

« Touch and GPIO events — Take no action.

« Touch event —Pass to a web page. If the zone supports HTML, the player can pass a touch event to the currently
showing web page. If there is no web page, the player takes no action.

Playlist and Layout Interaction:

To provide detailed control, you can specify behaviour that differs at the playlist and at the layout level:
« Playlist:
o Process the interaction if someone touches the currently playing item.

o Keep the interaction process active awaiting other events. You can implement complex behaviour by defining
multiple interaction actions in the same playlist.

« Layout:
o Process the interaction if there is no playlist action (that is, the layout action is a default).

o Process the interaction if someone touches anywhere on the screen.

You will find it easier to review layout interaction behaviour because the ICC displays all layout components
at once.

To configure touch actions for a playlist, you must either:

« Include an On Touch Advance To command in the playlist.

« Include an On Touch Change Layout command in the playlist.

« Play an HTML page in the zone.

To add items, click on the playlist's Specials tab and select those required. You can include more than one On

Touch Advance To or On Touch Change Layout commands in the playlist. Each On Touch command overrides
the previous one. This allows you to have the player change its response to touch events throughout the playlist.

If you enable touch for a zone that is displaying an HTML page, the player passes touch events to the HTML player
for handling. You can use this to allow a user to navigate through web pages using links embedded in the displayed
HTML page.

Note: To use HTML navigation, either omit On Touch playlist items or use On Touch Screen Event Perform
No Action (found on the playlist's Specials tab) to deactivate existing On Touch items. Otherwise, On Touch
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items will take precedence over the HTML player. Then, the player only passes Left Mouse Button Up and
Down events to the HTML player.

To configure touch actions for a layout, on the menu bar click Layouts and select the layout you want to configure.
Click the Interaction tab and select the touch screen actions in response to a touch screen event. The settings
include:

« Whether a touch response is required for this layout at the layout level or not.
« Whether the touch response is a Change Layout or Advance To command.
« Whetherit is the touch or release operation that causes the action.

« The period after which the layout will revert to another layout in the absence of a touch event.

Interaction Processing:
The way the player processes an event depends upon:
« The source (touch screen, GPIO, or remote keypad).

« The currently active interactions.

The player processes interactions for touch screen events as follows:
1. Creates a list of zones showing items directly underneath the touched screen location.
2. Processes that list in depth order, starting with the top zone.

If a zone has an active touch action, and that is not to pass the event to another zone, the player performs the
specified action and stops processing.

4. If no zone has an active touch action, the player performs the touch action defined for the layout.
The player processes interactions for RS-232 input events as follows:
1. Creates alist of all zones showing items coincident to the RS-232 input.

2. Processes that list in depth order, starting with the top zone.

If a zone has an active RS-232 input action, and that is not to pass the event to another zone, the player performs

the specified action and stops processing.
4. If no zone has an active RS-232 input action, the player performs the RS-232 action defined for the layout.
The player processes a remote keypad button event as follows:

1. Creates alist of all zones showing items coincident to the remote keypad button event.

2. Processes that list in depth order, starting with the top zone.

If a zone has an active remote keypad button action, and that is not to pass the event to another zone, the player

performs the specified action and stops processing.

4. If no zone has an active remote keypad button action, the player performs the remote keypad action defined for
the layout.

Passing Touch Events to HTML Pages:

If the current zone supports HTML, the player can pass touch events directly to the currently showing HTML page.
Using this technique, you can build rich interactive applications using stored HTML content. However, you cannot
create interactions with external web sites.
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When developing such HTML applications, you will likely require a large number of files. In order for the ICC to keep
track of these files during channel publishing and layout package creation, follow these rules:

« Initiate the application from a single HTML file (you can redirect from here to other files as required). Add that file to
the playlist.

« Place all additional files in a single subdirectory named [pagename] files, where [pagename] is the name of
the initiating HTML file (without its extension). Locate that subdirectory in the directory containing the initiating
HTML file.

4.21 Designing Interactive Layouts

You can design layouts that respond to user input in various ways:

« Send an Advance To command to play a specific item or start a playlist.
« Change the current layout.

« Change the size and position of a zone.

« Display hidden zones.

« Send asignal to another device through the RS-232 port or adapter.

Y ou might find the following general guidance helpful when developing interactive layouts.

Develop a Storyboard:

Advance planning is particularly important when designing a layout that smoothly offers choices and options to users.
A storyboard is a plan based on a series of sketches of individual scenes. Storyboarding is very effective technique
when designing interaction sequences. You can create a storyboard with sketches of screen layouts or simply with a
flowchart. The important point is to detail all possible outcomes at each stage of interaction.

Provide Material for Optional Actions:

You must make sure that you have collected and uploaded all the media files you require for any possible scenarios
controlled by interaction events. Before you start implementing your interaction events, create playlists for zones that
include all the necessary Advance To commands and rendezvous points.

Trade-Offs Between Display Change Methods:

You can change the display in response to an interaction either by changing the size and show/hide properties of a
zone or by using a Change Layout command. Each method has advantages and disadvantages:

Method Advantages Disadvantages

Change zone size and show/hide Very fast transition Continues using existing media
properties players

Use Change Layout command Resets all media players Slower, visible transition

4.2.2 General Purpose Input/Output

The player can respond to changes in voltages generated by a GP10 device such as a motion sensor or a pressure
mat. The player receives those inputs through its RS-232 port or adapter. It can also send output signals. For more
details see the RS-232 Technical Reference.
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Control-Line Inputs:

The player RS-232 interface has four input lines that can receive binary events such as contact closure or signals
from other devices. The available lines are:

o ClearToSend (CTS).

« Data Carrier Detect (DCD).
« Data Set Ready (DSR).

« Ring Indicator (RI).

The lines do not affect the operation of the RS-232 Send and Receive strings.

Include an RS-232 input item in a playlist and configure it to issue an Advance To or Change Layout command.
Use those commands to change the media played by the player. This is triggered when the player detects a line
transition generated by a user action.

Control Line Outputs:

The player can control the output state of the RS-232 DTR and RTS lines. Create RS-232 output items to change one
or both RS-232 outputs and optionally transmit a string of characters. Give the RS-232 output items unique names to
clarify their purpose.

4.2.3 Touch Screens

The player includes support for touch screen input from users. These features allow you to configure the player to
respond to those user inputs (for example, by executing Advance To or Change Layout commands). Connect an
overlay touch-screen panel to the player through its USB port.

4.2.4 Click On Touch

You can configure the player to play an audio file when someone touches an interactive screen.

To play an audio file, click the layout's Interaction tab and enable Click on Touch. The player does not play a sound
when the settingis No Click on Touch.

Specify these items:

« Volume - Express volume as a percentage of the Master Volume level. (You can specify the Master Volume
level on the Audio page in the Setup menu.) If this entry is blank, the player uses 75% of the Master Volume
level.

« Actions — Check the audio file's Use sound button. If necessary, navigate to the location of the file using the
folder display.

4.3 Using the RS-232 Interface Port

If you require the player to control equipment through an RS-232 interface, use its built-in RS-232 port or the USB to
RS-232 adapter, whichever is appropriate for the player model.

Considerations for sending RS-232 strings at specific events or playlist positions:

« Define the strings by expressing their byte values as separated hexadecimal pairs (for example, 3A 3B 3C 0D
0A).
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« Create the strings in accordance with the needs of the attached device.

« The state of the RS-232 control lines does not affect transmission of RS-232 strings.

Considerations for receiving RS-232 strings:

« The player reports the most recently received string in the Items tab on its Setup > Player > RS-232 Outputs
page.
« The state of the RS-232 control lines does not affect reception of RS-232 strings.

4.4 Displaying Part of a Movie or Web Page

You can configure a movie or HTML item in a playlist to display only a part of its output.

This is useful if you want to:
« Show a specific area of a movie or web page without resizing it.

« Crop amovie designed for a 16:9 (widescreen) format to a 4:3 (standard) format. This avoids resizing the zone,
which would alter the aspect ratio and distort the image.

To display only part of a movie item, modify the values for its Movie Size property (see Movie Properties for details).
To display only part of an HTML item, modify the values for its Web Page Size property (see HTML Properties for
details).

4.5 Changing the Screen Background

When switching between layouts, you can have the player display a colored background orimage. It can also
display this background in any areas of a layout that are not covered by zones.

Note: Setting the color to black is not recommended because it makes fault-finding more difficult.
To change the screen background, follow these steps:
1. Onthe menu bar, click Media and Screen Background.

2. Select either Solid color or Image:

o If youselect Solid Color, then click the | Fsktaleur | button to select a color.

o If you select Image, then browse the file system for an image. If you want a splash screen effect, set the
Layout Activation option to Activate new Layout after and select the delay from the drop-down list.

3. Click the| Save Changes | button.
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Part5: Ad Hoc Content

The Ad hoc feature allows you to delegate limited control of content to staff local to the display. This is particularly
useful where several players share the same channel but also need some customised content. The people at each
location can make those changes with a quick and easy, browser-based operation.

Local control of content is important in a wide range of application areas:

« Inan office, a secretary or office administrator can display welcome messages for visitors or display staff
information.

« On auniversity campus with multiple displays, different information may need to be delivered to different faculties
about upcoming events, room allocations, and so on.

« Inthe retail sector, store information and special offer details will vary from branch to branch.

« In health care, patient information and other details will vary in different hospitals or GP practices in the same
health authority area.

As the content designer, you delimit how much access is allowed at each site. You retain control of the key display
elements to maintain a consistent appearance and uniform identity for your organisation.

The ad hoc environment consists of these components:

« Ad hoc user —The person, usually at the display location, who has limited access and can update or change only
the content items you specify.

« Ad hoc entry —Is where ad hoc users log in through their browser, access pages that are available to them, and
make their changes.

« Ad hoc media folders — Contain all the media files that the ad hoc user can use when updating or changing
content.

You can delegate local responsibility for several different types of content:
o Text

« Tables

« Newsfeeds

« TV channels, radio stations, and streaming TV

« Folders

You can allow ad hoc users to update customisable content you have added to a playlist or update content they
create in the layouts you have allowed them to access.

As well as giving such access to content, you can also allow ad hoc users to:
« Change complete layouts.

« Change display schedules.

« Perform schedule overrides.

« Synchronise content.

You can also delegate control of a channel to an ad hoc user. In this case, you designate certain items as Ad
hoc from Center. This allows the ad hoc user to update those items on the iCC and in turn that updates
each subscribing player.
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The ad hoc system is secure: no ad hoc user can make changes unless you specify the customisable item and give
the user permission to access it.

5.1 Enhanced Ad Hoc Access Control

Generating ad hoc content is quick and easy. As the content designer, you can build-in ad hoc content during
implementation of your design. Alternatively, you can work with an existing design and allocate ad hoc content as
required. Whichever route you choose, the overall time taken for generating display content is minimised. Ad hoc
users can be working with the system productively with minimum delay.

Automatic Ad Hoc:

By default, the iCC enables automatic ad hoc for all newly-created layouts. You can control whether it is disabled or
enabled with the Layout Ad hoc Page setting on the layout's Layout Properties tab.

Automatic ad hoc makes creating content easier, as it eliminates many of the configuration and setup tasks. The
layout automatically creates a single ad hoc page, which contains all ad hoc playlist Items in the layout. As you
add orremove ad hoc items, the iCC automatically adds or removes them from the layout ad hoc page.

You have full control over ad hoc pages, including specifying which users are or are not authorized to make
changes. However, you cannot add or remove existing ad hoc Items or reference ad hoc items in other layouts.
Therefore, automatic ad hoc is unsuitable if you want multiple layouts to use the same ad hoc item.

Manual Ad Hoc:
Manual ad hoc gives you complete responsibility for creating and managing all ad hoc pages and the items within
them. You need to add ad hoc items to one or more playlists and one or more ad hoc pages, as required.

You must create an ad hoc item before you can add it to a playlist. Similarly, you must create an ad hoc page and add
one or more ad hoc items to it before it can be used by ad hoc users.

In manual ad hoc mode, you can create ad hoc pages that contain ad hoc items added to multiple layout playlists. For
example, this is useful if you want to show the same ad hoc welcome message on multiple layouts.

Creating Ad Hoc Content as You Build Your Design:

Create your layout in the normal way:

On the menu bar, click Layouts and Manage Layouts.
Click the Add Layout tab.

Add

Enter a name for the layout and click the | I button.

Create the zones you require and enable them to play the ad hoc media items you want to add.

1
2
3
4. Locate your new layout on the Layouts page and click its # button.
5
6

Click the |_52¥® | pytton and select Save all changes and edit Playlist from the drop-down list.
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You can now add ad hoc items. The way in which you do this depends on the type of ad hoc item you want to add:

Text 1. On the playlist's page, click the Specials tab and enter the text you wish to be displayed.

2. Check the Content of this item can be customized using this Layout's Ad hoc Entry Page box.

3. Click the | Add | button.

4. Clickthe | |button and set the item's Customization Scope:
o Local — Only for the individual subscriber.

o Remote — For all the subscribers to this channel.

Tables You should have already created and formatted the ad hoc table you require.
1. On the playlist's page, click the Specials tab.

2. From the Table Item drop-down list, select the table you want.
3. Click the 499 | pyton.

4. Click the table's | |button.

5. Click the | Save Changes and change llem Type | button.

6. Check the Use an existing Ad Hoc Item button and select the table from the drop-down list.
7. Click the | Save Changes |y, on,

Newsfeeds You should have already configured the newsfeed you require.
1. On the playlist's page, click the Specials tab.
2. From the Newsfeed drop-down list, select the newsfeed you want.

3. Check the Content of this item can be customized using this Layout's Ad hoc Entry Page box.
4. Click the | 4899 | pytton.
5. Ifyou want to further configure the item's ad hoc options, click the # I button.

TV and Radio You should have already added the TV and radio stations. For radio, you must enable the layout's
Stations soundtrack.
1. On the playlist's page, click the Specials tab.
2. Take the action appropriate to the type of station you want:
o TV —From the Live Video drop-down list, select the station you want.
o Radio — From the Live Radio drop-down list, select the station you want.

3. Check the Content of this item can be customised using this Layout's Ad hoc Entry Page box.
4. Click the | -A89 | pytton.

5. Ifyou wantto further configure the item's ad hoc options, click the # I button.
Converting an Existing Design to Ad hoc Content:

You can create ad hoc content after you have completed a design. To create ad hoc content in an existing design, the
process is the same as in each case above. You need to disable Automatic Ad Hoc in the Layout Properties tab.
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Creating Ad Hoc Pages:

When ad hoc users log on, their Home page displays the Ad Hoc Pages you create. Ad hoc users cannot access
any other player user interface pages. You design the ad hoc pages to display only the text fields ad hoc users can
change or the commands they are allowed to issue.

To create an ad hoc page:

1.
2.
3.

o &

IS

10.

On the menu bar, click Media and select Design Pages > Manage Ad hoc Pages.
Click the Add Page tab

Enter a name for the page. Use a name that will be easily recognizable by your ad hoc users.

Click the |94 | pytton.

Click the page's | # | button.

Add

Select the item you require from the drop-down list and click the | I button.

To add more ad hoc items, click the Add Item tab again. Rearrange the order of items using the [#] and [#]
buttons.

Click the Properties tab. Add any instructive text in the User Guidance Message field.

Click the Permissions tab. Check that the enabled roles are those you want to have access to ad hoc content.
Make any necessary changes.

Click the | S2ve Changes | t1on

5.2 Remote Keypad Control

For convenience and ease of use, ad hoc users can control their local player using an infrared remote keypad. This
enables them to change content at the touch of a button instead of having to access the player by their browser.

The remote keypad has the following controls:

Volume (up and down) — Adjusts the master volume level in 10% divisions.

Station (up and down) — Controls the ad hoc TV and radio stations played. The user can scroll up and down the
station list.

Programmable buttons (A, B, C, and D) — Each can be programmed to correspond to a specific rendezvous
point or layout.

When the user presses a button, the player displays a status message at the top right of the screen.

To allow ad hoc users to control the display with the remote keypad, take these steps:

1.
2.
3.
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On the menu bar, click Layouts and select the one the remote keypad will control.

Click the Interaction tab.

For each button, check the action required:

o No default Button Action — Check for the player to take no action when the user presses this button.

o When button is pressed Advance to Rendezvous Point — Check to assign a rendezvous point to this
button. Choose the zones you allow the ad hoc user to control.

o When button is pressed change to Layout — Check to assign a layout to this button. Ad hoc users press
this button to switch the display to that layout.
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To allow ad hoc users to choose TV or radio stations, take these steps:

1. Onthe menu bar, click Media and Manage Ad hoc items.

2. Click the Add Item tab.

3. Fromthe Add Ad hoc Item of Type drop-down list, select TV or Radio.
4

5

Add

Enter a name for the item and click the | | button.

Inthe Ad hoc Item property Allowed Choices, select one of:

o All Available TV or Radio Stations — Allows ad hoc users to select from any TV or radio station configured
on the player.

o Only Selected TV or Radio Stations — Allows ad hoc users to select from the TV or radio stations you
choose.

5. Select the default TV or radio station from the Default TV or Radio Station drop-down list.

5.3 Additional Ad Hoc

Additional Ad Hoc features allow for greater customisation of layout content. This is particularly useful in a
channel, where a network of players all play the same content.

Using additional ad hoc, multiple players in a channel can each show different content, controlled by ad hoc users
locally. This allows an organisation to maintain a consistent appearance or brand image across a number of sites,
while allowing local users to upload their own content and change the layouts and playlists to which they have been
given access.

The content types that can be used with additional ad hoc include:
« Folder play

« Layout

« Schedule

« Schedule override

« Advance To

Folder play allows you to add a folder to a playlist and give ad hoc users permission to upload their own content into
the folder. For example, different GP practices with players in the same channel could carry different local information
about late night dispensing chemists.

Layouts allow the ad hoc user to select a layout for a specific time slot in the schedule. Typically, if an organisation
published a channel with a layout for each department, an ad hoc user in each department could select the right
layout for that location.

Schedule allows the ad hoc user to set the time when a layout should appear on the display. For example, if alunch
hour layout has been scheduled, but times vary at different locations, local ad hoc users can set their times
accordingly.

Schedule override allows the ad hoc user to display one of a selection of predefined layouts and not have this
interrupted by any other layout changes in the schedule. For example, this can be used to show a special TV event or
display an emergency message without interruption.
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Advance To allows the ad hoc user on-demand control in several areas, including content selection. For example,
this might be useful in a foyer where the player is showing a corporate video in a continuous loop. The Ad hoc
Advance To command allows a local user to switch to live TV if required.

The following two procedures describe:
« Setting up an ad hoc schedule override.

« Setting up an ad hoc Advance To command .

Ad Hoc Schedule Override:

To set up an ad hoc schedule override and make it available to ad hoc users:
On the menu bar, click Schedules.

Select the channel name and Manage Schedules.

Click the Add Override tab.

Enter a descriptive name for the override.

o~ o Dd =

Select the audio, screen, and layout options from the drop-down lists.

Click the | Add Ovemide |1 t1on

o

7. Onthe menu bar, click Media and Manage Ad hoc items.
8. Click the Add Item tab.

9. Enter a name for the override in the Add Ad Hoc Schedule Override field and click the | 244 | putton.

10. Inthe Allowed Choices panel, select one of the following:

o All Available Schedule Overrides — Allows ad hoc users to select from any schedule overrides configured
on the player.

o Only Selected Schedule Overrides — Allows ad hoc users to select only from the schedule overrides you
select.

11. Select the appropriate Customisation Scope option:
o Local — Customisation applies on the individual player.

o Remote — Customisation applies on each player in the channel.

12. Click the |_SaveChanges |p ii0n

Ad Hoc Advance To Command:

To set up an ad hoc Advance To command:

On the menu bar, click Help and Ul Options.

Select the User Interface Policy as Detailed or Expert.

Click Playlists and select the layout and zone to locate the Advance To command.
Click the Specials tab.

Add a rendezvous point to the playlist and give it a name.

Add one or more media items to the playlist.

Click the Specials tab

N o o b~ w0 D=
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8. Select the Advance To item that has the same name as the rendezvous point you created and add it to the
playlist. This causes the playlist to loop back to the start again, regardless of what may follow.

9. Add a second rendezvous point to the playlist.
10. Add one or more ad hoc media items to the playlist.

11. Add the Advance To command that has the same name as the second rendezvous point to the playlist. This
causes the playlist to loop continuously through the ad hoc media items. If you want to revert back to the original
media items, omit this step.

12. On the Manage Ad hoc Items page, create an ad hoc Advance To item and select the names of the two
rendezvous points you have created.

13. Add those ad hoc Advance To items to an ad hoc page.

14. Log in as an ad hoc user and browse to the ad hoc page you have created.

15. Select the Advance To command that you wish to test and click the |_22¥& | putton. If the player is playing the
playlist, it will jump to the point in the playlist under the selected rendezvous point.

5.4 Ad Hoc from Center

The Update from Center feature allows ad hoc users to make changes on an iCC that will be updated to the
channel's subscribers. The ad hoc users on the iCC can only change the content on the ad hoc page you create.
You can use the Update from Center feature with ad hoc text and schedule override items. When you create an
ad hoc from center item, you set its scope as one of:

« Local — Default. Ad hoc text items behave as normal. Ad hoc users can log in and change the contents for
each player.

« Remote — Ad hoc items will only be visible to ad hoc users on the iCC. Changing the ad hoc item on the iCC

causes updates to all subscribers too. To restore the original schedule, select Default Schedule from the Ad
hoc page.

Subscriber players may not normally check for updates often enough if the ad hoc from center changes are
frequent. Therefore, you can configure the subscriber players to check for update from center items more
frequently. On the subscriber, the Channels > Manage Subscription page offers the Update From Centre Poll
Interval option. This determines how often the subscriber polls for update from center items and changes
accordingly. The subscriber player checks for normal updates and for updates from center independently.

5.5 Managing Ad Hoc Items

The ad hoc items page allows you to create, delete, and set properties for ad hoc items. Reach that page from the
menu bar by clicking Media and Manage Ad hoc Items.

To create an ad hoc item, click the Add Item tab. Select the item type from the drop-down list or select one of the
other types displayed and enter a unique name for it.

To delete an ad hoc item, click the @ button. If the iCC does not display the item's @ button, itis inuse and

cannot be deleted. To see which items are in use, click the | # | button and look at the Used By Layouts and Used
by Ad hoc Pages information.
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When you add an ad hoc item, you can also set a range of properties, depending on the item. The ICC
supports these item types:

« Advance To

« Layout

« Newsfeed

« Schedule

« Schedule override
o Text

o« TV

« Radio

When you add an item, you have to select one of these Allowed Choices options:
« All Available — Permits the ad hoc user to choose any of the defined items.

« Only Selected — Permits the ad hoc user to choose only those items you select.

In addition, for schedule override and text items, the iCC offers you the Customisation Scope option. Use this to
select where those ad hoc items can be customised and displayed:

« Local — Customization applies on the individual player.

« Remote — Customization applies on each player in the channel.

Text also has its own set of ad hoc options. Use these to control what an ad hoc user can enter in the Default Text
and Ad hoc User pages:

« Rich text—No validation is performed.
« Plain text— An ad hoc user cannot customise the text colour or styling.

« Integer between — Enter the lower and upper integer limits (both inclusive) for ad hoc content. This option is only
shown if you have set the User Interface Policy to Detailed.

« Plain text of maximum length — Limits the maximum length of plain text. This option is only shown if you have
set the User Interface Policy to Detailed.

« Plain text matching — This option is only shown if you have set the User Interface Policy to Detailed.

« Regular Expression — The ad hoc content must match the regular expression that you provide. There are many
web sites and books that provide information about using regular expressions. For example: http://www.regular-
expressions.info/javascript.html.

« Feedback Message — Enter a message to display if the ad hoc user text does not match the regular expression
you provided.

« Default Text — Enter the default text to use until an ad hoc user makes a change on the Ad hoc Data Entry page.
Your default text must be compatible with the ad hoc input mode you have selected.

« Customisation Status — Indicates if the ad hoc user has overridden the default value or not.

5.6 Creating Ad Hoc User Accounts

If you want a user on a subscriber player to update ad hoc channel content, you must create an account for
them on the subscriber with the ad hoc and any other required permissions. If you want a user on an iCC to be
responsible for
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ad hoc from center content, you must create an account for them on the iCC allocated with a role that has the
Edit Ad hoc Content and any other required permissions.

5.7 AdHoc Pages

When ad hoc users access the iCC using their browser, they only see the pages you have created for them. The
ICC does not allow ad hoc users access to any other pages in the iCC user interface. The iCC displays ad hoc
pages with the text fields you have allowed ad hoc users to change or the commands you have allowed them to
issue. You can give ad hoc users access to the ad hoc media folder, which contains all the items that they can
choose from when updating or changing content.

By default, the iCC enables ad hoc pages for all layouts when you create them. This means that when you add
customizable or ad hoc items to a layout, the iCC generates an ad hoc page for that layout containing all the
customizable and ad hoc items within it.

You can also create ad hoc pages that are not directly associated with a specific layout.

5.7.1 Managing Ad Hoc Pages

To manage ad hoc pages, you must have your user interface policy set to Detailed or Expert. To do so, follow these
steps:

1. Onthe menu bar, click Help and Ul Options.
2. Inthe User Interface Policy section, select Detailed or Expert.
3. Click the | Savethanges | ton.

To open the manage ad hoc pages screen, click Media on the menu bar and select Design Pages >
Manage Ad hoc Pages. The iCC displays the Ad hoc Pages and Add Page tabs.Ad hoc Pages:
The ICC provides the following action buttons for each ad hoc page:

@ — Delete the ad hoc page.
# | —Edit the ad hoc page to manage its items, properties, and permissions.

If the iCC does not display the page's @ button, it is in use and cannot be deleted. Also, you cannot delete layout
ad hoc pages, only disable them on the Layout Properties tab.

Add Page:

To create an ad hoc page that is not associated with a specific layout, follow these steps:

1. Inthe Add Ad hoc Page Name field, enter a unique name for the page.

2. Click the| #dd |button. The iCC displays the Ad hoc Pages tab with the new page listed.

3. Click the| # |button next to the page to configure its items, properties, and permissions.

5.7.2 Editing Ad Hoc Pages

The edit ad hoc page lists all the items you have added to the page that an ad hoc user can change.

Note: Click the Ad hoc Entry Page link at the top of the page to navigate to the Data Entry page.

97



Part 5: Ad Hoc Content

The iCC displays these tabs:
« Items — Shows the items on the page and allows you to modify them.

« Add Items — Allows you to add new items to the page (not shown for layouts automatically managing ad
hoc pages).
« Properties — Allows you to change the page name and the user message.
« Permissions — Allows you to see the roles that can change the ad hoc page and the users allocated with those

roles. If arole has only asset-based permissions, you can enable or disable the role's access here. See Asset-
Specific Permissions for more information.

Items:

To remove an ad hoc item, click its @ button.

Note: This is not available on layouts that automatically manage ad hoc pages.
On pages with multiple items, you can adjust their order using these buttons:
|I| —Move the item to the top.
|I| — Move the item up one place.
El — Move the item down one place.
E —Move the item to the bottom.

Add Item:

To add an ad hoc item to the page, click the Add Items tab and follow these steps:
1. Select the item from the Add Ad hoc Item drop-down list.

Note: You can have only one ad hoc Schedule Override item on an ad hoc page.

2. Click the| #dd | pytton.

3. Perform other actions on the Items tab. Move the item or click its . # | button to add a label to show next to it on
the Data Entry page.

Properties:

The options on the Properties tab are:

* Page Name — Unique identifier for the ad hoc page. The iCC displays it on the Data Entry page.

« User Guidance Message — Optional. Enter a message for the iCC to display on the Data Entry page to
help users when entering values.

5.8 Ad Hoc Folder Play

You can add a folder to a playlist and then give ad hoc users permission to upload their own content into that folder.
For example, you might develop a layout for an education authority with a zone dedicated to showing student artwork
that is published to subscriber player units in each school: each school uploads its local artwork to the ad hoc folder
so the content of the zone is unique to that school.
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Your ad hoc folder must contain at least one default item that is shown until ad hoc users upload content. Even if you
republish the channel, local content remains in place (unless you have removed the folder from the playlist).

To add an ad hoc folder to a playlist follow these steps:
On the menu bar, click Playlists and select the layout and zone where you want to add the folder.
Click the Files & Folders tab.

N —

Click the | Ad4 | hytton for the folder you want to add to the playlist.

Click the Playlist tab and, If necessary, adjust the item order.

Click the folder's | | button.

Check the Management box.

o o r W

7. Click the| SaveChanges |p 1o

The iCC creates a subfolderin the ad hoc_mediafolder with the same name as the folder you added in step 3. Put
any default ad hoc content into that subfolder. The player will display the content in that subfolder rather than the
content in the original folder. Your ad hoc users can add to or delete content from that subfolder as required. However,
if you or your ad hoc users leave the ad hoc subfolder empty, the player will display the content in the original folder
you added to the playlist.

5.9 Ad Hoc Media Folder

You designate ad hoc media folders to delimit the media folders that ad hoc users can access. Go to the Media >
Files & Folders page to create folders and to browse the file system.

To allow an ad hoc user to access a media folder, you must add it to the playlist and then enable it for the ad hoc user.
If suitable material is available in the folder, the player plays it in preference to any other. If no suitable media is
available, the player plays the content of the default folder for that playlist instead.

You must create an ad hoc folder for the user to upload content to. If you see the message 'No Media Folder has
been configured for this user, you need to designate a media folder for the user's account. Do so by following these
steps on the player:

1. Onthe menu bar, click Setup and select System > Users.

Click the user's | | putton.

2
3. Select the folder from the Media Folder drop-down list.
4

Click the |_S2ve Changes |, tton

5.9 Changing Ad Hoc Content

If you want to change the ad hoc content currently playing on the player, the general steps to follow are:
1. Connect to the player with your browser

2. Onthe menu bar, click Ad hoc Entry.

3. Select the ad hoc page for the content you want to change.

4

Make the necessary changes (see table below for details).
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5. Ifthe playeris playing the item, click the | ShowNow and Save Changes |, tton, Your change takes effect

immediately.

6. If the player is not playing the item, click the button. Your change takes effect when the player
next plays the item.

7. Exit your browser to leave the player.

In more detail, how you make your change depends on the ad hoc item concerned. Follow the steps for the ad hoc
item you want to change:

Text and Tables | Change the text scrolling across the screen orin a table:

TV Stations

Radio Stations

Newsfeeds

Media Folders
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1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page for the content you want to change.
3. Editthe textor table entry. Tips:
o To remove text from the screen, delete everything in the box.

o To create a line break in vertically scrolling text, press the Enter key at the location required.

4. Click the |_Show Now and Save Changes |or| Save Changes |, on.

Change the TV station showing on the screen:
1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page for the content you want to change.

3. Selectthe new TV channel from the drop-down list

4. Click the |_Show Now and Save Changes |or| Save Changes |, 4on.

Change the radio station:
1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page for the content you want to change.

3. Selectthe new radio station from the drop-down list

4. Click thel Show Mow and Save Changes |or| Save Changes |button.

Change the source for a newsfeed showing on the screen:
1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page for the content you want to change.

3. Selectthe new newsfeed from the drop-down list.

4. Click the |_Show Now and Save Changes |or| Save Changes |button.

Manage media items (typically, still images held in a folder) showing on the screen:
On the menu bar, click Ad hoc Entry.

Select Media Folder. The player shows the contents of your media folder.

. To upload a new file or manage the existing files, see Uploading Content Files.

1
2
3. To view a file, click its name.
4
5

. To change the order in which files play, see Folder Play Properties.
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Screen Layouts Change the whole layout (this assumes you have already added an ad hoc layout to the ad hoc page):
1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page relevant to the layout you want to change.

3. Selectthe new layout from the drop-down list.

4. Click the |_Show Now and Save Changes |or| Save Changes |, on.

Scheduling Change the schedule for when the player makes changes to the display (for example, to coincide with
meal or break times or for an after-hours event):

1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page relevant to the schedule you want to change.

3. Modify the schedule using the drop-down lists and check boxes.

4. Click the| Show Mow and Save Changes |or| Save Changes | ton.

If the current time is within your new schedule, the player triggers the change immediately (unless it
has already begun another schedule).

If the schedule has related audio or you require silence, reprogram the audio on or off time to match.
Advance To (on |Activate events on demand (for example, to show a video selected from a list):
demand) 1. On the menu bar, click Ad hoc Entry.
2. Selectthe ad hoc page relevant to the Advance To command you want to invoke.

3. Selectthe relevant name from the drop-down list.

4. Click the| Show Mow and Save Changes |or| Save Changes | ton.

5.10 Ad Hoc Theming

You can change how the user interface appears to your ad hoc users by using Ad hoc Theming. Ad hoc theming
lets you customise page headers and the text that appears on the page.

You might use ad hoc theming to:
« Include a company logo in a page to make it consistent with a brand identity.
« Provide atranslation of pages in a language not already supported on the player.

The ad hoc theme applies to ad hoc users on the iCC or on a player subscribing through a channel. You
cannot include ad hoc themes in layout packages.
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To access the Ad hoc theme page, click on Media and select Manage Ad hoc Theme. Create your theming
features using the following tabs:

Properties

Strings

102

Select the options you require:

« Ad Hoc Theme — Choose the Disabled button to retain the default appearance. Choose the
Enabled button to use the theme you are customizing.

o Header text color — Click the | PekCalsui | button to select a different header text color.

« Header background color — Click the | PekCalow | putton to select a different header background
color.

« Page logo — Select the Alignment option for the position you want the logo to have on the page.
Select the logo image from the files displayed. If your logo file is not there, navigate through the folders
to where itis located or click the Files & Folder link to upload it.

When complete, click the m button.

Allows you to provide either translations or alternative text for all the headers, boxes, instructions, and
warnings that appear in three ad hoc areas:

« Homepage

« Ad hoc Item Edit Pages

« Media Folder

The iCC displays the default text on the left. Enter your new text in the field on the right.

When complete, click the | Save Changes | putton.
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Part 6: Sharing Content Using Layout Packages

A Layout Package is a single file which contains all the media and control files required to fully install one
or more layouts on anotheriCC.

You can distribute layout packages on DVDs, by memory sticks, through file servers. or sent by email.
Transferring layouts from one iCC to another is a two-step process:

1. Create the layout package on the originating iCC.

2. Upload and install the layout package on the destination iCC.

6.1 Layout Packages

The Layout Packages page allows you to create, delete, and install layout packages. The Layout
Packages tab lists all the layout packages available on the iCC.

To upload a layout package from your computer onto the iCC, take these steps:

Click the | Browse_ | button.

2. Selectthe file and click the L 2*=" | bution.
3. Click the button.
The iCC displays a progress bar. After being uploaded, the file appears in the Layout Packages list.

Click the button next to a layout package to take these actions:

(0] Delete the layout package. This only removes the layout package
file (not any media or layouts you have already installed).
o Display information about the layout package content.
[ instal |  Copy the layouts and media contained in the package onto

the iCC. If any of those items already exist on the iCC, but
have different values, you are asked how you want conflicts
handled (see Layout Package Conflicts for details).

Click the Create tab to display the options for creating a new layout package:

« Name — Unique identifier for the layout package. In the name, you can only use the characters a-z and A-Z,
the numbers 0-9, or a space.

« Description — Optional. A description for the layout package.
« Include Layouts — Select the layouts you want in the layout package.

Click the Status tab to see information about layout package operations. The iCC only displays the Status tab
if you have started a layout package operation or have completed one previously.
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6.2 Creating a Layout Package

To create a layout package, follow these steps:

Finalise the layout or layouts that you will include in the layout package.
On the menu bar, click Layouts and Layout Packages.

Click the Create tab.

Enter a suitable name and optionally a description for the new layout package.

ok DN =

Check the box next to each layout to include in the package.
Note: The iCC also includes layouts referenced by Change Layout commands even if you do not select
those layouts explicitly here.

6. Click the| Create LayoutPackage |, tton. The ICC displays the Status tab.

7. When the layout package creation completes, click the Package Filename link and follow the prompts on the
pop-up screen to save the package file on your computer.

8. Send copies of the layout package ZIP file to those who need them.

6.3 Uploading and Installing a Layout Package
To upload and install a layout package on your iCC, follow these steps:

1. Onthe menu bar, click Layouts and Layout Packages.

2. Click the  Browse. | button and navigate to the layout package file on your computer.

3. Click the |m button to copy the file onto the iCC. The iCC displays a progress bar during upload.
4. After uploading, the iCC displays the layout package in the list.

5. Click the layout package's | nstal | hytton. If items in the package have the same name as items already on the
iCC, the iCC prompts you to resolve the conflict (see Layout Package Conflicts for more details).

Note: Layout packages are compressed ZIP files. The iCC does not list other types of file on the layout
package page.

You can also copy layout packages to and from the iCC by using an FTP client (for example, Internet Explorer)
on your computer. Browse to the [HOME/package folder on the iCC.

6.4 Layout Package Conflicts

When you install a layout package, the iCC merges items in the package with existing items. This includes:
« Layouts

« Special items

« Adhoc items

« Ad hoc pages

« Mediafiles
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The iCC flags a conflict when an item in the package is identical to an existing item, but has different property
values. You are prompted to resolve the conflict with one of these options:

« Do Not Copy — The iCC will not change the existing items. This is equivalent to not copying any conflicting
items or files from the layout package. The iCC installs all non-conflicting items.

« Copy and Replace — The iCC will replace existing items with items from the layout package. This is equivalent
to the iCC overwriting the local items.

« Copy but Keep Both Items — The iCC renames the items in the layout package to avoid conflicts with existing
items. The iCC displays the new names on the Status tab.

The iCC may offer different conflict actions for media files and layout and special items.

In some cases, selecting Copy but Keep Both Items may cause additional items to be in conflict. For example, if
an ad hoc text item is in conflict and is contained in a layout that exists locally, but is identical, and you choose the
Copy but Keep Both Items option, the iCC renames the ad hoc text item. This causes the layout in the layout
package to be modified to reference the newly renamed ad hoc text item. This in turn causes a layout conflict,
since the local layout and the modified layout are now different. The iCC shows additional, secondary conflicts on
a separate line in the Conflict Details section.

Click the | Install LayoutPackage |, tton to proceed with the Installation or the |_“2ncelinstall | b ytton to stop the
installation process.

6.5 Layout Package Information

To see information about a layout package, follow these steps:

1. Onthe menu bar, click Layouts and Layout Packages.

2. Click the layout package's! @ | button.

The iCC displays this information:

« The originating iCC.

« Layouts included in the package.

« Special Items included in the package.

« Other additional settings (such as color items and special fonts).

« Mediaitem files in the package.

This information may help you resolve any conflicts between items in the package and those already on your iCC.
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Part7: Channels and Signage Networks

Channels provide an easy way to display the same content at multiple locations by setting up a digital signage
network of players. A collection of players that all play the same content on their screens is known as a channel.
A channel has these basic parts:
TheiCC.

. The content that the iCC publishes.

. One ormore subscriber players.

When you publish to a channel, it includes all the related schedules, layouts, and media content. You should consider
these factors when calculating the storage space required for a channel:

« With the exception of video files, content does not require large amounts of storage. If your layouts do not include
video files, you should find 1 GB to 2 GB of space sufficient.

« If yourlayouts include video files, increase storage by at least 2 GB per hour of standard quality video. Allow for
more if the video is high quality.

However, the channel does not include user records, including ad hoc users. If your content relies on that, you will
need to ensure it is already present on each of the subscribers.
Also consider the capabilities of the subscriber units in your network:

« Are they powerful enough to show the content? Some content may not show optimally on less powerful player
models (for example, high-resolution movies or Adobe Flash items that require a fast CPU).

« What resolution are their attached screens? Ideally, to display the same content you should have screens set to
the same resolution. If some screens display at lower resolution, take into account that content will be cropped.

« Do they have any additional hardware or licenses required? Subscribers can only display certain content if they
are configured to do so (for example, TV channels)?

To set up and begin using a channel, follow these general steps:

. Create the content on the iCC.
2. When your content is ready, click the Manage Channels Page link that appears at the top of each screen
on youriCC. The iCC displays the Manage Channels page. Specify your channel configuration here (see
Configuring the Channel for more details).

3. Click the appropriate publish button on the Manage Channels page. The iCC will not distribute changes to
a channel until you publish them. See Publishing a Channel for details of the publishing options.

Repeat those steps for each additional channel you want to create (see Multichannel Publishing for more details).

You will now need to configure each player in your network in the Subscriber role, pointing them to the correct
location to find the channel content to display.

Important. The iCC user account you specify in the subscriber configuration must have the Subscribe
Channel permission.

After a period, the subscriber players will poll for channel content, download it, and begin displaying it on the screens
they control.
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Some other features may be of interest to you:

« Control the timing and circumstances of publication. You can configure the ICC to publish a channel regularly
or only when you initiate publication manually. You can also specify that changed content is only published
after an approval process. See Publishing Mode and Policy for more details.

« Add ad hoc content to your channel. This provides content that varies on a per player basis. For example, if you
have players on different sites, you may wish to allow local users to display messages specific to their location.
You will need to provide the users on the subscriber players with the appropriate ad hoc permissions. See Ad
Hoc Content for more details.

« Distribute channel content using a separate Channel Content Server (CCS). You might consider adding one or
more CCSs to your digital signage network depending on the configuration scenarios you need to support. See
Channel Content Servers for more details.

Note: It is recommended that the iCC and each subscriber player run the same software version. Earlier
version subscribers may not be able to display content created on the iCC.

7.1 Publishing

The iCC provides a wide range of features for you to configure and publish multiple channels to exactly meet
the needs of your digital signage network.

Refer to the topic that describes the task you wish to perform :

Configuring the Channel

Publishing a Channel

Multichannel Publishing

Managing Channels

7.1.1  Publishing Mode and Policy

Before you begin to configure a channel, you need to decide on the Publish Mode and the Publish Policy you will
adopt:

Publish Mode — Defines the method of publication.

Publish Policy — Controls how the iCC allows publication of changes.

The publish mode and the publish policy interact so you should carefully consider the publication regime
you require. The iCC prompts you to select the publish options when you add a channel. You can change
your selection later by editing the channel configuration (see Configuring the Channel for details).

The iCC offers two Publish Mode options:

« Manual — The iCC only publishes the channel when you click a button on the Manage Channels page. You
can only set a publish policy if you choose this option.

« Automatic — The iCC publishes the channel at the time of day or at the frequency you configure. Because it
is automatic, you cannot set a publish policy if you choose this option.

The iCC offers two Publish Policy options:

. Allow at any time — The iCC allows any user to publish changes at any time.

. Allow only after change complete notification — The iCC only allows publication after you complete
an approval notification.
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Choosing the second option enables you to include a review and approval process in your content development and

publication workflow. You have to approve changes to the channel by clicking its M button on the Manage
Channels page and completing the Notify Content screen, which looks like this:

MNotify Content TR

Channel Name: Reta

8 Cancel

The Notify Content screen has these features:

Channel Name — Confirms the name of the channel whose changes you are approving.

Change Note — You must enter a note to approve the changes (the © Nt | hytton is not activated until you do).
If necessary, this field automatically expands to accommodate the length of note as you write. You can also

expand it by dragging the expansion icon at the bottom right.

Click the | ® "5 | button to confirm your approval. The iCC will now allow publication of the changes.

7.

1.2 Configuring the Channel

To configure a channel for publication, from the menu bar click Channels and Manage Channels.

When you first access the Manage Channels page, the display looks similar to this:

Actions Channel Details State Current Schedule WValid Until Schedule Entries

Corporate S& Ijj.
Laist Pulbdish Mawar 5 F

Next Publish ',JJ Har

=

Eefault Channg

= & W Publish To

Manags Manage

Refer to Managing Channels for a description and explanation of all the Manage Channels features.

Now, to configure the channel for publication, click the # | button. TheiCC displays the Edit Channel page,
which has these tabs:

Publish Settings — Used to configure the channel name, description, and publishing options.

Channel Limits — Used to limit the number of layout zones and the maximum size of the channel and of individual
media files.

Permissions — Used to manage the roles that can access the playlist and the users allocated with those roles
(See Asset-Specific Permissions for more information).
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To get started, go through the items on the Publish Settings tab and configure the options you require. It is not
necessary to configure Channel Limits or Permissions but if you need to, click the tab to configure those options

too. Click the | ® =*** | button when you have completed all of your configuration.

Configure the Publish Settings options you require as follows:

Channel Name

Description

Publish Mode

Publish Policy

Publish

Preview URI

Custom
Preview
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Enter a unique name for the channel. This appears at the top of the page on the subscriber and in the
iCC Channels Details column.

Optional. A meaningful description to further identify the channel and its content.

Select the mode of publication you want:

« Manual - You publish by clicking a button on the Manage Channels page. Selecting this mode
enables the Publish Policy options.

« Automatic — The iCC publishes at the time you specify. Selecting this mode enables the Publish
options.

Only enabled if you set Publish Mode to Manual.

Select the publication policy you want:

« Allow at any time — Allows the channel to be published at any time (whether it has changed or not).

- Allow only after change complete notification — Prevents a change to the channel being published
until the user completes a notification. Use this as a change control mechanism.

Only enabled if you set Publish Mode to Automatic.

Select the time you want the ICC to publish the channel:

« at-— Publish each day at the time you choose (00:00 is midnight).

« every — Publish regularly at the interval you choose (in hours and minutes).

Important: Before choosing the timing, take into account when the iCC is publishing other channels in
your configuration. Consider staggering the timings to balance the load on the iCC and on your network.

Select where you want to preview the channel:
« Default — Preview on the default URI (thatis, /channel/preview).

« Custom — Preview on a URI of your choice (for example, /channel/design).

Only enabled if you set Preview URI to Custom.
Specify the URI you want to use:
« Create and set new URI - Enter a new URI.

« URI- Select an existing URI (only enabled if you previously created a URI).
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Channel Server Select how you want to publish the channel:

« The ICC /channel/1 folder — The iCC publishes the channel to one of its own channel folders. The ICC
displays the folder details on the Manage Channels page. Subscribers access the content through
FTP, HTTP, or HTTPS. Selecting this option enables the Channel URI option.

« The USB Flash Memory's / channel folder — The iCC publishes the channel to the channel folder on
an attached USB stick.

« FTP Site — The ICC uploads the channel to an FTP site. Selecting this option enables the other FTP
configuration items you must also complete (Publishing Root URL, Authentication, and Error Retry
Interval).
Channel URI Only enabled if you set Channel Server to The iCC /channel/1 folder.

If you want to publish to a location other than the /channel/1 folder, enter its URI here.

Publishing Root This and the next two options are only enabled if you set Channel Server to FTP Site.
URL Enter the URL required.

Avalid FTP URL begins with ftp:// followed by the host name or address and the full path to the
publication location. Examples of valid FTP URLs are:

e ftp://example.com/mychannel/
e ftp://192.168.0.23/channel/
e ftp://somehost/a/b/c/

Note these points:

« Ifthe folders do not exist on the FTP server, the iCC attempts to create them. This will fail if you do not
provide a login name and password with appropriate write access.

« To test the setup, the iCC attempts to log into the FTP server you have defined. It notifies you if this is
successful or not.
Authentication | Selectthe login method required:
« Login using anonymous FTP access — The FTP site does not require specific login credentials.
« Login with — The FTP site requires login credentials. Enter the username and password in the boxes

provided.

Error Retry If the iCC fails to connect to the FTP site, specify the period before it tries again.
Interval

Configure any Channel Limits options you require as follows:

Layout Zone Specify the number of zones allowed in published layouts:
Limit « Unlimited number of zones — Default. Do not limit the number of zones.
« Limit to — Do not allow more zones than the value you specify. For example, if publishing to less
powerful models, choose a value to ensure you will not overload them.

Channel Size Specify the size limit for the channel:
Limit « Unlimited size — Default. Do not limit the size of the channel.

« Limit to (MiB) — Do not allow the channel size to exceed the value you specify. For example, if you
set a limit of 100 then all of the combined elements in that channel cannot exceed a total of 100 MiB.
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Individual Media Specify the size limit for each individual media file:

File Size Limit | |, imited size — Default. Do not limit the size of each individual media file.

« Limit to (MiB) — Do not allow each media file size to exceed the value you specify. For example, if
you set a limit of 50 then each media file uploaded cannot exceed the limit of 50 MiB.

7.1.3 Publishing a Channel

After configuring the channel for publication, you are ready to publish and activate it. You can add and publish
additional channels later.

Note: If you are publishing to a USB stick, insert that into the ICC before beginning. Ensure it has the capacity to
hold the channel content.

Before continuing, it is important to understand the distinction between publish and activate:
« Publish —When the iCC copies the channel content to the publication location you specified.
« Activate — When the subscribers start displaying the channel.

You can specify that activation takes place later than publication. In other words, the iCC will publish the channel
but subscribers will not display it until after the date and time you specify. This is useful to ensure all subscribers
start showing the channel content at the same time (rather than as soon as they can download it). For example, you
can use this to allow for the difference in time it takes several subscribers to download large media files over a slow
network.

To publish and activate the channel, follow these steps:

1. Onthe menu bar, click Channels.
2. Click Manage Channels.

3. Inthe channel's Actions column, click the button for the publishing option you require:
o | ® |_publish and activate as soon as possible.
o L% |_publish and activate later. The iCC prompts you for the date and time after which to activate.

The iCC begins the copying process and displays progress in the channel's State column. If there is a problem, the
iCC displays an error message. After copying is complete, how the subscriber receives the new content depends
on where you chose to publish the channel:

« iCC channel folder or external server— The subscribers will download the new content the next time
they check the channel.

« USB stick— Remove the USB stick and use it to load the channel content onto each subscriber.

Repeat the same process even if you have only changed the schedule. In all cases, the ICC displays the following
banner if you have changed the channel contents but have not yet published it:

Channels have changed. Please go to the Manage Channels page to see more detals on required achons.

If you are not on the Manage Channels page, clicking the Manage Channels Page link takes you there. To publish
the new content, follow the same steps as described above.

The Manage Channels page provides you with all of the features you need to add, edit, and delete channels. It also
displays status information on each channel. You can also access detailed information on each channel by following
these steps:
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On the menu bar, click Channels.
Select Detailed Status. The iCC displays the list of channel names.

Click the name of the channel whose status you want to check.

The Detailed Status page contains this information:

Publisher State — The current publication state of the channel.
Channel — Channel identifier and activation details.

Required Version — If relevant, indicates the minimum software version the players must be running to display
the channel.

Size — The size of the channel content sent so far, its total size, and the status of delivery progress.

7.1.4 Multichannel Publishing

iCC allows you to create and publish up to 50 channels simultaneously.

Note: Although schedules are unique to each channel, more than one channel can share layouts and contents.

To add a new channel, follow these steps:

1

2
3.
4
5

If required, create the layout and content for the new channel.

On the menu bar, click Channels and Manage Channels.

Click the | Add Channel | p iton,

Complete the Settings and Schedule information the iCC prompts you for.

. When you are ready to publish the channel, follow the same steps as described in Publishing a

Channel.

To delete a channel, follow these steps:

On the menu bar, click Channels and Manage Channels.

If the channel you want to delete is the only one, configure another channel. You cannot delete the last channel
on theiCC.

Click the @ button next to the channel you want to delete. This only deletes the channel schedule: the channel
content is still on the iCC.

For more information about the tasks you can perform through the Manage Channels page, see Managing Channels.
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7.1.5 Managing Channels

You manage the channels on youriCC through the Manage Channels page.
To understand the tasks you can perform using the Manage Channels page, this illustration shows its essential

features, which are described below:

Add Channel | Pubdish Listed Channels  ®ilter & all Freviewsd Publishing Attention Regquired

Actions Channel Details State Current Schedule Valid Until Schedule Entries

eilils S desd ayout Bt #’
Ratad Last Pubdish b

[}
F Puhlish Ta: Mchanr i t Habs — e
L e { Compatible Version: v R ﬁj 201 .. . Tj
Manage M anage -
The header options are:
Add Channal Click to configure a new channel on your iCC. The Add Channels wizard prompts you for the

basic channel settings and schedule configuration. That is sufficient to create and publish a
channel on the iCC using the default settings. To modify how and where the channel is

published, click its | # | button to access the detailed configuration options (see Configuring
the Channel for details).

Publish Listed Channels | Click to publish all the channels listed in the display.

Channels will not be published if:

« They are notlisted in the display (that s, the current filter excludes them).

« Their Publish Policy requires a notification and one has not been completed after a change.
Filter Limit which channels are or are not displayed in the table. Enter a string in the Filter field

and the iCC limits the display to the channels whose name matches that string.

You can also select a filtering option (either alone or in combination with the Filter string):

« All - Default. Displays all channels.

« Previewed - Displays only the channels that the iCC has published to the preview location. «

Publishing — Displays only the channels that the iCC is currently publishing.

« Attention Required — Displays only the channels that require your attention (for example,
those that have yet to be published after you have changed them).
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The table lists each channel under these headers:

Actions

Channel Details

Click the button to perform the action indicated:

@ — Delete the channel.

# | Editthe channel configuration.

lil— Notify a change. Only shown if the channel Publish Policy requires a change

notification. After you notify the change, the iCC displays the |£| button. Click that to

undo your notification or click the € or % | putton to publish the changed channel .
B |_ publish the channel to the preview location, /channel/preview. Configure a player to
subscribe to that location to preview the content before you publish it on a live channel. The

ICC displays the preview location in the Channel Details column and the preview icon in the
State column.

€ | _ publish the channel and activate as soon as possible.

&' |— Publish the channel and activate later. The iCC prompts you for the date and time
after which to activate.

Contains this information:

Channel Name — Click the link to open the channel's detailed status page.
Description — If provided, the additional channel description.
Publish To — Indicates the publication location.

Compatible Version — If relevant, indicates the minimum software version the players must
be running to display this channel.
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State Contains this information:

« Last Publish — Date and time the iCC last automatically published the channel or when
you did so manually.

« Activate After — If you set the channel to activate later, the iCC also displays this entry to
show the date and time you specified.

« Next Publish — Indicates the type and date and time of the next publication:
o]
o @ — Automatic publication on the date and time indicated.

o I% — Manual publication on a date and time you choose.
The ICC also displays dynamic status information, examples include:
« During publication — Displays progress with a cumulative percentage, file, and byte count.

« After you change the channel — Displays this prompt:

o
« After you change the channel and a notification is required — Displays this prompt:

|
L+

- After a required change notification is completed — Displays this prompt (hover your cursor
on the *¥ ijcon to see the notification and which user provided it):

] o

wr gl

Current Schedule Displays the name of the channel's schedule. Click the Manage link to open the Manage
Schedules page.

Valid Until Displays the schedule's Valid Until setting.
If the iCC is not showing all the schedule entries, it displays the 'Epn. Click that icon to
reveal the additional schedule entries.

Schedule Entries Contains this information:
« Name of the layout shown for each schedule entry. Click the link to open the layout editor.
« The layout's canvas size.
« Anicon showing the zones in each layout (click a zone to open its playlist):

] —

| |

« Ifthe iCC is not showing all the schedule entries, it displays the B icon.
Click that icon to reveal the additional schedule entries.

Click the Manage link if you want to edit the schedule settings.

7.2 Channel Ad Hoc

Using ad hoc content within a channel enables you to allow users to show their own content on their local player while
still showing the rest of the channel.
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Create ad hoc content in the same way as you would a normal part of a layout. Local ad hoc users can then log into
their subscriber player and change that content.

Ad hoc from center is similar to regular ad hoc in that it allows a user to log in to change an element of the signage
display quickly and easily. However, instead of the user making ad hoc changes on the subscriber player, with ad
hoc from center the user can make changes on the iCC. Consequently, the subscribers to that iCC upload the ad
hoc from center changes to the channel. When configuring those subscribers, you might want to set their polling
interval to a shorter period so that ad hoc from center updates arrive more quickly.

7.3 Channel Content Servers

The iCC itself is a channel content server. However, in certain situations, a better solution might be to use an
external file server.

An alternative is to use an external Channel Content Server (CCS) to offload channel distribution processing
from youriCC. Each subscriber player polls the CCS for the latest channel content in the same way it would poll
the iCC directly.

How you publish your channels depends on the number of subscriber players and the network they are connected to:

How to Publish Description When Would You Use This Method?

On the ICC You store channel files on the iCC and subscribers You have up to 500 subscribers in a
download them using HTTP, HTTPS network with no special network
(recommended), or FTP. topology requirements.

The iCC bandwidth limiting feature is
there to help as the numbers approach
that limit (see Firewall for more details).

This method requires no extra
hardware.

Using a USB memory stick | You publish channel files onto USB memory sticks. | Your subscribers are not connected to
You distribute the sticks to each subscriber, which a network or you do not want to
automatically reads the channel from it. publish the channel through a

You have to perform this process every time you network.

update the channel.
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How to Publish Description

Using an external CCS You use the iCC to publish content to an external

CCS using FTP. The CCS makes the files available
to the subscribers, either through HTTP, HTTPS
(recommended), or FTP.

When Would You Use This Method?

One or more of these factors is true:

Access to the subscriber domain is
limited for security reasons.

Groups of content need to be
physically separated from each
other.

Content needs to be locally cached
to reduce network congestion or to

prevent consumption of expensive

bandwidth.

This method:

Allows you to create the network
structure you need.

Easily ties this into your existing
server hardware or web host.

When planning how to publish, you should bear in mind these network and bandwidth considerations:

Using a CCS requires both the iCC and the subscriber to be able to connect to it through a local network or the

internet.

Using network-based publication will not work if there is a problem with connectivity or if the credentials

provided by the subscriber for either the iCC or the CCS are incorrect.

Bandwidth use depends on the layouts and media being published as well as the number of subscribers. Large
media files take time to transfer and this increases the time before the subscribers begin playing the channel.
However, after the subscriber downloads the media, it will only need to download new or updated items later.

Subscribers periodically poll the publishing source for channel updates. If you do not update your channel
frequently, then save bandwidth by decreasing the rate at which the subscribers check for new content. You
need to balance this with it taking longer for the subscribers to display new content when you do change it.
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Part8: System Status

Use the Status options to access information about the system.

Select the menu item for the status information you want to access:
» System —Viewing the disk and CPU temperatures over time, general system status, and hardware specification.

« Conditional Play — Checking the items that are subject to conditional play.

8.1 System Status

The System status page provides details of the environmental performance of youriCC.

Select the tab for the option you require:

e °C 24 Hours - Viewing disk and CPU temperatures from the last 24 hours (not displayed if you are using
the Virtual iCC appliance).

. °C 30 Days - Viewing disk and CPU temperatures from the last 30 days (not displayed if you are using the
Virtual iCC appliance).

« Status — Viewing uptime, temperature, Ethernet, and memory metrics.

. Hardware — Viewing iCC processor specification and memory capacity.

CPU Load - Viewing a graph of the processor loading.

°C 24 Hours:

Illustrates disk and CPU temperatures from the previous 24 hours on separate graphs. Green lines indicate the safe
temperature range and red where the temperature is too high.

Beneath each graph, notes indicate the maximum temperature during the period and the shut down temperature.
The iCC shuts itself down if the disk temperature exceeds 50 °C for more than 5 minutes.

°C 30 Days:

As above except covering the previous 30 days.

Status:

The display contains the following information (some systems do not report all items):

ICC Uptime How long the iCC has been running since its last restart.

Disk Temperature Current disk temperature

CPU Temperature Current CPU temperature.

CPU Fan Speed Speed of CPU cooling fan (in RPM).

Case Fan Speed Speed of system cooling fan (in RPM).

Ethernet Receive Total inbound network traffic (in bytes and packets) and number of errors.
Ethernet Transmit Total outbound network traffic (in bytes and packets) and number of errors.
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System Disk How much system disk space used of how much available.
Data Disk How much data disk space used of how much available
Hardware:

The display contains the following information:

CPU Make, model, and speed of iCC processor.
Available Memory Amount of iCC main memory.

CMOS Signature Support may request this value.

TV Card The model of TV card installed or if none is fitted.
TV Card Features TV card features (if installed).

CPU Load:

The display contains the following information:
« The average percentage CPU load over the previous 10 seconds.

« A rolling graph of processor load sampled every second.

Values of 90% and above indicate processor overload (for example, video may not play smoothly as a result). To
avoid CPU overload, you can change the media type or change the order of items in the zones.

8.2 Conditional Play Status
The Conditional Play status page summarizes the playlists or schedules with the Conditional Play property set.

The page displays details of the items that you have configured to play conditionally along with the result. If you
have not added the required player local information for those conditions, the iCC displays an action message
containing a link you can follow to add the missing name.

The rest of the page is split into two tabs, one each for Playlist Items and Schedule. Each tab displays:

« Details of the PLI name on which the item depends.
« The operation that the player executes to decide if the item plays.

« The values that the item contains and the current values in the PLI.

The iCC displays links to the required items: click the link to go to the page you need to access.
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Part9: Setup

Use the Setup options to configure and check the operational features of youriCC.

Select the menu item for the option you require:
« System Setup — Configuring the administrative and infrastructure aspects of the iCC system.

« Player Setup — Configuring the RS-232 and interactivity characteristics you want the player to
support.

« Maintenance & Troubleshooting — Performing backup, update, and support activities.

9.1 Help and User Interface Options

Use the Help menu to access the iCC user interface options, page-specific help, and the user guide.

Use the Help > Ul Options page to set the iCC user interface options. Those options are on these tabs:

« My Options — Changing user interface behavior (these changes only apply to the user interface you see).

« Shared Options — Adding a title on every page of the user interface (this change applies to the user interface

for all users).

When you have completed making your changes, click the |_S3¥& Ehanges |y, tton to enable them.
To change the general options, select from the following:
User Interface Policy | Select the display mode you want:

« Productive — Displays only the most commonly used features.

« Detailed — Displays both commonly used and advanced features.

« Expert — Displays commonly used, advanced, and expert features. Take care if you use this

mode.

To change the Time & Date Display options, select from the following:

Time Style Select the time format you prefer. Locale Specific means the format matches the language option

you have set on your browser.

Time Separator A character to separate the time-display values. A colon is the default. Enter another character to

use as an alternative. The iCC ignores this setting if you have selected the Locale Specific option

from the Time Style menu.

Date Style Select the date format you prefer. Locale Specific means the format matches the language option

you have set on your browser.

Uncheck the Show last 5 days as day name instead of date box if you want the ICC to display

recent days by numeric date rather than by name (for example, 'Monday').

Date Separator A character to separate the date-display values. A hyphen is the default. Enter another character
to use as an alternative. The iCC ignores this setting if you have selected the Locale Specific

option from the Date Style menu.

Month Style Select how you prefer to see the month expressed.
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To change the Advanced options, select from the following:

Layout Editing Select how you want to edit layouts:
« Graphical Layout Editing — Direct editing including use of drag-and-drop.

« Non-Graphical Layout Editing — Indirect editing by entering values. May be needed if your
browser does not support direct editing.

Playlist Add Item Select where you want the iCC to add new items to a playlist:
« At Top - ltems are added to the top of a playlist.
« At Bottom — Items are added to the bottom of a playlist.

After the items are added, you can move them into whichever position you wish.

Drop Down Menu Select the menu behaviour you want:

Display Mode . .
play « Menu is shown when hovered over — Menu expands when you hover your cursor over it.

« Menu will show when clicked — Menu expands when you click it.

9.2 Users, Roles, and Permissions

Use the Users and Roles options to set up user accounts and allocate permissions to them using roles.

To understand the relationship between users, roles, and permissions, read the information below. Otherwise, click
the tab for the options you require:

» Users — Setting up a user account and allocating it with roles (see Users for how to do so).

« Roles —Managing roles and their permissions (see Roles for how to do so).

The iCC provides features for you to precisely define a user's access to and control of:
. Playlists

. Layouts

. Schedules

. Channels

. Folders

The iCC system

So that you can closely manage what can or cannot be done by your users, the iCC offers two groups of
permissions that vary in scope:

« Global permissions — System-wide permissions (for example, to manage all channels).
« Asset-based permissions — Permissions applicable only to assets (for example, to just edit layouts).

In the case of asset-based permissions, you can enable or disable access down to the level of a specific asset or
even further (for example, only one aspect of a playlist item, such as its play criteria). For each relevant asset,
the iCC displays a Permissions tab for you to manage that access (see Asset-Specific Permissions for more

information).

The combination of global and asset-based permissions allow you to manage the iCC and your signage assets to
a fine degree of detail.
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However, enabling a user's permissions one-by-one is time consuming and is not supportive of consistency.
The iCC Roles feature reduces the time and increases the consistency.

What are Roles? When you set up users, you need to grant them the various permissions that match their
function and responsibilities. Users with similar responsibilities will need similar sets of permissions. For
convenience, the iCC allows you to group those permissions into Roles for ease of allocation. For example, the
iCC comes with a sample role called Designer that is configured with the permissions necessary to edit layouts
and publish channels.

In fact, the iCC comes with a number of pre-configured roles already in place. Use them as they are, edit them
to match your exact requirements, or create new roles of your own. Then, granting a new user the permissions
they need is simply a matter of allocating the appropriate roles to them. It is easy to edit those allocations later to
implement any changes.

9.2.1 Asset-Specific Permissions

Click the Permissions tab to see the roles allowed to access the current asset. If a role has only asset-based
permissions, you can enable or disable its access here.

The Asset line describes the current asset.

The Allowed Roles box lists the names of the roles and their status:

« Arole with arelevant global permission is already enabled. The iCC indicates this with a checked and greyed-out
box to the left of the role name.
« Arole with only an asset-based permission can be enabled or disabled for this asset. To enable it, check the
box to the left of the role name. To disable it, clear the box. If you enable or disable a role, click the

[ Save Changes | or | Save allchanges | button-(the latter means .the_iCC will also save changes you
made in other parts of this view).

Click the |E2 | button at the right of the role-name bar to reveal more information:

« Left-hand column — Names of the users allocated with this role (to edit a user, click its name to open the Users
tab).

« Right-hand column — The permissions you have granted the role (to edit a role, click its name to open the Roles
tab.)

To hide the user and permission information again, click the =/ button. You can reveal that information for all roles
by clicking the EX220d_all 1 4t0n and hide it by clicking the Collapse all button.

If no role has any of the other permissions relevant to this asset, the iCC lists those permissions in the blue
information bar near the bottom of the page. If you want to grant a permission to a role, click the Manage Roles link
at the bottom of the page to open the Roles tab.

9.3 System Setup
Use the Setup > System options to configure and check the operational features of youriCC.
Select the menu item for the option you require:

« Users — Adding and managing user accounts.
« Roles — Managing roles and permissions.

« Date & Time — Specifying time source and time zone.
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Network — Setting up and testing the network connection.
TV & Radio — Setting up TV and radio stations.

HTTP Proxy — Setting up proxy server access.

Security — Configuring firewall and secure access services.

Player Local Information — Adding customized data items to the player.

Reporting — Configuring the iCC to report to the network iCOMPEL Deployment Manager (IDM).

Licensing — Managing your software licenses.

9.3.1 Users

Use the Users options to manage the iCC users.

The iCC displays a list of the users on the system (some are provided by default). You can take any of the following
actions:

« Add auser.

« Review auser's roles.

« Edit auser.

« Delete a user.

Add a User:

To add a user, click the @ button. Complete the following details:

Username The name the user logs in with (for example, 'remote’, or 'chef’). This must be unique on this ICC.
Follow the on-screen guidance on how to compose the username.

Password The user's password. Repeat in the Password Confirm field.

Note: You cannot retrieve passwords. If users forget their password, you have to give them a new one.
It is strongly recommended you change the factory-supplied password for the remote user.

Password Check the box to permit the user to change his or her own password.
Policy
Then, complete these steps:
1. Click the » meat button. TheiCC displays a list of available roles. If you want to see the permissions a role has,
click its =) button (orthe Expand all button to see the permissions for all roles).
o Check the boxes next to the roles you want to allocate to the user.
Note: If you allocate a role that has an FTP permission, the iCC displays the FTP tab. Click » mext

and select the FTP home folder from the drop-down list.

3. Click the @ saw=  button.
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Review a User's Roles:

Toreview the roles allocated to a user, click the user's name. The iCC displays the roles on the right of the screen.
If any of those roles has an FTP permission, the display also shows the user's FTP home folder. To see the
permissions arole has, click its =] button (orthe Expand all button to see the permissions for all roles).

Edit a User:

To edit a user, hover your cursor over the user's name and click the # | button:

« TheiCC displays a set of tabs, with the Roles tab showing first. If you want to see the permissions arole has,

click its =2 button (or the EXpand all putton to see the permissions for all roles). Check or uncheck the boxes
to edit the allocation of roles to the user.

¢ Click the Details tab to change the user's password.
. TheiCC may also display the FTP tab if the user has an FTP-related role. Click it to change the user's FTP home
folder.

When you have finished, click the | @ s=v= | button.

Delete a User:

To delete a user, hover your cursor over the user's name. The iCC displays the@ button. Click that button to
delete the user. You cannot delete the user you are signed in as.

9.3.2 Roles

Use the Roles options to manage the ICC users.

The iCC displays a list of the configured roles (some are provided by default). You can take any of the
following actions:

« Addarole.

« Review arole's permissions and users.

« Editarole.

« Deletearole.

Add a Role:

To add a role, click the il button. Complete the following details and click the © === | button:

Role Name A name with which to reference the role (for example, 'FolderController'). This must be unique on

this iCC.
Global Check the boxes next to any system-wide permissions you wish to grant the role. You do not have to
Permissions grant a role any global permissions.

See the permission descriptions below for details on each permission.
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Asset Based Check the boxes next to any asset-based permissions you wish to grant the role. Roles with global
permissions permissions can already access the relevant assets. For ease of reference, the ICC displays these
permissions grouped according to asset type.

Note: Granting an asset-based permissions to a role does not enable access to those assets by default
(except for the channel permissions). You have to manually enable a role's access on each asset.

See the permission descriptions below for details on each permission.

Review a Role's Permissions and Users:
Toreview arole's permissions and the users allocated with the role, click the role's name. The ICC displays the
permissions and the users on the right of the screen.

Edit a Role:

To edit a role, hover your cursor over the role's name. The iCC displays the [ # |button. Click that button to
open the permissions configuration screen. Check or uncheck the boxes to edit the role's permissions.
You cannot edit the role's name.

When you have finished, click the | ® 5=v= | putton.

Delete a Role:

To delete a role, hover your cursor over the role's name. The iCC displays the[ @ |button.
Click that button to delete the role.

Permission Descriptions:

The following tables describe what each permission allows.

Global permissions:

Manage System Settings | Full control over items on the Status and Setup menu pages. Access to the Media page for
newsfeeds, fonts, and files & folders.

Monitor Status View only access to the System status and Manage Channels pages.

Manage Layout Full control over items on the Media, Playlists, Layouts, and Schedules menu pages.

Able to change a role's asset-based permissions for layouts, ad hoc, schedules, and
playlists.

View only access to the Status and Manage Channels menu pages (except for the links to
the current schedule and schedule entries).

XML Control Access to the XML message interface allowing non-browser based control of the iCC.
Read/Write FTP Read, write, and delete files in the Media folder and all its subfolders using FTP.
Read Only FTP Read only access to the files in the Media folder and all its subfolders using FTP.
Manage Channel Full control over the Channels menu page.

Able to change a role's asset-based permissions for channels.

Subscribe Channel Able to enable a published channel to be read by subscribers.
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Asset-based permissions:

Publish Channel

Notify Channel

Edit Schedules

Edit Layout

Manage Playlist

Edit Playlist tem Media
Edit Playlist Item Style

Edit Playlist ltem Play
Criteria

Edit Ad hoc Content

Manage Folder Content

9.3.3 Date & Time

Content Commander User Guide

Permits the role to publish a channel.

Permits the role to set notification that a channel is ready to publish.
A role with the Manage Channel permission can configure a channel so thatit can only be
published after a notification is set.

Change schedule settings.

Access to the Media page (tables and colors only).

Access to the Layouts and Playlists pages of the layouts you have permitted the role to
edit. Grant edit permission on the layout Permissions tab.

Permits the role to add content to a playlist using drag-and-drop only. Add the Manage
Folder Content permission to enable the role to use the Files & Folders and Upload Files
options.

Full control over playlists.

Permits the role to add content to a playlist using drag-and-drop only. Add the Manage
Folder Content permission to enable the role to use the Files & Folders and Upload Files
options.

Edit playlist items.
Edit playlist item styles.

Edit playlist conditional play and time validity settings.

Add or delete content on the Ad hoc Entry page (not the ad hoc content design pages).

Add or delete folder content. The role is only permitted to do so in folders with this
permission enabled for it.

Permits the role to add content to a playlist using drag-and-drop only. Add the Manage
Folder Content permission to enable the role to use the Files & Folders and Upload Files
options.

Use the Date & Time options to configure the time source and time zone for youriCC.

Click the tab for the option you require:

« Settings — Configuring the time source and time zone.

« Status — Checking current Network Time Protocol (NTP) characteristics.
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Settings:

To configure the time settings, complete the following details then click the| Sawve Changes | button and reboot
the iCC:

Date and Time Settings Choose the time method to use:

« Network Time Protocol (NTP) — Best for accuracy but requires the iCC to have a
network connection to an external NTP server.

« Windows Compatible Network Time Protocol — Use if the NTP server is a local
Windows server.

« Local System Clock — The iCC internal clock. Only use if the iCC cannot access an
NTP server. Without an external reference, the local system clock may drift.

Time Zone Setting Select the time zone for the iCC to use.

Local System Clock Settings |If you chose the Local System Clock method, the ICC activates this display. The values

shown are those current when you opened the Date & Time page. Adjust the date and
time to those required.

Network Time Protocol (NTP) | If you chose one of the NTP methods, you must enter the URL of at least one NTP server
Settings (three are recommended).

Note: The iCC will only synchronize to NTP server time if the NTP time and the local system time are within a
few minutes of each other. If the difference is greater, reboot the iCC to synchronize times again.

Status:

Not displayed if you have chosen Local System Clock. Shows the latest characteristics of each of the NTP servers
you have designated. This example shows the characteristics of the active time source:

Server IP address Offset Jitter Status Last event

Matwork Time Server (NTP) 1 178.254.20.157 -1.647ms 3.449ms Achiva Dme source

SYE_pear

9.3.4 Network

Use the Network options to configure, check, and test the iCC network connection.

Note: The iCC displays its active IP address in large text on the splash screen during the boot up process.
Click the tab for the options you require:

« Ethernet — Configuring IP address and DNS settings.
« Network Status — Checking current IP address and DNS values.

« Tests —Running ping, trace, DNS lookup, and TCP dump tests.
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Ethernet:

To configure IP addressing, complete the following details then click the | 58¥& Ehanges |, tton and reboot the iCC:

Ethernet Settings | Select how the iCC obtains its IP address:

« DHCP - Select if the iCC will obtain its IP address from a DHCP server on your network. If the
ICC cannot find a DHCP server, it defaults to an IP address of 169.254.1.1.

« Static — Select if you are specifying an IP address for the iCC. Enter it in the IP Address field. If

you select this option, the iCC enables the Static Address Settings and Static DNS Settings
fields.

Caution: If you are using a static address in combination with an LDAP security
configuration, you must specify a valid DNS Nameserver. Failure to do so will make
your iCC inaccessible.

DHCP Setting Optional. For ease of reference, enter a name for the iCC. Only available if your DHCP server
supports this feature.

Static Address If you selected the Static Ethernet setting, enter the addresses required: «
Settings IP Address — Enter the IP address for the iCC.
« Netmask — Specify the address range for the iCC subnet.

« Default Gateway — Enter the gateway IP address if the iCC uses one.

Static DNS Settings | If you selected the Static Ethernet setting, enter the addresses required:
« DNS Search Path — Enter the path needed to reach the Domain Name Server (DNS).

« DNS Nameserver — Enter the IP addresses of up to three DNS nameservers.

Network Status:

Displays the current network connection status and values.

Tests:

In each case, start the test by entering the host's name or IP address and clicking the | Aun | hutton:

Ping Host Ping the host.

Trace Route Trace the route to the host. This can take a few minutes to complete.
DNS Lookup See the host's details held on the DNS.

TCP Dump Collect IP packets for the number of seconds you specify.

9.3.5 TV & Radio
Use the TV & Radio options to enable the iCC to use TV and radio stations in playlists.

Click the tab for the option you require:

« Digital Tuner Stations — Adding and editing digital TV and radio station names.

« Streaming TV & Radio — Specifying and checking multicast addresses.
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Digital Tuner Stations:

Click the button for the type of station you want to add:

| Add TV Station | —Adding a TV station.

| Add Radio Station |—Adding a radio station.

In each case, the iCC prompts you to enter a name for the station. You must enter the exact name of the station the

player can receive, matching any upper or lowercase characters. Click the® 221 button to finish. The iCC then:

« Adds the TV station name to the Live Video drop-down list. Access that list on the playlist Specials tab for zones
with the Movie player enabled.

« Adds the radio station name to the Live Radio drop-down list. Access that list on the playlist Specials tab for
layouts with the Soundtrack property enabled.

You can now add TV or radio stations to playlists. Before adding a station, ensure that the player has the appropriate
license and that it can tune into the station's signal (see TV for more on the required player setup).

The Digital Tuner Stations tab lists the stations you have added. Click the button to perform the action indicated:

@ — Delete the station.

L Change the station name. Click the © Edit putton when you have completed the change.

Streaming TV and Radio:

If the player cannot receive a TV signal directly, it might be able to receive it by multicast streams using the local
network. The player decodes the multicast stream and displays the TV image in a zone in the normal way.

If you want to use multicast streams to provide TV to the player there are these requirements:

« The player has the appropriate license.

« Thereis a streaming transmit server to convert the TV signals into multicast packets.

« If youriCC and the player are on different networks, the streaming addresses must be the same.

« All routers and switches on the local network between the streaming transmit server and each player are
enabled for multicast streaming.

« There s sufficient network capacity to efficiently support multicast streaming.

Note: There may be copyright issues involved in rebroadcasting material onto a local network.
Click the Status tab to display a list of stations available through streaming.

Click the Settings tab to specify the multicast address by following these steps:

1. Inablank field, enter the IP address on which to receive the Service Advertising Protocol (SAP) packets. Valid
addresses are between 224.0.0.0 and 239.255.255.255.

2. If required, enter additional addresses in the remaining fields. You can specify up to six addresses.

3. Click the! 52¥& |pytton.
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9.3.6 HTTP Proxy

Use the HTTP Proxy page to set up proxy server access if the iCC needs to use one to access Internet resources.
Check with your network administrator to see if a proxy is needed.

To use a proxy for accessing an Internet resource, you must perform both of the following actions:
. Setupthe HTTP proxy by completing the information on the Add HTTP Proxy tab.
. Specify that the iCC must use a HTTP proxy when you set up individual Internet resources (for example, a

newsfeed).
After you have configured the HTTP proxy, specify that the iCC uses it on the relevant setup page:
« Newsfeed — Set up the individual newsfeed on the Media > Newsfeeds page.
« Reporting — Set up on the Setup > System > Reporting page.

« Software update — Set up on the Setup > Maintenance & Troubleshooting > Software Update page (Settings
tab).

The iCC does not transfer a proxy configuration in a channel.
Note: Newsfeeds do not support use of Microsoft® NTLM authentication. We recommend changing the

Windows proxy to allow Digest authentication. You must restart the iCC when you make any changes to the
HTTP proxies.

To configure the HTTP proxy, complete the following details then click the | Add and Restart |y tton:

Server Address Enter the IP address of the proxy server.

Server Port Enter the port the iCC needs to connect to on the proxy server (default is 3128).
Username If the proxy server requires authentication, enter the username.

Password If the proxy server requires authentication, enter the password.

Use this proxy for | Check the box for each resource the iCC needs to use the proxy for.

9.3.7 Security — General Settings

Use the Security options to configure the iCC firewall and other security services and to monitor firewall activity.

Caution: The iCC comes ready-prepared with default firewall and other security service settings to protect
against unauthorised access. Do not change the security settings unless you have a good working
knowledge of IP networking and network security. Incorrect configuration can block all access to the iCC.

The iCC firewall protects it against unwanted and potentially malicious traffic. However, the iCC also needs
to accept your login and allow necessary communications. To allow and protect such access, the
iCC supports a variety of secure services:

« VPN —Virtual Private Network. Allows the iCC to communicate over an encrypted path through firewalls.

« HTTP/HTTPS — Hypertext Transfer Protocol and Hypertext Transfer Protocol Secure. By default, the iCC uses

HTTP with Digest authentication, which encrypts passwords. HTTPS is more secure because it also encrypts
content.

« FTP —File Transfer Protocol. FTP access is controlled by password. Passwords are not encrypted. Use FTP
for copying over backups and software updates.
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o SSH —Secure Shell. Only used to access the iCC operating system for occasional support and maintenance
purposes. Access is by the master password.

You can configure each of those to match the specific security needs of your network or to conform to corporate
policy on port numbering.

Click the tab for the option you require:

« Firewall — Examining and configuring the firewall and other security services settings.

« Master Password — Changing the iCC master password.

« LDAP - Detailing access control using the Lightweight Directory Access Protocol.

« LDAP Expert — Entering XML-based LDAP parameters. (Only displayed if you have set the User Interface
Policy to Expert.)

« Firewall Status — Monitoring the detailed firewall activity report.
« LDAP Tests — Testing your LDAP configuration.

« SSL Certificates — Using customized Secure Socket Layer certificates.

Firewall:

The Firewall tab allows you to examine and configure the firewall and other security service settings.

140



Content Commander User Guide

To change your security settings, complete the relevant options then click the | Save Secusity Settings | button

and reboot the iCC:

Firewall Service
Settings

HTTP Service
Settings

FTP Service
Settings

SSH Service
Settings

Movie Player
Unicast Listener
Service Settings

Master Password:

IP Address Filtering — Default: Disabled. Check this box to prevent any access to the iCC except
from the Allowed IP Addresses.

Allowed IP Addresses — Enter the IP addresses that can access the iCC, not forgetting to
include your own. To allow more than eight IP addresses, specify a range using the standard
syntax (for example, entering 192.168.1.0/24 allows access for all IP addresses between
192.168.1.0 and 192.168.1.255).

Authentication — Default: HTTP Authentication. For a more secure authentication method, and to
enable explicit sign out from the iCC session, take these steps:

o Select Form-based Authentication.

o Change Supported Protocols to HTTPS.

o On the SSL Certificates tab, detail the SSL certificate to use.

XML API Authentication — Default: HTTP Digest Authentication. The authentication method used
for programmatic control through the XML API interface. Alternatively, select HTTP Basic
Authentication if it better suits the requirements of your application.

Supported Protocols — Default: HTTP and HTTPS. Select either HTTP or HTTPS to restrict access
to that protocol. You cannot manage the iCC without either HTTP or HTTPS enabled.

Bandwidth Limit — If you want to limit the bandwidth available to particular ports, specify it here (in
whole numbers of megabytes per second). This allows you to differentiate the quality of service on a
per-port basis (for example, restricting bandwidth for subscriber downloads). Do not restrict
bandwidth on the ports through which users log in to the user interface.

HTTP Ports — Default: 80. Modify or add if you want your iCC to accept HTTP connections through
different ports. Check the Limit Bandwidth box to restrict the bandwidth available to the port.

HTTPS Ports — Default: 443. Modify or add if you want your iCC to accept HTTPS connections
through different ports. Check the Limit Bandwidth box to restrict the bandwidth available to the
port.

Service State — Default: Enabled. Uncheck this box to disable FTP access.

FTP Ports — Default: 21. Modify or add if you want your iCC to accept FTP connections through a
different port.

Passive Port Range — Default: 59000-59009. Modify the Low Port and High Port values to
specify a different range.

Transfer Rate — Default: Limit to 10000 Kibit/s. Modify the Limit to value to specify a different
transfer rate (in whole numbers of kibibits per second).

SSH Ports — Default: 22. Modify or add if you want your iCC to accept FTP connections through a
different port.

Service State — Default: Disabled. Check this box to enable the unicast listener service.

Listening Ports — Specify the ports the iCC listens on.

The Master Password tab allows you to change the master password. You need the master password to

access the iCC operating system through SSH.
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Note: This is not the same password you use to login to the iCC through a browser.

It may be desirable to change the master password, but you must know the existing one to do so. Please contact
your reseller or supplier for the master password.

To enable the new password, you must click the |_&hange Master Password | h,tton and reboot the iCC.

LDAP:
See Security — Advanced LDAP Settings for details.

LDAP Expert:
See Security — Advanced LDAP Settings for details.

Firewall Status:

The Firewall Status tab displays the detailed iCC firewall activity report.

Understanding the information in that report requires a good working knowledge of IP networking and network
security. In particular, note these points:

« The Chain PLAYER-INPUT section details the rules governing connections made to the iCC on various
protocols.

« TheiCC checks the IP address of incoming connections against the Chain PLAYER-INPUT-ADDRESSES
rule set. The iCC drops connections from IP addresses disallowed by the security settings.

« TheiCC checks allowed connections against the Chain PLAYER-INPUT-PORTS rule set. The iCC drops
connections to a port disallowed by the security settings.

« The Pkts (packets) and Bytes columns show the volume of traffic accepted or rejected by each rule. An
unusually high number of packets on a DROP line might indicate an attack on the iCC.

LDAP Tests:
Run the LDAP test to check your current LDAP settings and to receive feedback on any problems.
Recommendation: Always test any change to the LDAP settings before rebooting the iCC. Torun a test:

1. Enterthe name of the target iCC user in the Test Username field.

2. Click the| TestLDAP Setings | button. The test

results are displayed in two parts:

« A table showing the status of each step.

« Adetailed log.

When you have a correct setup, and the iCC username is valid, the LDAP test returns the Passed status.
To correct any indicated problems, check the user permissions and change the associated LDAP settings.
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The iCC performs the following tests and indicates any failures as well as displaying detailed log messages:

Tests Checks

Bind to LDAP server Configuration and Bind sections
Search for FTP user FTP User section

FTP Read/Write Access FTP User section User Filter
Search for HTTP user HTTP User section

Find HTTP user HTTP User section

Search for group membership Roles LDAP Filter section

SSL Certificates:

If you want to use customized SSL certificates, rather than the default certificates, follow these

$terSelect the Use Custom SSL certificates for the Web Server option.

2.
3.

Enter your Certificate, Key, and CA Chain values in the relevant fields.

Click the | Sawe Changes |button and reboot the iCC.

9.3.8 Security — Advanced LDAP Settings

The iCC Security page includes tabs to allow you to configure and test LDAP:

LDAP — Detailing access control using the Lightweight Directory Access Protocol.

LDAP Expert— Entering XML-based LDAP parameters. (Only displayed if you have set the User Interface
Policy to Expert.)

LDAP Tests — Testing your LDAP configuration.

Caution: Do not use LDAP to control security for the iCC unless you have expertise with LDAP
implementations. LDAP is a powerful technology and enabling a misconceived configuration can make the
iCC unusable.

Before beginning to configure security for the iCC using the options on the LDAP and LDAP Expert tabs, read
through the guidance that follows. When you have completed your configuration, click on the LDAP Tests tab
to test it before rebooting the iCC (see LDAP Tests for details).

To begin with, it is important to understand the difference between the iCC and the LDAP security models:

The basic iCC security model prevents access to system features unless a user is authenticated and has
explicit permissions.

In the LDAP security model, a user is considered to have permission if an LDAP filter matches entries in the
directory. Typically, an LDAP filter establishes that a user is a member of a group.

Recommendation: Use secure HTTP (HTTPS) for LDAP authentication otherwise passwords are sent in the
clear and are not encrypted.

143



Part 9: Setup

What follows is guidance for completing each of the fields on the LDAP tab:
» Configuration

«» Fallback User

. Bind

« FTP User

« HTTP User

« Roles LDAP Filter

Configuration:
You must check the Enable LDAP box to allow the iCC to use LDAP.

You must enter the Primary LDAP Server hostname and port and choose the Server Encryption.

The Server Encryption types are:

« None —No encryption (passwords are sent in clear text) (standard LDAP port is 389). Not recommended. «
SSL - The iCC encrypts all communications with the LDAP server using SSL (standard LDAP port is 636). «
TLS - The iCC encrypts all communications with the LDAP server using TLS (standard LDAP port is 389).

The Certification Authority (CA) Certificate is required when you use SSL or TLS encryption. For SSL, the certificate
must conform to the following (if your certificate is in a different format you must convert it to conform to the
supported format):

« |s aPEM-encoded certificate (X.509).

« Is not a PEM-encoded version of an archive certificate format.

« Is an RSA-based certificate.

« Has a PEM-encoded RSA key and is not pass-phrase protected.
« Has a CA chain that is PEM encoded.

« Does not have a CA chain that is a PEM-encoded version of an archive format.

For TLS, the certificate must conform to the following:

« Is aPEM-encoded certificate (X.509).

« Is not a PEM-encoded version of an archive certificate format.
Note: Microsoft® Active Directory® does not support LDAP over TLS and by default LDAP requires additional
configuration of the Active Directory server.

Fallback User:

The fallback user can always login to the iCC and perform management tasks, even when LDAP authentication is
not working.

Enter the username and password that you wish to use to manage the iCC in the event of problems with the LDAP

setup.

Recommendation: Give the fallback user SystemAdministrator access. Use a very strong password for the
fallback user password.
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Bind:

Select Allow Anonymous Bind to use anonymous binding to the LDAP server. Otherwise select Bind using DN
and complete the Bind Username and Bind Password.

For example, the bind username is a distinguished name (DN) like: cn=Manager, dc=yourdomain, dc=com.

FTP User:

The information in this section is used to authenticate users and give them permission to gain FTP read/write
access to the iCC. You will need to know how to find the user object in the directory that corresponds to the
username given to FTP.

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting
from the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Set the Login Username Attribute to an attribute that will contain the username given to FTP. This is typically as
described for the relevant context:

« Active Directory — Typically, the sAMAccountName attribute.

« Posix Scheme Directory — Typically, the uid attribute.

In the User Filter field, enter the LDAP filter that will match a user object in the directory (use %$s where you wish the
filter to contain the username of the user that is logging in).

Recommendation: If possible, add checks for group membership to control which users can access FTP
on the iCC.

Example user filters for the relevant contexts are:

« Active Directory — (& (sAMAccountName=%s) (objectclass=user) (memberOf=CN=ICC ftp
access,OU=Security Groups,DC=yourdomain, DC=com) )

« Posix Scheme Directory — (& (uid=%s) (objectclass=posixAccount))

HTTP User:

The information in this section is used to authenticate users to use the web interface of the ICC. Permissions are
set in the next section. You will need to know how to find the user object in the directory that corresponds to the
username givento HTTP.

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting
from the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Set the Login Username Attribute to an attribute that will contain the username given to HTTP. This is typically as
described for the relevant context:

« Active Directory — Typically, the sAMAccountName attribute (note: in this case, do not include this attribute in
the User Filter field).

« Posix Scheme Directory — Typically, the uid attribute.
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In the User Filter field, enter the LDAP filter that will match a user object in the directory (use $s where you wish the
filter to contain the username of the user that is logging in). Example user filters for the relevant contexts are:

o Active Directory — (objectclass=user)
« Posix Scheme Directory — (objectclass=posixAccount)

In the Display Name Attribute field, enter an informal name for the user for the ICC to use where required. This is
typically as described for the relevant context:

« Active Directory — Typically, the displayName or sAMAccountName attribute.
« Posix Scheme Directory — Typically, the cn or uid attribute.

Roles LDAP Filter:
After a user has been authenticated to access the iCC web interface through HTTP, the iCC will check the user's
permissions.

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting
from the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Enter the Filter Attribute appropriate to your context. Example filter attributes for the relevant contexts are:

« Active Directory —dn
« Posix Scheme Directory —uid

You can set up permission filters for any of the configured roles. The iCC displays a field for each role.

Set those to LDAP filters that match the role's permissions. Use $s where you wish the user's username to be
written into the filter.

Typically, the filter checks that the user is a member of a group. Example permission filters for the relevant contexts
are:

« Active Directory — (& (objectClass=group) (member=%s) (distinguishedName=CN=player
monitor,QU=Security Groups,DC=yourdomain, DC=uk))

« Posix Scheme Directory — (& (objectClass=posixGroup) (memberUid=%s) (cn=monitor))

9.3.9 Player Local Information

Use the Player Local Information page to add, delete, or modify data items for customising player behaviour.
Click the tab for the option you require:

« Player Local Information — View, delete, or edit player local information. To delete a set of PLI, click its @
button. To edit a set of PLI, click its | # | button and take the relevant action (click the | S2¥& Ehanges | tton
when done):

o Modify — Edit any of the Name or Value fields.
s Delete avalue — Click its L@ | button.

o Add a value — Click the ¥ | button. The iCC opens a new field for you to enter the value. A value can be
anything you choose (for example, '3', 'Conference Room', 'London’).
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« Add Player Local Information Item — Add a new set of player local information. To do so, follow these steps:

a. Enteraname forthe PLI. The iCC will use this name to reference the PL| on other screens.

b. Enter at least one value. To add another value, click the _* |putton. To delete a value, click its @ button.

c. Click thel Add Player Local Information ltem |button.

Example uses of PLI include the following:

Conditional play — Add data that the player checks to determine which playlist items or schedules to play.
Localise HTML pages — Add data that the player uses to localise output from web pages.

Configure a weather widget — Specify the current location to customise a weather widget display.

These examples further expand and illustrate how you might use player local information:

Design general channel content that also allows each player to play specific content. For example, if your
company has branches in different countries, you could use player local information to specify each location in
ISO format. A weather widget you install checks that value and provides a localised weather forecast.

Design general channel content but that uses conditional play to control the media and schedule for individual
player units. For example, you could create the same channel content for all branches of a chain store but use
player local information to control conditional play items in that content. You could play content in each store
based on the profile of customers visiting that store (using conditional play for playlist items). You might also
display specific opening hours for a store (using conditional play for one or more schedules).

When you enable reporting, the player includes player local information in its reports to the IDM and you can
use this for whatever purpose you wish. For example, you could use player local information for asset tracking
purposes by storing the player's address and asset tracking identifier. If there is a problem, it is easy to
determine the location of the player based on IDM reports.

9.3.10 Reporting

Use the Reporting options to configure how your iCC reports status information to the IDM.

Note: Some features may depend on installed licenses.

You can configure your iCC to send reports to the IDM using any of HTTP, HTTPS, or VPN. However, if you want
your IDM to connect to the iCC over SSH you must use VPN.

Click the tab for the option you require:

Reporting Settings — Enabling and configuring reports.

« Status — Checking reporting states and events.
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Reporting Settings:
To configure reporting, complete the following details then click the | Save Changes | button (you must also reboot

the iCC if you change the Reporting or SSH settings):

Reporting Check the button for the reporting option you want:
« Status reporting is disabled — The iCC does not send reports.
« Report status to a IDM via HTTP — The iCC sends report using HTTP or HTTPS. «
Report status to a IDM via VPN — The iCC sends report using VPN.

Reporting Interval Specify how often you want the iCC to send a report. The minimum interval is 5 seconds.

Report to IDM via Select whether the iCC sends reports using HTTP or HTTPS. Enter the name or network address of
HTTP the IDM in the field (optionally with the required port number appended after a colon).

Report to IDM via Enter the name or network address of the IDM in the field (optionally with the required port
VPN number appended after a colon).
Check the Allow SSH access via VPN box to allow the IDM to connect to the ICC over SSH.

Authentication Enter the username and password for the reporter account on the IDM.

Proxy Check the Use proxy if configured box if the iCC has to send reports through a proxy. You must
have already configured the proxy (see HTTP Proxy for details).

9.3.11 Licensing

Certain features beyond the normal capabilities of the iCC are licensed. This page allows you to view
currently installed licenses and features and to add new licenses.

The Licensing tab shows a summary of all installed licenses, while the Status tab shows all currently licensed
features.

The Add License tab allows you to add new licenses.

Note: The iCC must be rebooted for newly installed license features to become available.

9.4 Player Setup
Use the Setup > Player options to configure the player RS-232 and interactivity settings.

Select the menu item for the option you require:
» RS-232 Outputs — Configuring and adding RS-232 items.
« Interactivity — Configuring touch screen, RS-232, and remote keypad interaction.

9.41 RS-232 Outputs

Use the RS-232 Outputs options to add and manage RS-232 items.

You can use the player RS-232 port, or the RS-232 adapter attached to one of its USB ports, to send RS-232
strings or RS-232 outputs to control an external, RS-232 enabled device. You do this by creating RS-232 items
on theiCC.
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The RS-232 item consists of one or more of these properties:

« The voltage level for either or both of the RS-232 output lines.
« An RS-232 hexadecimal control string.

« The event causing the player to execute the item.
Click the tab for the option you require:
« ltems —Listing the RS-232 items already defined on the iCC.
. Add Item — Adding a new RS-232 item.
. Configuration — Accessing the RS-232 configuration options, including baud rate, data bits, stop bits, and parity.
The player can execute an RS-232 item in a playlist or automatically at one of the following events:
« Screen is muted or unmuted.
« Audio is muted or unmuted.

« A specified layout starts or completes.
You have to specify the condition when you create the item: you cannot change it later.
Note: You can only create one RS-232 item for each of the conditions.

The RS-232 items are published as part of the channel and are downloaded to subscriber players. However, the

iCC provides an override so you can designate an RS-232 string or configuration to use locally that is different from
that defined in the channel's RS-232 item.

Items:

For each item, you can take these actions:

« Click the @ button to delete an item.

« Click thel # |button to review or modify an item's properties. Click the | “P92% | putton to enable any
modifications.

Note: If you have enabled Send RS-232 String Action for the item, the iCC also displays the Local Override

section. This allows you to enable and define a local RS-232 string for the item separate from the one defined in
the channel.

Add Item:

To create the RS-232 item, complete the following details and click the | 499 | putton:

Name Enter a name to uniquely identify this RS-232 item.

Perform Enabled Actions when Specify when the player executes the RS-232 item (in a playlist or automatically at

the event you specify).

Send RS-232 String Action Check the Send RS-232 String Action box to enable the player to send the RS-232

string you specify. Clearing the box disables it.

RS-232 String (as Hexadecimal) | Enter the RS-232 string you want the player to send (in hexadecimal).
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DTR (Data Terminal Read) Action | Check the Set DTR level box to enable the player to setthe DTR line voltage to the
option you select. Clearing the box disables it.

RTS (Ready To Send) Action Check the Set RTS level box to enable the player to set the RTS line voltage to the
option you select. Clearing the box disables it..

Configuration:

Configure the player RS-232 transmission to match the settings of the connected RS-232 equipment. To configure
RS-232, complete the following details and click the | S2ve Configuiation | tton:

« Bits per Second — Select the baud rate from 110 to 460800.

« Data Bits — Select either 7 or 8 data bits.

« Stop Bits — Select either 1 or 2 stop bits.

« Parity — Select the parity as none, odd, or even.
Note: The iCC also displays the Local Override section. This allows you to enable and define a local RS-232
configuration separate from the one defined in the channel.

9.4.2 Interactivity

Use the Interactivity page to program the player to respond to RS-232 inputs.

The player can respond to voltage changes on the following RS-232 inputs:
o Clear ToSend (CTS).

« Data Carrier Detect (DCD).

« Data Set Ready (DSR).

« Ring Indicator (RI).

Click the | # | button to view and edit the properties for each input required:
« Enabled - Indicates the availability of the input for use on the player.
« Name — The name to use for this input when referencing it elsewhere.

« Used By - Indicates the zones and layouts that use the input.

9.5 Backing Up YouriCC

In case of problems, you should maintain regular backups of the media content files and settings that your
iCC uses. See Backup Contents for details of what is backed up.

Use the Setup > Maintenance & Troubleshooting > Backup & Restore page to create, save, and restore
backups. Configure the iCC to automatically create backups on a regular schedule or perform a manual backup
as required. You can save the backups on the iCC disk drive, on a network share, or on attached USB storage. If
needed later, you can use the backup to restore media files and settings onto this or anotheriCC.

Click the tab for the option you require:

» Backup Status — Review backup information and delete or restore a backup.
» Manual Backup — Perform a manual backup.
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« Scheduled Backup — Configure automatic backups.

« Network Share — Configure a network share location for backups.

Backup Status:

The display contains the following information and options:

Upload a backupfile 14 pioad a backup file from your computer onto the iCC take these steps:

1. Click the | B'®WS&- |, o and navigate to the file you want to upload.

2. Select the file and dlick the . 2#%" | button.

3. Click the button.
The iCC displays a progress bar. After being uploaded, the file appears in the Available
Backups list should you wish to restore it.

Backup History/Status Provides these pieces of information about backup activity:
. Creation Date/Time — Day and time when the iCC created the backup.

. Status — Whether the backup completed successfully or not.
« Location — Where the iCC saved the backup.

« Backup File — The name of the file containing the backup. Click on the name for the option
to open or save the file.

Available Backups The list of backups available for you to restore.

Use the following options to control how many backups the iCC displays:

« Backup Location — Leave blank to see all backups. Restrict those displayed by selecting a
location from the drop-down list.

« Filter Results — Leave blank to see all backups. Restrict those displayed by entering a filter
string.

Refresh list _ r heeded, click to update the list of backups.

The table listing the backups contains the following columns:

« Actions — To restore the backup onto the ICC, click the |J button. To delete the backup,
click the @ button.

. Location — Where the ICC saved the backup.

. Backup File — The name of the file containing the backup.

. Restored Size — The total size of the files and settings when restored onto the ICC.
. Backup Size — The size of the backup file.

. Serial — The serial number of the iCC backed up.

. Creation Date/Time — Day and time when the iCC created the backup.
Click on a column header to change the sort order.

Use the Show drop-down list to select how many backups you want displayed at a time. If
there are more backups than that, navigate through them by clicking the Previous and
Next arrows.
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Manual Backup:
To perform a manual backup, take these steps:
1. Select where you want to save the backup from the Location drop-down list.

2. If desired, edit the File Name field to provide a backup filename of your choice.

3. Click the| BackupMow | button.

The iCC displays a progress bar. Click the | €ancel |ptton to stop the backup at any time.

Scheduled Backup:

To configure a scheduled backup, complete the following details and click the | 52¥& | pytton:

Scheduled Backup | Check the Enable box. Uncheck the box to disable the scheduled backup.

Location Select where the iCC saves the backup from the drop-down list.

File Name Prefix Optional. If desired, provide a prefix name for the backup file (the suffix is always 'backup').
Back Up Every Check the box next to the day or days you want the iCC to save a backup.

Start at Use the drop-down lists to select when you want the iCC to start the backup.

Backup Retention | Default: 30 days. If you want to change how many days the iCC keeps the backup, enter an
Period appropriate value.

Network Share:

Before configuring the iCC to use a network share, you must ensure that the share is already set up. To configure a

network share, complete the following details and click the| Sa¥& | putton:

Network Backup Check the Enable box. Uncheck the box to disable backup to this network location.
Location

Host Enter the fully-qualified specification of the location host (for example,
backupserver1.supportdomain.businessname.com).

Port Default: 445. If you need to use a different port to connect to the share, enter it here.
Share Enter the name of the share on the host.

Domain Enter the fully-qualified domain name (for example, supportdomain.businessname.com).
Username Enter the username for the credentials authorised to write the file.

Password Enter the password for the credentials authorised to write the file.

After you click the . 52¥& | putton, the iCC tests the configuration and reports any errors.

9.6 Software Update

You can access the Software Updates page from the Setup > Maintenance Troubleshooting menu.
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Use the Software Update options to check the latest update status and to configure whether the ICC performs
updates automatically or not. Contact Black Box Technical Support at 877-877-2269 for more information on

available updates.

Note: It is not possible to install an earlier software version than the one currently installed. The currently installed
version is shown highlighted.

Click the tab for the option you require:

« Update Status — Checking details of the last update, how the iCC checks for updates, and if any new

updates are available.

« Settings — Configuring or disabling automatic updating.

« Manual Update — Performing a manual update from a downloaded file.
Caution: Never turn off the power to the iCC while it is installing an update. It can take 30 minutes to install a

large update.

Update Status:

The display contains the following information:

Last Update Messages

Status

Last Checked for updates

Update File

Update Description

Progress

Describes the most recent update.

Indicates whether or not the iCC is allowed to check for updates.

If it reads 'Not allowed to Check for updates’ this is because you have selected one of the
following options on the Settings tab:

« Turn off automatic update.

« Download Allowed — specifying a period that does notinclude the current time.

Indicates when the iCC last checked for updates.

If you have either selected Turn off automatic update or have set a Download Allowed
period that does not include the current time, this reads 'Not known'.

Indicates if an update is available or not.

If an update is available, and has not yet been installed, the display details its location and
description. To install that update:

1. Click the Settings tab.

2. Selectthe Automatically download and install updates option.
3. Click the | SaveChanges |p o

A description of what the update listed above provides.

Not displayed if there is no update available.

Contains a progress bar during a download. After a download completes, indicates that an
update is ready for installation at the next reboot.

Not displayed if there is no update available.
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Settings:

To configure software updating, complete the following details and click the | S2¥& Changes | tton:

Update Mode

Reboot Allowed

Download Allowed

Update Server URL

Check Interval

Authentication

Proxy

Manual Update:

By default, automatic update is turned off. To turn it on, select the mode of operation you
want to use:

« Automatically download and install updates
« Check for new updates but do not download or install them

« Turn off automatic update

Specify the day and time when the ICC can reboot to install an update.

Only activated if you have chosen Automatically download and install updates.

Specify the day and a time slot when the iCC can check for updates.

If you have selected Automatically download and install updates, the iCC will check for
updates and, if it finds one, will download and install it automatically. The iCC installs the
update at the day and time specified in the Reboot Allowed option.

If you have selected Check for new updates but do not download or install them, the iCC
will check for but not download updates. Instead, it displays the details of any new update on
the Update Status tab.

Not activated if you have chosen Turn off automatic update.
if different from the defauit, specify the URL where the iCC checks for updates (the defauit URL

is http://icompelupdates.blackbox.com). Not activated if you chose Turn off automatic update|.

Specify how often the iCC checks for updates (in hours and minutes).

Not activated if you have chosen Turn off automatic update.

If the update server requires authentication, enter the details here.

Not activated if you have chosen Turn off automatic update.

Select the required proxy configuration:

. No proxy required — The iCC connects directly to the internet.

, Use proxy if configured — The iCC accesses the internet through the configured proxy.
You must first configure the proxy (on the Setup > System > HTTP Proxy page).

The first part of this screen confirms the version of the software currently installed on the iCC.

If you have manually downloaded an update and wish to install it, follow these steps:

1. Click the | Browse. |

button and navigate to the update file location.

2. Select the file and click the L__2#"__ | putton

3. Click the | YPlo2d | b tton.

4. Follow the on-screen instructions.
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9.7 Reboot System
You can access the Reboot page from the Setup > Maintenance & Troubleshooting

menu. Use the Reboot page to perform a controlled reboot of the iCC.

Caution: You can stop and restart the iCC simply by switching the power off and on. However, following a
software update, you must reboot the iCC using this controlled process to ensure the update completes
successfully.

Select Yes from the drop-down list and click the |_B&Boat | ytton.

155






Part X






Content Commander User Guide

Part 10: Troubleshooting

YouriCC requires little maintenance.

From time to time, Black Box may release software updates for your iCC. To make sure you keep your iCC up
to date, you can set it to receive and install those updates automatically (see Software Update for more details).

The following topics provide more information about iCC maintenance and problem solving procedures:

« Backing Up Your iCC — Creating and restoring a backup of your media files and iCC settings.

« Reboot System —Manually rebooting the iCC.

« Support Snap Shot- Creating a collection of log and device data for support purposes.

« Connection Troubleshooter — Following a sequence of tasks to track down and correct connection problems.

10.1 Support Snap Shot

If you have a problem with your iCC, your support representative may ask you to create a Support Snap Shot. A
support snap shot consists of a detailed collection of iCC logs and device setting data.

You can access the Support Snap Shot page from the Setup > Maintenance & Troubleshooting menu

Click the | Create Support Snap Shat | button and follow the on-screen instructions to create the support snap shot, if you
are asked to do so.

The Extras tab includes further diagnostic tools that you may be asked to use by the support representative
to help diagnose and resolve problems with youriCC.

10.2 Connection Troubleshooter

If you are having difficulties connecting to your iCC, work through the tasks in the following table:

Task Comment

There must be network cables connecting the iCC to | Use either a network cable connecting your computer to your LAN
and one connecting the iCC to the LAN, or a crossover cable

your PC. connecting your computer directly to the iCC. Make absolutely sure
that you are using a crossover cable.

If you are using a laptop, connect it to main power. If your laptop is running on battery power, and the battery is low,
the networking circuits may have been shut down. You may need
to reboot your laptop and the iCC.

If you are using a crossover cable, turn off any Your laptop may have a switch to turn wireless networking on and

wireless networking. off. Otherwise, look for an icon on your desktop or in your Control

Panel (for Windows PCs).
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Task

If you are using a crossover cable, your computer
must not be configured to work through a proxy.

Reboot the iCC and the PC.

During the iCC boot sequence, press the ESC key

and look for an OK message (in green) for the eth0

parameter.

During the iCC boot sequence, press the ESC key
and look for the IP address on the screen.

The iCC must have completed its boot sequence.

The green LEDs on all applicable network sockets
should be on or flashing.

You should know the IP address of your PC.

Make sure that the IP addresses of the iCC and
computer are in the same subnet.

You should try to ping the iCC from the PC. (Some
networks do not allow pings.)

You should be able to access the iCC with your
browser.

Make sure your browser is not showing a cached
version of the ICC home page.
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In Internet Explorer, select Tools > Internet Options >

Connections. Click the | E¥M==tngs | tton and clear the Use a

proxy server for your LAN box.

In Firefox, select Tools > Options > Advanced. On the Network

Settings...

tab, click the button and select No Proxy.

If you see a [Fail]message (in red) for the ethOparameter this
usually means that the iCC has found nothing to connect with at
the other end of the cable.

A No Cable message means that the cable is missing or faulty or
that there is another device on the network with the same IP
address. The address 169.254.1.1 either means that DHCP could
not be found or you are using a crossover cable.

The screen connected to the iCC should be showing the
localhost login: prompt.

If applicable, check the green light (if present) is lit on the socket
that the network cable plugs into on your PC, on the iCC, and any
hubs or routers in the path from the computer to the iCC.

To find the IP address of a Windows PC, click Start > Run. Enter

cmd and click the| L |bul'ton. Enter ipconfig and

press the Enter key. Your computer displays its IP address.

You may need to consult your network administrator for further
advice.

On a Windows computer click Start > Run. Enter cmd and click

the L °__|putton. Enter ping followed by a space and then
the IP address of the iCC. Press the Enter key. After a few
seconds you should see a message thatincludes the phrase (0%
loss). The yellow LED on the network socket of the iCC should
flash during the ping.

In the address bar of your browser, enter the IP address of the iCC
and click the Enter key. When prompted, enter the username and
password for the iCC. The home page of the iCC should appear in
the browser.

In Internet Explorer, click File and select Work offline. Also, select

Delete...

Tools > Internet Options and click the | I button in the

Browsing History panel then press F5.



Task

If you are using a crossover cable then you should not
be prompted to dial up to the Internet.

You should be able to connect to the iCC using FTP.
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Comment

If you are using Internet Explorer, and you cannot prevent the
computer from dialling out for an Internet connection, install the
Firefox browser on your computer and use it to access the iCC.

In Internet Explorer, in the address bar type ftp: //followed by
the IP address of the iCC and press the Enter key. When

prompted, enter the same username and password.

In Firefox, in the address bar type ftp:// followed by the
username, a colon (:), the password, the at symbol (@), and then
the IP address of the iCC. For example,
ftp//remote:9999@192.168.1.2. You should see a list of
folders, including the Media folder.
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Part 11: Technical Reference

This section contains technical reference topics not covered elsewhere:

« Playback Performance — Enhancing the playback performance of specific media types.

« RS-232 Technical Reference — Understanding RS-232 pin assignments and electrical interfaces.

« Backup Contents — Understanding which files and folders the ICC saves in a backup.

11.1 Playback Performance
You can optimize the playback performance of specific media by taking note of these points:

« The player units have no problem displaying MPEG-2 video at a reasonable rate (up to 10 Mbps). This
typically uses less than half of the player processing power.

« You should resize images (especially digital photos) before uploading them onto the iCC. Ideally, resize them
so that they match the size of the zone.

« Scrolling text uses relatively little processing power, provided it does not take up more than 30% of the screen
area.

« Animations (typically in Flash or HTML with embedded JavaScript) have no upper limit to the processing
power they require and can overwhelm the player. If this occurs, the animation will typically run slowly but
other zones will continue as normal.

11.2 RS-232 Technical Reference
The pin assignment of the RS-232 9-way D-PLUG is as follows:

Pin Direction RS-232 Name Quiescent State
1 Input to iCC Input DCD High impedance
2 to iCC Output RxD High impedance
3 from iCC Output TxD -ve voltage level
4 from iCC DTR -ve voltage level
5 Sig. GND

6 Inputto iCC DSR High impedance
7 Output from iCC RTS -ve voltage level
8 Input to iCC Input CTS High impedance
9 toiCC RI High impedance

For historical reasons, the RS-232 standard uses a variety of terminology to describe its signal status:
« Lowered = Negated = Logic 1 = -ve voltage = Off = Marking.
« Raised = Asserted = Logic 0 = +ve voltage = On = Spacing.

The iCC uses voltage level in order to describe line status since this is the only explicit identification.
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Inputs have:

« Hysteresis (generally of about 0.5 V).
« Athreshold level of about +1.5V.

« Aninput impedance of about 5000 ohms connected to GND (defaults to a -ve voltage state with nothing attached).
« An acceptable input range of +/-15 V.

Outputs have:

« A voltage swing ranging from +/-5V to +/-12 V (depends on hardware).

« A source current drive capability of about 15 mA (with output current limiting). This can drive LEDs or provide a
voltage for contact closure applications.
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11.3 Backup Contents

Backing Up Your iCC describes how you create a backup for your iCC. The folders and files included in the backup
are:

Folders Files

/data/data/ad_hoc media/ / /data/data/config/audio settings.xml
data/data/channel/ /data/data/config/http proxy settings.xml
/data/data/config/ad hoc/ / /data/data/config/local_information.xml
data/data/config/channel/ / /data/data/config/player settings.xml
data/data/control/ /data/data/config/remote setup settings.xml
/data/data/fonts/ /data/data/config/schedule_log rotate.xml
/data/data/media/ /data/data/config/screen_settings.xml
/data/data/package/ /data/data/config/software update settings.xml
/etc/Black Box/ICC/ /data/data/config/streaming video settings.xml
layout permissions/ /data/data/config/tv_controller digital

tuner stations.xml
/data/data/config/tv_settings.xml
/etc/Black Box/common/user_ passwords.xml
/etc/Black Box/common/users.xml
/etc/Black Box/iCC/custom ssl ca certificate.crt /etc/
Black Box/iCC/custom ssl ca certificate.key /etc/Black
Box/iCC/
custom ssl ca chain certificate.crt /etc/Black Box/iCC/
date-and-time-settings.xml
/etc/Black Box/iCC/dsm_reporting password.xml /etc/Black
Box/ICC/dsm_reporting settings.xml /etc/Black Box/iCC/
ldap passwords.xml
/etc/Black Box/iCC/ldap_ passwords pending.xml /etc/Black
Box/iCC/ldap_settings.xml

/etc/Black Box/iCC/ldap settings pending.xml

/etc/Black Box/iCC/security settings.xml
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Part 12: Glossary

Term

Ad Hoc

Ad hoc from center

Advance To

Canvas
Channel

Channel Content Server

Channel name

Conditional play

Content

Digital signage

Digital Signage Network

Display

Donate

Event
Folder play
Graphical layout editor

Interactivity

IPTV (Internet Protocol
Television)

Layout

Content Commander User Guide

Meaning

An override to a display schedule, often managed locally by ad hoc users, which is restricted
to a specific zone and/or content type. Ad hoc users control ad hoc content or ad hoc items,
which are keptin ad hoc media folders, and displayed on ad hoc pages.

An ad hoc schedule override which is managed and sent by a remote publisher player to one
or more specific subscriber players.

A command in a playlist that causes the player to start displaying from a specific place in this
or another playlist. A matching rendezvous point indicates the place in the other playlist

The display space in which the player renders layouts.
A source of display content used by subscribers. Also refers to the content it contains.

A server storing and publishing channel content to offload processing overhead from the
publisher.

Identifies the channel.

A means of controlling whether content is played or not depending on the values setin the
player local information.

An item of digital media or text that is displayed in a zone as part of a playlist.

Electronic display that may show a combination of any or all of text, graphics, and still and
moving images.

A set of systems connected together to provide integrated management of numerous display
screens.

The overall content being shown on the screen, rather than its layout or zone configuration.

The process of applying a player's configuration to a folder that the iCOMPEL Deployment
Manager then uses to configure other players.

An interactive input that causes a change in the display.

The ability to add an entire folder of items to a playlist and have them play in sequence.
The interactive editor for creating and modifying layouts using zones.

The player can run predetermined fixed schedules in the different zones within a layout.
However content can also be dictated by external stimuli such as floor pressure pads, the

incorporation of a touch screen display, or changing content using a remote keypad.

The delivery of television services over the Internet (as opposed to traditional broadcast
technology, satellite, or cable reception).

The combination of a background image and one or more display areas (zones) and that can
be shown simultaneously on a screen.
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Term

Layout icons view
Layout package

Manager

Media

Media audit

Media folder

Media player

Menu bar

Multichannel publishing

Override

Page

Player

Player local information

Playlist

Properties, item

Publish

Publisher

Remote keypad

Remote setup

172

Meaning

Abstract display of a layout showing only the distribution and size of its zones. The color of
each zone indicates the media itis enabled to play.

The media and settings for a layout bundled in a ZIP file for distribution to other players.

A component of the Black Box Digital Signage Platform. Manager is the generic term for
the appliance that manages the digital signage network. Specifically, the manager is the
iCOMPEL Deployment Manager (IDM).

General term for the content the player displays (such as text, images, video, and newsfeeds).
Reports indicating which media items played on the player, when, and for how long.
Designated area on the iCC disk holding media items for adding to playlists.

A feature that provides a zone with the ability to 'play’ different types of media. You can
enable a zone with players for movie, HTML, text, and image media, either singly orin

combination.

Appearing on all of the user interface pages, the menu bar provides access to the
various iCC configuration and design options (such as Media or Playlists).

An iCC configured with more than one channel.

Users can override or interrupt a schedule when necessary, for example to display special
instructions in the event of an emergency, or to show a special event from a TV broadcast
feed.

The iCC interface is made up of different pages, accessed through the menu bar. Ad hoc
users have their own dedicated pages for their limited-level access.

A component of the Black Box Digital Signage Platform. Player is the generic term for the
appliance that runs the screen. Specifically, the player is the iCOMPEL Subscriber Unit.

Data entered on an player used to alter what is displayed according to conditions often tied to
a locality.

A series of digital media contentitems displayed in a zone.

Refers to the specific characteristics of a display item such as the font and type size of text,
the format of images, or the duration of an item in a playlist.

To distribute channel schedules to multiple subscriber players for display on their associated
screens.

A device that provides content to players through channels. Specifically, the publisher is the
Black Box Content Commander.

A programmable hand-held device for local control of displays, this can be used to switch
between layouts, choose TV or radio stations, and adjust volume level.

A feature allowing a player's configuration to be applied to other players by the iCOMPEL
Deployment Manager through a folder.



Term

Rendezvous Point

Role

Schedule
Schedule entry
Screen snap shot
Standalone
Streaming video
Subscribe
Subscriber
Support snap shot

User Interface policy

Zone

Content Commander User Guide

Meaning

This may be added to a playlist as part of an Advance To command or may be used in
multiple playlists to ensure synchronisation between them.

Describes the function of a player: one of standalone, subscriber, or publisher.

A plan or timetable for displaying layouts at specific times.

An individual action added to the player schedule.

A picture of what the player is currently displaying.

A player thatis neither a subscriber or publisher.

Video which is delivered to the end user 'live' (that is, direct from the video provider).
Players that show a schedule from a publisher subscribe to that device.

A player that accepts a channel from a publisher.

A collection of detailed logging information used for support and problem solving purposes.

The level of features exhibited in the menu bar and in other options (can be productive,
detailed, or expert).

A single display area in a layout.
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Index

Action buttons 20
Ad hoc 89
adding layout items automatically 31
Advance To 94, 101
and remote control 92
and security 90
and showing video-on-demand 80
automatic 90
channel content 112
content 16
controlling display 92
controlling TV or radio 93
creating as you design 90
creating pages 97
creating users upload folder 99
customisation 93
customisation scope 96
default text 96
deleting page 97
disabling layout page 97
environment 89
folder play 93
how to set up Advance To 94
how to set up schedule override 94
item types 96
layout 93
local control 89
manual 90
media 72
media folder 100
newsfeeds 100
on publisher 95
publisher account 96
radio stations 100
schedule 93, 101
scope of update from center 95
screen layouts 101
subscriber account 96
text and tables 100
TV stations 100
user feedback message 96
users 90
Advance To 73
and ad hoc 101
and playlists 73
and RS-232 85
and synchronisiong playlists 79

Content Commander User Guide

comparison with Change Layout command
74 Animations and optimizing display 165
Approving publishing 112
Audio 54

click ontouch 85

icon 30

playing on touch 85
Authentication 141

digest 17

form-based 17, 141

HTTP 141

Background image 86
Backup 150

what is included 167
Bandwidth 141

limiting 141

per port 141

Canvas size 33
Change Layout 84
adding 74
and RS-232 85
comparison with Advance To command 74
Channel 14
add 118
basic steps touse 111
managing 118
parts of 111
publish 111
publishing methods 121
storage space required 111
Color 75
adding 75
background 86
defining 75
deleting 75
modifying 75
naming format 75
opacity 75
Command buttons 21
Conditional play 26
and player local information 147
status 126
view 37
Conflicts during layout package installation 106
Crop 86
HTML 86
movie 86
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176

Customization scope and ad hoc 96

Date and time 135
Display change method tradeoffs 84

Ethernet 137

File & Folders tab 50

File management 50

Firewall 140
settings 140
status 142

Folder play 41
creating complex sequences 70
defined 57

Font adding 76

Form-based authentication 141
switchingto 17

FTP 51
uploading files 51

using to copy a layout package 106

GPIO and RS-232 84
Graphical layout editor 32

Help 17
Home page features 17
HTML page 56

and interactivity 82

passing touch events to 83
HTTP 147

and reporting 147

digest authentication 17
HTTPS and reporting 147

Images and optimizing display 165
Interactivity 32, 84
actions 82
and storyboards 84
and zone displaying HTML 82
click ontouch 85
configuring layout 83

configuring playlist 82
events 81
how the player processes 83
playing audio 85
remote keypad 83
RS-232 83
touch screen 83, 85
touch screenicon 30
IPTV 59

Layout 30
action buttons 30
adding a soundtrack 32

adding ad hoc items automatically 31

colornaming 75
configuring interactivity 83
creating package 105
defined 15

delete package 105
display 30, 33

filtering those displayed 30 installing

package 105

interaction with playlist 82 managing

packages 105

saving changes 34

zones 33
Layout package 105

copying using FTP 106

distribution methods 105
LDAP 140

binding 145

configuring FTP user 145

configuring HTTP user 145

fallback user 144

security model 143

settingup 143

testing setup 142
Localizing HTML pages and PLI 147

Logon and form-based authentication 141

Master password 140
Media 45
ad hoc 72
Adobe Flash 56
audio 45, 54
backup and restore 150
clocks 47
common properties 71
entering text 45



external web pages 59
fonts 76

HTML web pages 56
images 54

live video 58
multicast video 59
newsfeeds 46

on player disk 50
overview 45

PDF files 57

play criteria properties 71
players 45

players described 33
presentations 55
properties listed and mapped 61
QR Codes 49

radio 58

soundtrack 45

tab 61

tables 47

text 45, 54

uploading file with drag and drop 52

uploading files 51
uploading files with FTP 51
video 53
Media folder and ad hoc 99
Movie 53
crop 86
formats 86
size 86
MPEG and optimizing display 165
Multicast TV 138

Network 137
status 137
tests 137
Newsfeed 46
and ad hoc 100
setting up proxy server 139
subscribing to 46

OpenType font 76

Permissions
described 134

Play Criteria
properties 71

Content Commander User Guide

tab contents 61
Player accessing by name 17
Player local information 146
and conditional play 147
and localizing HTML pages 147
and weather widget 147
examples 147
Playlist 36
action buttons 37
adding Advance To command 74

adding Change Layout commnand 74

adding external web pages 60
adding rendezvous point 74
adding RS-232 49
and Advance To 73
and rendezvous point 73
and RS-232 149
configuring touch actions 82
creating a sub-playlist loop 81
defined 16
examples of synchronizing 79
interaction with layout 82
master 79
slave 79
synchronizing 79
Port bandwidth limiting 141
PowerPoint and save as formats 55
Properties 61
advanced 61
generic 61
listed and mapped 61
Proxy server 139
Publish 111
approval process 112
approve 112
automatic 112
manual 112
mode 112
policy 112
toachannel 111
when and how 112
Publisher 112
and ad hoc account 96

network and bandwidth considerations 122

publishing methods 121

Radio 58
and soundtrack 58
configuring 137
Remote keypad 81
and interactivity 83
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controls 92
Rendezvous point 73

and playlists 73
and synchronizing playlists 79
Reporting 147

HTTP, HTTPS and VPN compared 147

settingup 147

setting up proxy server 139
Roles

and changing them 133

and permissions 130

and permissions | Default.iCC specific | [8] 133
RS-232 85

adding to playlist 49

and Advance To 85

and Change Layout 85

and hexadecimal code 85

and interactivity 83

control line inputs and outputs 85

creating item 149

GPIO 84

in playlist 149

sending and receiving 85

uses of 149

Schedule 25
action buttons 25
and ad hoc 101
creating 26
default entry 25
defined 15
entry 25
example 25, 27
listing all 25
override 25
Screen color 86
Screen layouts and ad hoc 101
Security 139
and ad hoc users 89
and configuration 16
and passwords 16
configuring LDAP 144
configuring LDAP FTP user 145
configuring LDAP HTTP user 145
defaults 139
firewall 140
firewall status 142
LDAP 143
LDAP binding 145
LDAP fallback user 144
LDAP model 143

master password 141
SSL certificates 143
testing LDAP setup 142
VPN, HTTP, HTTPS, FTP, and SSH
described 139
Software 152
updating automatically 154
updating manually 154
Software update and proxy server 139
Soundtrack 66
adding to a layout 32
with radio 58
SSL certificates 143
Status 125
conditional play 126
firewall 142
network 137
on Home page 18
overview 125
system 125
Streaming TV 138
Style tab contents 61
Subscriber 13
and ad hoc account 96
multiple 14
System
date andtime 135
System status 125

Tabbed pages 20
Tables 47
and ad hoc 100
and colouritems 75
Terminology 15
Test 137
LDAP 142
network 137
Text and ad hoc 100
Time and date formats 129
Time validity
view 39
Time zone 136
Touch screen 85
and interactivity 83
icon 30
TrueType font 76
TV 137
and ad hoc 100
configuring 137
multicast 138
setting up streaming 138
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Uploading files 37
and drag and drop 52
and FTP 51
and the Uploading Files tab 51
Userinterface 18
action buttons 20
changing appearance 129
changing display modes 129
command buttons 21
features 18
tabbed pages 20
time and date 129
Users 132-133
setting up and modifying accounts 132
setting up and modifying roles 133

Video 53
on demand using ad hoc 80
storage space required 111
VPN and reporting 147

Weather widget and PLI 147
Web page size 86

Zones 32
action buttons 35
buttons on tab 34
captioning 79
defined 16
in layout 33
listing 34
master playlist 79
media players 33
moving properties dialog 35
players for 45
saving changes 34
slave playlist 79
synchronizing 79
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